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Using this Online Reference

This online reference contains material from both your MiniCAD User's Guide ("how-to" information) and 
your MiniCAD Reference Manual ("what-is" information). Information in this reference is presented in the 
same order and with the same chapter/topic organization as these two manuals.

The following tips will help you use this reference effectively:

· Many topics in this manual contain hypertext references to supporting and/or related material. If you 
jump to one of these references, remember that you can use the Back button on the tool bar to return
to the original topic.

·  All topics in this reference are sequentially linked so that you can page through 
them just like a paper manual (this is the first "page" in the sequence). This means that when you are 
reading about a particular topic, you can use the browse buttons on the tool bar to page forward and 
backward through the surrounding information.

· If you find that you are frequently referring to a particular topic, you can use the Define command 
on the Bookmark menu to mark that page. This way you can jump directly to that spot the next time you 
need that information.



What's in my MiniCAD box?

The following items are included with your purchase of MiniCAD 7. Please take a minute to make sure 
you have all of them.

· Installation Guide.    On this insert sheet, you'll find step-by-step directions for installing MiniCAD 7 
on your computer, as well as any last-minute program updates.

· Application CD-ROM.    This disk contains the entire MiniCAD 7 program, including the Design and 
Drafting Toolkit™. Before using it to install MiniCAD, we recommend that you make a back-up copy--
that way you will have a copy on hand if your original disk becomes damaged.

· Demo/Training/Samples CD-ROM.    This disk has animated narratives that demonstrate each 
MiniCAD tool and command plus samples of MiniCAD drawing files from around the world.

· Manuals.    You'll find four manuals to help you learn MiniCAD 7. The User's Guide and the Reference
Manual share a common index--you can review either book's index to locate information in both 
manuals.

· User's Guide: An Overview of How MiniCAD Works.    In this book, you'll find general information 
about how to learn and use MiniCAD; create, view, and print drawings; render and manipulate 
objects; and use MiniCAD's database and spreadsheet resources. 

· Reference Manual: A Detailed Look at MiniCAD's Palettes and Commands.    Unlike the User's 
Guide, which gives a general overview of the program, the Reference Manual has step-by-step 
directions for how to use each of MiniCAD's palettes and menu commands. This detailed information 
explains everything from what you'll find listed in the Object Info palette to how to use MiniCAD's new 
Wall Framer.

· Toolkit Manual: How to Use MiniCAD's Industry-Specific Resources.    Along with illustrations 
showing each of the thousands of symbols and hatch patterns included in MiniCAD's Design and 
Drafting Toolkit, the Toolkit Manual has instructions for the program's industry-specific parametrics, 
worksheet templates, customized templates, and macro commands.

· MiniPascal Manual: How to Use MiniCAD's Marco Programming Language.    The MiniPascal 
Manual includes examples showing how to write macros plus a complete listing of the program 
language's routines and syntax--everything you'll need to create macros to automate your complex 
and repetitive drafting tasks. 



What are MiniCAD's system requirements?

Like Windows 95, MiniCAD 7 is a full 32-bit program. It requires:

· Microsoft Windows™ 3.1, Windows 95™, or Windows NT™--for best performance, we recommend 
Windows 95.

· A 486 or Pentium-based PC computer. As expected, the speed of the computer is the determining 
factor in the overall performance of MiniCAD, and faster is always better.

· 30MB of free hard disk space for a full installation (less required with custom installations).

· A Microsoft Mouse or other Windows 3.1-compatible pointing device.

· An SVGA, XGA, 8514/A, or other Windows 3.1-compatible graphics card with a minimum of 256 
colors.

For additional information, see the following topics:

What are MiniCAD's RAM requirements?



What are MiniCAD's RAM requirements?

To run, MiniCAD 7 requires at least 4MB of RAM (random access memory) left after Windows has 
loaded--in all, at least 12MB of RAM installed. (While MiniCAD will run on an 8MB PC, the lack of 
available memory may restrict your file sizes.) You may need additional RAM to render complex 3D 
images. Generally, 8MB of free RAM will be sufficient. For best performance, though, we recommend 
additional RAM. As always, the more RAM the better.



How do I register my copy of MiniCAD 7?

Registering your program is easy. Simply complete the Registration Card, which you'll find bound into the 
front pages of your MiniCAD User's Guide, and mail it back to us. As a registered MiniCAD 7 user, you'll 
receive

· 18 months of free Tech Support, 

· free maintenance upgrades for MiniCAD 7,

· information about the next version of MiniCAD and about any special offers for purchasing this 
product upgrade at a reduced cost, and

· a subscription to our newsletter, The Dispatch, which is packed with information about registered 
MiniCAD trainers in your area, third-party vendors and the MiniCAD add-on products they offer, and 
the many ways your fellow users are putting MiniCAD to work.



How can I learn to use MiniCAD?

Several tools for learning MiniCAD 7 are included with the program. In addition, there are a number of 
additional resources--including books, videos, and training programs--offered by independent vendors.

Tools Included with Your Program

Other Free Resources

Users' Groups

Third-Party Resources



Included with Your Program

To help you learn MiniCAD's many 2D drafting and 3D modeling features, we've included the following 
tools in your program box.

Training CD-ROM

Manuals

On-Screen Help



Training CD-ROM

The Demo/Tutorial/Samples CD has animated narratives that demonstrate each one of the program's 
tools and commands plus sample drawings created by MiniCAD users around the world.



Manuals

There are four manuals to help you learn MiniCAD's extensive features. The User's Guide explains 
fundamental concepts about the program, while the Reference Manual has step-by-step directions for 
each palette and menu command. For a comprehensive look at the industry-specific resources included 
with MiniCAD, see the Toolkit Manual. In the MiniPascal Manual, you'll find all the necessary details to 
use this built-in programming language to create customized macros. For a more detailed look at each 
manual's contents, see What's in my MiniCAD box?.



On-Screen Help

You can get brief descriptions of many of MiniCAD's tools, commands, and other features using the on-
line help that comes with MiniCAD.



Other Free Resources

As a registered MiniCAD user, you'll receive free technical support and a subscription to our company 
newsletter, The Dispatch. You can find a wealth of MiniCAD information in The Dispatch and, if you have 
Internet access, on our company's web page.

Tech Support

The Dispatch

Diehl Graphsoft, Inc. Home Page

Technical Notes



Tech Support

For a full 18 months after registering your copy of MiniCAD, you have unlimited access to technical 
support. There are five ways that you can contact Tech Support:

· Call 410-290-5114.

· Send a fax to 410-290-8050.

· Send an e-mail to /tech@diehlgraphsoft.com/.

· Send a message via CompuServe to 72662,1320.

To help Tech Support serve you faster, prepare a brief description of your problem that includes specific 
details about what you were trying to do and what actions you had taken right before the problem 
occurred. The more clues you can give Tech Support, the easier it will be to solve your problem quickly. 
You should also be ready to tell the representative 

· the version of MiniCAD you're using,

· your MiniCAD registration number,

· your operating system (Windows 3.1, Windows 95, or Windows NT),

· the type of computer you're using,

· how much RAM is installed on your computer,

· how much free RAM MiniCAD has access to, and

· if you made any recent changes to your computer setup (such as new fonts, software, or hardware).



The Dispatch

Three times a year, we publish a 24-page newsletter, which we send free to all registered users. In The 
Dispatch, you'll find articles about how your colleagues worldwide are using MiniCAD, what new MiniCAD
features and additions are in the works, and the other software packages we offer. 

Also in each issue of The Dispatch is a pull-out "Products & Services Guide," which lists registered 
MiniCAD trainers and companies that offer MiniCAD ad-on products. For more information, see Third-
Party Resources.



Diehl Graphsoft, Inc. Home Page

Along with general company and product information, on our web page /www.diehlgraphsoft.com/ you'll 
find valuable files that you can download. From the company, there's software and documentation 
updates and new externals. From your fellow users, there are macros and sample files.



Technical Notes

For the more complex facets of MiniCAD, our Tech Services, Engineering, and Content departments often
create supplementary documentation. Along with step-by-step directions and examples, these Technical 
Notes also provide hints and guidance for using MiniCAD more efficiently. There are several ways you 
can get copies of these. You can download copies from our company home page, or you can request 
them by phone or fax. You'll find a complete listing of all Technical Notes in The Dispatch. If you are 
requesting only one or two notes, we can fax them to you. For larger requests, we mail them to avoid 
tying up our fax machine.



Users' Groups

Currently, there are approximately 20 MiniCAD Users' Groups scattered across the U.S. and 10 abroad, 
including groups in Australia, Hong Kong, Ireland, and Israel. These groups provide valuable hands-on 
information and networking contacts for MiniCAD users. To find out if there is a Users' Group in your area,
consult our company home page or The Dispatch--or call our Marketing Department. If there isn't a group 
in your area, we'd be happy to help you start one.



Third-Party Resources

Through Mac Academy, you can purchase training videotapes for either Macintosh or Windows versions 
of the program. In these taped tutorials, one of our company experts demonstrates MiniCAD's tools, 
commands, and other features.

In addition, when you register your MiniCAD program, you'll automatically receive our newsletter, The 
Dispatch. Each issue has a "Product & Services Guide," which lists third-party resources. These include:

· Authorized MiniCAD Trainers.

· Manuals geared for specific industries.

· Macros and parametrics engineered for MiniCAD.

· Symbol libraries.

· Software that adds to MiniCAD's built-in features.



What system conventions do I need to understand?

If you are familiar with other Windows programs, you should have no problem understanding and 
following directions in the MiniCAD manuals. MiniCAD 7 follows standard Windows system conventions 
for items such as menu commands, scroll bars, arrow keys, and mouse functions.

For all MiniCAD users--new and old--there is one global convention you need to understand. This 
convention, which is a change from previous versions of MiniCAD, makes it easier to calculate and enter 
changes to dimensions. Every time you make a change to a dimension text box--a place where you can 
type in length, width, or degree angle--you now have the option of letting MiniCAD make the calculation 
for you. For example, say you have drawn a rectangle that is 5 3/8" by 3" and you want to make it 5 1/2" 
longer, you can let MiniCAD do the math for you. In the Object Info palette, you could type in "+5.5" after 
the current dimension (5 3/8"), and then press the ENTER/RETURN key. MiniCAD would automatically 
"do the math" and resize your object. In MiniCAD 7, you now can add (+), subtract (-), multiply (*), and 
divide (/) dimensions this way.



What basic terms do I need to understand?
For those new to MiniCAD and Windows, please take a minute to review the following terms, which 
explain basic mouse functions. In addition, you may want to review the documentation that came with 
your system software or, if needed, consult an independently produced manual.

· Object.    In MiniCAD, an object can be a text block, icon, symbol, or graphic image as well as a 
standard drawing object, such as a circle or square.

· Selection Arrow.    This is the pointer (arrow cursor) that appears when you are using the 2D 
Selection Tool or the 3D Selection Tool. 

· Click.    Use the mouse to position the tip of the selection arrow on an object, and then briefly press 
and release the left mouse button. 

· Double-click.    Use the mouse to position the tip of the selection arrow on an object, and then rapidly
press and release the left mouse button twice without moving the mouse.

· Select.    Using the mouse, position the tip of the selection arrow on a tool button and click--this will 
activate the tool. To select an object, position the selection arrow anywhere on the object and click. A 
selected object will display on your screen with a "bounding outline" (a rectangle with black filled-in 
squares around the edges). To "clear" an object, use the mouse to position the selection arrow on a 
blank part of your drawing window and click. 

· Drag.    You can use the mouse to move (drag) an object within your drawing. To do so, use the 
mouse to select an object but do not release your finger; while still pressing the mouse button down, 
drag the mouse. This will drag the object. When you have finished moving the object, simply release 
the mouse button. The object will stay at its new location.



What basic screen elements does MiniCAD use?

In addition to the basic screen elements that are part of all Windows programs--the menu bar, the title bar,
the window control buttons and so forth--MiniCAD's drawing window has the following elements that you 
use to create and edit objects.

Data Display Bar

Mode Bar

Views Bar

Rulers and Grids

Palettes



Data Display Bar

The Data Display Bar at the top of the window displays data about your drawing file and objects. 

There are two different modes to this bar--the Default Mode and the Drawing Mode.

Data Display Bar in Default Mode

Data Display Bar in Drawing Mode



Data Display Bar in Default Mode

Unless you are drawing an object, the Data Display Bar at the top of the drawing window will always stay 
in Default Mode. 

In this mode, the bar displays the following information from left to right:

· X: This field shows the x (horizontal) location of the cursor in the drawing window.

· Y: This field shows the y (vertical) location of the cursor in the drawing window.

· Class menu. If you click this item, MiniCAD will give you a menu that lists any classes that exist in 
your drawing. In addition, if you click the first item listed in the menu (Classes…), the Classes dialog 
box will appear--allowing you to edit and delete existing classes or to create new ones. For an 
overview, see What are Classes?. For step-by-step directions on using and creating classes, see the 
Classes command.

· Layer menu. If you click this item, MiniCAD will give you a menu of the layers that exist in your 
drawing. In addition, if you click the first item listed in the menu (Layers…), the Layers dialog box will 
appear--allowing you to edit and delete existing layers or to create new ones. For an overview, see 
What are Layers?. For step-by-step directions on using and creating layers, see the Layers 
command.

· Zoom percentage. This item shows the current magnification level of your drawing. To change the 
percentage, though, you must use the Zoom In and Zoom Out tools. For more information on working 
with the zoom tools, see the Zoom In Tool and the Zoom Out Tool.



Data Display Bar in Drawing Mode

When you are drawing an object, MiniCAD automatically changes the Data Display Bar at the top of the 
drawing window to "drawing mode." Depending on what drawing tool you are using, the bar displays 
different fields. Here are some of the more common fields:

· DX: The offset distance from the previous click or position of x.
· DY: The offset distance from the previous click or position of y.
· DZ: The offset distance from the previous click or position of z.
· L: The length of the object you are drawing.

· R: The radius of the object you are drawing.

· Area: The area of the object you are drawing.

· Perim: The perimeter of the object you are drawing.

· Ratio: The ratio of width to length in the object you are drawing.

· A: The angle of the object you are drawing.

· Rise: The angle (rise) of the roof you are drawing.

· Run: The pitch (run) of the roof you are drawing.

· X: The x (horizontal) location of the cursor in the drawing window.

· Y: The y (vertical) location of the cursor in the drawing window.

When drawing an object, you can use the Data Display Bar to type in exact dimensions and coordinates, 
rather than dragging the mouse to change the object's values. 

Note 
If a value is listed directly on the Data Display Bar, rather than in a text box, you cannot type in values.

While drawing with the mouse, use the TAB key to move the cursor from one field to the next--the 
selected field will be highlighted--and simply type the information in the correct text box. When you have 
finished typing the information, press the ENTER/RETURN key. MiniCAD will create the object using the 
information you entered.



Mode Bar

The Mode Bar at the top of the drawing window is activated when you select one of MiniCAD's 2D or 3D 
tools. 

It displays two types of information about the selected tool:

· The Tool's Available Modes. The Mode Bar contains special buttons for 2D and 3D tools that have 
more than one mode. (For example, the Eyedropper Tool has two modes--Pick Up Attributes and Put 
Down Attributes.) When you select a multi-mode tool, the Mode Bar displays a button for each 
available mode. In addition, the Mode Bar lists the name of the selected mode. 

· The Tool's Name. The Mode Bar displays the name of the tool you are using when you select any 2D
or 3D tool.



Views Bar

In MiniCAD 7 you have the ability to save individual views of your drawing, called "sheets." Then, at any 
time, you can flip through these sheets, examining your design from multiple views. (For more 
information, see the Save Sheets command.) 

The "Back" and "Forward" buttons on this bar are used to flip through different views. In addition, you'll 
find the six other options on this bar, located in the lower-left corner of the drawing window.

Back--Click to go to the previous saved sheet (view).

Forward--Click to go to the next saved sheet (view).

Zoom In--Works just like the Zoom In Tool on the 2D Tools palette. Click to double the magnification of 
your drawing. (For more information, see the Zoom In Tool.

Zoom Out--Works just like the Zoom Out Tool on the 2D Tools palette. Click to reduce by one-half the 
magnification of your drawing. (For more information, see the Zoom Out Tool.

100--Works just like the Normal Scale command. Click to display your drawing in its real-world scale. (For
more information, see the Normal Scale command.)

Fit to Window--Works just like the command with the same name. Click to display your whole drawing 
(all pages) in the Drawing Window. (For more information, see the Fit to Window command.)

Fit to Objects--Works just like the command with the same name. Click to have MiniCAD zoom in or 
zoom out so that all of the objects in your drawing are visible. (For more information, see the Fit to 
Objects command.)

Sheets shortcut menu--In addition to accessing the Edit Sheet and Save Sheet commands, you can use
this menu to select a sheet (view) by its name. (For more information, see the Edit Sheet command and 
the Save Sheets command)



Rulers and Grids

To help you precisely measure your drawings, MiniCAD gives you a range of Ruler and Grid options. You 
can set your units for inches, feet, millimeters, centimeters, meters, or some combination of these units. 
Or, if you prefer, you can create a customized measurement system. The program also allows you to hide
the rulers or grid in any drawing file. To learn more about working with rulers and grids, see How do I set 
up a drawing?.



Palettes

MiniCAD's Standard Overlay has eight palettes that you can use to create and edit objects in your 
drawing. You can display or hide MiniCAD's palettes in your drawing window. 

Depending on your initial settings, some combination of these palettes will appear when you first open the
MiniCAD drawing window.

Three tool palettes:

· 2D Tools
· 3D Tools
· Dimensioning Tools

Plus five other palettes:

· Attributes
· Constraints
· Object Info
· Resources
· Working Planes

For general information about these palettes, as well as step-by-step directions for using their tools and 
resources, see Palettes and Tools. 



What are the core concepts used in MiniCAD?

No matter how you plan to use MiniCAD, you need to have a basic understanding of how the MiniCAD 
drawing environment works. If you understand the following concepts, you will have a good reference 
point for learning and using any of MiniCAD's tools, commands, and resources.

2D objects

3D objects

Hybrid objects

Symbols

Layers and Classes

SmartCursor

Macros

Overlays

Stationery Pads

Worksheets



2D objects

In MiniCAD you can draw in a 2D, 3D, or hybrid (combined 2D and 3D) environment. To work most 
efficiently, you will want to use tools and symbols devised for the drawing environment you are using.

2D objects (squares, circles, lines) and symbols are designed for drafting alone. While they will display in 
a 3D drawing view, they will not interact with the 3D environment--if you try to walk around or fly over 
them, you will see that they remain "flat" and do not rotate with the rest of the drawing. 

For related information see the following:

3D objects
Hybrid objects



3D objects

In MiniCAD you can draw in a 2D, 3D, or hybrid (combined 2D and 3D) environment. To work most 
efficiently, you will want to use tools and symbols devised for the drawing environment you are using.

3D objects (extruded rectangle, for example) and symbols have heights (z coordinates) as well as widths 
and lengths (x and y coordinates). While 3D objects will display in a 2D drawing view--and from a 
Top/Plan view they will look flat--they will remain 3D objects with a height (z coordinate).

For related information see the following:

2D objects
Hybrid objects



Hybrid objects

In MiniCAD you can draw in a 2D, 3D, or hybrid (combined 2D and 3D) environment. To work most 
efficiently, you will want to use tools and symbols devised for the drawing environment you are using.

Hybrid objects are a composed of both 2D and 3D objects. The way these objects work is revolutionary to
the CAD field. Whenever you draw or insert a hybrid object, you are simultaneously adding both a 2D 
object and a 3D object to your drawing. Then, depending on which view you are in, that object will display 
and respond properly. For example:

in 2D views, the door symbol displays like this....

...however, in 3D view it displays like this.

There are six hybrid objects in MiniCAD--walls, roofs, floors, columns, parametric objects, and hybrid 
symbols. 
The advantage of working with hybrid objects is that you can automatically create 3D models from your 
2D drawings, or vice versa--a tremendous time saver. 
For related information see the following:

2D objects
3D objects



Symbols

In addition to the thousands of pre-built symbols that ship as part of the Design and Drafting Toolkit™, 
MiniCAD lets you make and reuse your own symbols. Unlike standard drawing objects, which are stored 
as individual items in your file, symbols are stored differently--the original symbol is stored in the MiniCAD
library and "linked" copies of it are placed in your drawing. Working this way gives you several 
advantages:

· Using symbols makes your files smaller. The whole symbol and its definitions are stored only once in 
your drawing file--then, only attribute information (location coordinates, rotation) is stored for each of 
the places that the symbol appears in your drawing, called instances. 

· If you decide to edit the symbol, you only need to do it once--just make your changes to the master 
symbol (called the definition), and MiniCAD will automatically update all the instances of the symbol in
your drawing. 

· You can attach database information and records to symbols--for example, prices and part numbers. 
This allows you to easily track items in your drawing and to print database reports and cost 
spreadsheets. 

· You can easily reuse symbols. With MiniCAD's Resource palette, you can import symbols from a 
closed file into your current drawing--much faster than first opening the file and then cutting and 
pasting an object. 

· Plus, when you import a symbol, MiniCAD also imports all database records and information that are 
attached to the symbol.

For more information about using the Resource palette to import symbols, see Working with Symbol 
Resources. For a listing of the industry-specific symbols included in the Design and Drafting Toolkit, see 
the MiniCAD Toolkit Manual.



Layers and Classes

Many CAD programs allow you to separate your drawings across flat layers. MiniCAD, however, gives 
you the added flexibility of creating layers that have heights (z coordinates) as well. Combined with the 
program's unique class feature, MiniCAD can significantly streamline the way you work. 

For further information see the following:

What are Layers?

What are Classes?



What are Layers?

On the most basic level, you can understand how MiniCAD layers work if you equate them to drawing on 
clear, acetate sheets. Layering a drawing across acetate sheets gives you immediate flexibility--you can 
stack the sheets in any order you want, or temporarily set aside some of them. For example, if you drew a
floor plan on two layers--one acetate sheet with your master 2D drafting plan and another with an addition
to the plan--you could easily look at the floor plan with or without the addition.

Yet, because these "layer sheets" are electronic rather than acetate, you can do a whole lot more with 
them. For starters, you can position them feet apart rather than flat on top of each other. And, with 
MiniCAD's modeling capabilities, you can use these layers to create 3D objects. For example, if you draw 
the first floor, second floor, basement, and roof of a house each on its own layer, you not only can print 
the 2D drafting plan for any one of these layers, but you also can link the drawing layers together, creating
a model of a fully formed 3D house.

MiniCAD gives you a tremendous range of options when creating layers. In MiniCAD, individual layers 
can be created with different scales, colors, and projections. You also can temporarily--or permanently--
make each layer visible, invisible, or "grayed." 

For more information about creating and working with layers, see the Layers command and the Layer 
Options command. For related information, see What are Classes?.



What are Classes?

In addition to layers, MiniCAD gives you another powerful way to organize the elements in your drawing--
classes. Because classes work across layers, they allow you to "group" similar objects in your drawing 
that for practical reasons need to exist on separate layers. This gives you another way of viewing and 
tracking a subset of objects in your drawing.

If you were drawing a house with four separate plan layers--first floor, second floor, basement, roof--you 
could group all lighting fixtures and wall sockets in a class called "Electrical." Then, by making the 
Electrical class visible and all other classes invisible, you could view and print an electrical plan for each 
story of the house. 

Just like with layers, MiniCAD gives you flexible options when working with classes. Most important, you 
can link class information to worksheets. Using the house example, not only could you print an electrical 
plan for the house, but you also could keep a running inventory of the cost for all lighting fixtures and wall 
sockets.

For more information about creating and working with classes, see the Classes command. For related 
information, see What are Layers?.



SmartCursor

MiniCAD's SmartCursor™ helps you quickly create precise drawings. The SmartCursor is really a system 
of cues that you can set to appear on your drawing screen. Then, depending on where your cursor is 
located and on what cues you have asked MiniCAD to give you, the SmartCursor will automatically let 
you know your options. 

There are two types of cues you can set--Snap Point and Floating Datum. For detailed information on 
working with and changing settings in the SmartCusor, see the Constraints Palette.



Snap Point

The SmartCursor's ability to automatically "snap" objects to specific points in your drawing makes it easy 
for you to create mathematically precise drawings. 

Say you want to join two lines at their exact endpoints. Without the SmartCursor, you would have to zoom
way in--say, 1000 percent--in order to see that the lines joined precisely where you wanted them to. 
However, in MiniCAD you can set the SmartCursor to automatically join neighboring objects at their 
endpoints. Then, when the line you are drawing comes within the specified distance of the first line (the 
default distance is six pixels), MiniCAD will give you a screen signal--letting you know that if you release 
the mouse button, the two lines will be joined at their endpoints. 

This feature lets you "click with confidence," knowing without seeing it that MiniCAD is placing objects 
precisely where you want them. The Snap Point options you can set change depending on whether you 
are drawing in 2D or 3D. In general, though, you can snap to various points, vectors, and surfaces in your
drawing. 

For related information, see Floating Datum.



Floating Datum

MiniCAD uses a Cartesian coordinate system--where the default origin of your grid is set at the x and y 
coordinates 0, 0. From that starting point, everything else is either a positive or negative width (x and -x) 
and a positive or negative height (y and -y) away. 

MiniCAD's SmartCursor allows you to temporarily change the datum (origin) of your grid and use the Data
Display Bar like a tape measure. This is especially useful when you want to position one object at a 
relative x and y distance from another.

Say you've just drawn a gazebo and you now want to position a line of trees parallel, but five feet to the 
left, of it. You could use the SmartCursor to set the Floating Datum (origin) to the upper-right corner of the 
gazebo. Then, when you drag the mouse, the Data Display Bar will let you know how far away your 
cursor is from your new datum. You can even type 5' in the Data Display Bar and then press the 
ENTER/RETURN key. A guideline will appear on your screen, marking the starting edge for your line of 
trees in one fluid movement.



Macros

Built into MiniCAD is a powerful programming language called MiniPascal. MiniPascal makes it possible 
for you to use and create macros--recorded directions--to automate your complex or routine drafting 
tasks. When you "run" a macro, MiniCAD automatically follows the macro's directions in the sequence 
that you ordered.

More than 300 ready-to-use macros come with your MiniCAD 7 software. In addition, the range of macros
you can create with MiniPascal is nearly endless. Here are just a few of the types of macros you can 
create: 

· A macro that customizes your working environment. For example, you can create a series of 
macros that will set up the file foundation for each type of drawing you regularly produce--
automatically creating and naming several layers, setting each layer's scale and visibility, creating 
customized classes, and controlling the default settings for the SmartCursor. Then, rather than adjust 
each of those elements when you create a new drawing file, you can let the macro do the work for 
you.

· A macro that creates a new "drawing tool." Say you often draw complex wiring diagrams that have
color-coded circuits. You could create a macro that draws a hairline blue line, another that draws a 
thick red line, and another that draws a medium-weight black line. Then, rather than resetting the line 
color and weight attributes for each object you draw in each file, you would only need to run the 
correct macro and start drawing.

· An interactive macro that helps you create a customized object. In this case, you would select 
the macro for the object you want to create, and the program will prompt you with a dialog box, asking
for variables. For example, if you ran a ball bearings macro, MiniCAD would prompt you for details 
such as type, diameter, and inches or metric. Then, after you had typed in these variables, MiniCAD 
would create ball bearings to match your specifications.

· An interactive macro that processes your drawing. MiniPascal is also powerful enough to create 
and run interactive macros that "read" and react to attributes in your drawing file. For example, in the 
DTM module, there's a macro that converts 2D contours into 3D objects. When you run this macro, 
MiniCAD finds all the 2D contours in your drawing and prompts you to type in the start elevation and 
interval and to chose between polygons or loci. Then it changes the contours into objects with z 
heights, according to your specifications. 

You can find a list of the ready-to-use macros, arranged according to industry, in the MiniCAD Toolkit 
Manual. For more information about creating macros, see the MiniCAD MiniPascal Manual. 



Overlays

Because MiniCAD is a versatile CAD package, it contains hundreds of specialized tools and commands. 
Yet, if all of these were displayed at one time, your drawing window would be very cluttered. For that 
reason, MiniCAD comes with different overlays to help streamline your working environment:

· AEC

· CIVIL

· ELECTRIC (electrical)

· MECH (mechanical)

· 7STANDARD

· TERRAINM (terrain modeler)

· TOOLKIT

Each overlay is really an industry-specific combination of menu commands and tools. When you first open
MiniCAD, the program defaults to the Standard Overlay. If you switch to the AEC Overlay, you'll see that 
four new tools are added to the 2D Tools palette--the Number Stamp, Stair, Wall, and Property Bounds 
tools. If you then switch to the Civil Overlay, you'll see that those four AEC tools disappear from the 2D 
Tools palette, and that a Civil menu with two new commands (Engineering Properties… and Structural 
Shapes…) is added to the Menu Bar.

For more information about the combination of menu commands added with the each industry-specific 
overlay, see the MiniCAD Toolkit Manual. To learn how to change overlays, see How do I switch 
overlays?.



Stationery Pads

In MiniCAD, template files are called "Stationery Pads." Using stationery pads is a way that you can 
standardize and streamline your work. Just like with macros, you can create a stationery pad that will set 
up the foundation for your drawing environment. Then, rather than changing each setting before you 
begin drawing, you can open a stationery pad and immediately get to work.

Stationery pads give you additional ways to customize the foundation for your drawing environment. In 
addition to all the things you can do with macros (creating and naming layers, setting each layer's scale 
and visibility, creating customized classes, controlling the default settings for the SmartCursor) with a 
stationery pad you can also automatically "import" customized command palettes and symbols. You can 
even import macros.

An advantage to using stationery pads is that MiniCAD will never let you accidentally "erase" or "write 
over" your template file. When you open a stationery pad, MiniCAD automatically opens a copy of the file.
Then, when you go to save your drawing for the first time, MiniCAD will prompt you for a new file name--it 
is impossible to unknowingly replace the master stationery pad with your new drawing file.

In addition to letting you create your own stationery pads, MiniCAD comes with a number of ready-to-use 
pads in the Design and Drafting Toolkit. In the Mechanical Engineering Toolkit, for example, there is a 
stationery pad called "Detail GD&T." If you open this template, you'll see that the drawing file has been set
up for Geometric Dimensioning and Tolerancing. There are two layers--both set for 1:1 engineering 
scale--and the drawing window and grid display in decimal inches, accurate to three decimal places. In 
addition, there are four command palettes geared for mechanical detail drawing (Line Styles, Drafting 
Tools, Dimensioning, and Geometric Tolerancing). 

MiniCAD allows you to choose one "default" stationery pad--which will automatically open when you 
create a new drawing file--and as many other specially named stationery pads as you want. Opening 
these other stationery pads is as easy as opening a drawing file. For step-by-step directions on creating 
stationery pads, see How do I work with template files?.



Worksheets

MiniCAD's worksheet capabilities make it far more dynamic than a mere drawing program. In any 
MiniCAD file, you can create or import a worksheet capable of tracking data--such as material schedules 
and cost estimates--in your drawing. 

You can create worksheets and add information easily to them while you're designing--you don't have to 
leave the drawing window. Then, whenever you want, you can view the worksheet data as either a 
spreadsheet or as database rows.

Using a MiniCAD Worksheet Like a Spreadsheet

Using a MiniCAD Worksheet like a Database



Using a MiniCAD Worksheet Like a Spreadsheet

Like a typical accounting spreadsheet, you can use MiniCAD spreadsheet rows as a multi-column 
analysis of your file that can perform mathematical calculations. You can create formulas using the more 
than 30 built-in functions, which include adding, subtracting, multiplying, and dividing within a column or 
across columns.

With a spreadsheet setup, for example, you could produce a cost analysis of your initial design. Then you 
can play "what if" games, and the spreadsheet will track how your changes affect the overall cost of your 
design. 

For detailed information about using and creating worksheets, spreadsheets, and databases, see Using 
Worksheets.



Using a MiniCAD Worksheet like a Database

You can use MiniCAD worksheet rows as a database--a comprehensive list--of the objects in your 
drawing. MiniCAD's database capabilities then allow you to search the list for objects that meet any set of 
criteria you specify. You can specify dozens of criteria combinations, including an object's name, line 
weight, fill pattern, layer, or class. 

For example, you could ask MiniCAD to give you a listing of all the furniture in a resort you've designed or
for a listing that shows only the green wing-backed chairs that you placed in the two-room suites that are 
scattered throughout the resort.

MiniCAD gives you a wide range of options when using and creating worksheets. You can link worksheets
within a drawing so that they share information, and you can import worksheets--or just their formulas--
from one drawing into another. 

For example, if you customarily use the same set of objects in your drawings, you could create a 
stationery pad or a "master" drawing file with a worksheet that serves as a "master price list"--listing all 
the objects and their costs. Then, to create a materials list and cost estimate for any new design, you 
need only import the worksheet into your new drawing file.

You can even import worksheets from other software programs, such as Excel™ and FileMaker™, into 
MiniCAD. Or export MiniCAD worksheets into these other spreadsheet or database programs. 

For detailed information about using and creating worksheets, spreadsheets, and databases, see Using 
Worksheets.



How do I set up a drawing?

The following seven elements or "settings" determine the basic parameters of your drawing file. While you
can change these settings at anytime during the drawing process, it is usually most efficient to set them 
before you begin drawing--if needed, you can always change them later on.

Scale

Units

Snap and Reference Grids

Printer Setup

Drawing Size

Layers

Classes



Scale

Scale works the same way in MiniCAD that it does on a map--it's the ratio of the actual size of an object 
to its size in your drawing. For example, if you use MiniCAD's default scale of 1:1, every inch in your 
drawing will represent an inch in the "real world." The best scale to use will obviously depend on what you
are designing--and whether it makes sense to work with a life-sized, reduced, or enlarged drawing. 

In MiniCAD, you have the flexibility of setting one scale for all layers in your drawing, or setting a different 
scale for individual layers. 

For additional information, see the following topics:

How do I change a whole drawing's scale?

How do I change the scale of an individual layer?



How do I change a whole drawing's scale?
1. On the Page menu, click Scale… 

2. In the dialog box that appears, you will see several different scale options. You can either select an 
existing scale or create your own (by typing in a number after Paper Scale: 1:). 

3. To change the scale for the entire drawing--all layers-- select the All Layers checkbox. 

4. Decide if you want the text to be scaled in your whole drawing.

Tip
To ensure that the text in your drawing always appears in an appropriate size, make sure to select the
Scale Text checkbox.

· If you want scaled text, select the Scale Text checkbox. 

· If you don't want scaled text, make sure that the Scale Text checkbox is not selected.

5. Click OK.



How do I change the scale of an individual layer?

There are two ways you can do this. You can go to the layer you want to change in your drawing and 
follow the steps in How do I change a whole drawing's scale?, making sure that the All Layers checkbox 
is not selected. Or you can follow these steps:

1. On the Organize menu, click Layers… 

2. In the dialog box that appears, select the layer you want to change. (The easiest way is to double-
click the layer name in the scroll box under Layer:).

3. Click Scale… In the dialog box that appears, select the new scale you want to use for this layer--you 
can either select an existing scale or create your own (by typing in a number after Paper Scale: 1:). 

4. Make sure that the All Layers checkbox is not selected.

5. Decide if you want the text to also be scaled in this particular layer.

· If you want scaled text, select the Scale Text checkbox. 

· If you don't want scaled text, make sure that the Scale Text checkbox is not selected.

6. Click OK.

7. Decide if you want to change the scale for any other layers in your drawing.

· If you don't want to change the scale for other layers, click Done. 

· If you want to change the scale in other layers, Click Scale… and follow the directions starting 
with Step 3 above. When you are finished changing individual layer scales, click Done.



Units

MiniCAD gives you a wide range of measurement systems to choose from, including inches, feet, 
millimeters, centimeters, meters, or some combination of these units. In addition, the program gives you 
the flexibility to create your own customized measurement system. 

Whatever system of units you select, MiniCAD is smart enough to apply the measurement system 
globally throughout your drawing--from the measurements that display on the ruler to those used in 
dimensions and worksheets. In addition, MiniCAD coordinates your measurement system with the scale 
you have selected, automatically adjusting the level of precision in your drawing. 

For additional information, see the following topics:

How do I select an existing measurement system?

How do I create a customized measurement system?



How do I select an existing measurement system?
1. On the Page menu, click Units…

2. In the dialog box that appears, select the measurement system you want to use in the Unit Name: 
shortcut menu. 

Caution 
Select "Old-Style Feet & Inches" only if you are working with a drawing that was created in an older 
version of MiniCAD. Do not select this unit for new drawings because it will disable the program's 
automatic precision feature.

3. Decide whether you want unit marks to display alongside the measurements in your drawing. (Note If 
you select Feet & Inches, you'll see that MiniCAD automatically displays unit marks and, therefore, 
the Show Unit Mark checkbox will be checked and unavailable.)

· If you want unit marks displayed, select the Show Unit Mark checkbox. 

· If you don't want unit marks displayed, make sure that the Show Unit Mark checkbox is not 
selected.

4. Decide if you want parts of whole units to display as fractions or as decimals.

· For fractions, select the Display as Fractions checkbox.

· For decimals, make sure that the Display as Fractions checkbox is not selected. 

5. Select what dimension you want units rounded to and what angular accuracy you want to use in the 
Round Dimensions To: and the Angular Accuracy: shortcut menus. If you are working with decimals, 
you also need to select what Decimal Format: you want MiniCAD to use.

6. Click OK.



How do I create a customized measurement system?
1. On the Page menu, click Units…

2. In the dialog box that appears, select Custom from the Unit Name: shortcut menu. Or, if you have 
already created a custom measurement system, select that unit from the Unit Name: shortcut menu 
and then click Edit Custom…

3. In the dialog box that appears, type information in these four text boxes. 

· Unit Name: In this box, type the name you want to give to your custom measurement system--for 
example, "MiniCAD."

· Units in an inch: In this box, type how many units in your custom measurement system equal (fit 
inside) a standard inch--for example, typing in "5" would mean that there are 5 MiniCADs in one 
inch, just as there are 2.54 centimeters in one inch.

· Unit Mark: In this box, type what mark (abbreviation) you want to use to represent a unit in your 
custom measurement system--for example, "mc" to stand for "MiniCAD."

· Square Unit Mark: In this box, type what mark (abbreviation) you want to use to represent a 
square unit in your custom measurement system--for example, "sq mc" for a "square MiniCAD."

4. Click OK. The Custom Units dialog box will close, taking you back to the Set Units dialog box.

5. Decide whether you want unit marks to display alongside the measurements in your drawing. 

· If you want unit marks displayed, select the Show Unit Mark checkbox. 

· If you don't want unit marks displayed, make sure that the Show Unit Mark checkbox is not 
selected.

6. Decide if you want parts of whole units to display as fractions or as decimals.

· For fractions, select the Display as Fractions checkbox.

· For decimals, make sure that the Display as Fractions checkbox is not selected. 

7. Select what dimension you want units rounded to and what angular accuracy you want to use in the 
Round Dimensions To: and the Angular Accuracy: shortcut menus. If you are working with decimals, 
you also need to select what Decimal Format: you want MiniCAD to use.

8. Click OK.



Snap and Reference Grids

MiniCAD has two separate grid systems to help you draw easily and precisely:

· The Snap Grid is an invisible grid that MiniCAD uses to help you draw and place objects precisely. As 
you drag your mouse across the screen, it will automatically "catch" at each increment on the Snap 
Grid.

· The Reference Grid, however, is the grid that actually displays on your screen. The most useful way 
to set the Reference Grid is so that it is an extension of the scale you have set. 

Depending on what you are drawing, you may or may not want these two grids to be identical. For 
example, say you are designing kitchen cabinets with a tolerance of one-sixteenth of an inch. It would 
make sense to set the Snap Grid to 1/16". However, it would be hard to draw on a screen that displayed 
16 horizontal and vertical lines squeezed within every inch. For that reason, you might want to mark off 
only whole inches on your screen by setting the Reference Grid to 1". 

You set both grids in the same place:

1. On the Page menu, click Set Grid…

2. In the dialog box that appears, type the setting you want MiniCAD to use for your Snap Grid in the 
text box after Current Snap Grid:--for example, type 1/16" 

3. Then, type the setting you want MiniCAD to use for your Reference Grid in the text box after 
Reference Grid:--for example, type 1"

4. Determine if you want your Reference Grid lines to display on your screen.

· If you want the grid lines to display, select the Show Grid Lines checkbox.

· If you don't want the grid lines to print, make sure the Show Grid Lines checkbox is not selected.

5. Determine if you want your Reference Grid lines to print.

· If you want the grid lines to print, select the Print Grid Lines checkbox.

· If you don't want the grid lines to print, make sure the Print Grid Lines checkbox is not selected.

6. Click OK.



Printer Setup

You use the printer setup facility to tell MiniCAD the type of printer you want your drawing set up for, as 
well as the paper size, scale, and orientation of your drawing. All of these elements help determine the 
"print boundary" of your drawing, which is marked by a gray box on the screen. To change your Printer 
Setup settings: 

Note 
Depending on your printer and printer drivers, this dialog box may not resemble the one that displays on 
your screen.

1. On the File menu, click Print Setup

2. In the dialog box that appears, select the:

· printer/device you are printing to, 

Important 
Selecting a printer in Printer Setup will only change your drawing's settings; you need to change 
the printer in your Print Manager in order to change the printer that your drawing is sent to.

· size or type of paper you are using, and

· orientation of your drawing--whether you want your drawing to be "portrait" (vertical) or 
"landscape" (horizontal). 

3. Click OK.



Drawing Size

The drawing size is the actual size of your drawing--not the size of paper your printer uses. MiniCAD 
considers the settings you've chosen in Printer setup along with the drawing size you've specified to 
automatically figure out how many sheets of paper your drawing needs to be printed on in order for the 
whole drawing to come out of your selected printer. 

For example, say you are designing a house and you plan to send the final drawings to a service bureau 
to be printed on a plotter. In the meantime, however, you need to print out proofs of your house design on 
your office laser printer, which only takes 8-1/2" x 11" sheets of paper. By typing in the dimensions of a 
"D" size sheet of technical paper in the Drawing Size and selecting "US Letter" for the paper type in 
Printer Setup, MiniCAD will determine that your drawing needs to be "tiled" across 12 sheets of      8-1/2" x
11" paper. And it will automatically show 12 linked gray boxes on your screen, marking off the portion of 
the whole drawing that will print on each sheet of 8-1/2" x 11" paper. (When the service bureau changes 
the settings in the Printer Setup box for its plotter, MiniCAD will automatically convert the 12 smaller 
boxes into one large one.)

To change your Drawing Size settings:

1. On the Page menu, click Drawing Size… 

2. In the dialog box that appears, either:

· Type the Width: and Height: of your total drawing and select either inches (inch) or millimeters 
(mm). 

· Or, if your final drawing size matches an existing paper type, select that type from the Size: 
shortcut menu.

3. Decide if you want to see the individual page breaks.

· If you want to see gray lines marking what portion of the drawing will print on each piece of paper,
select the Show page breaks checkbox.

· If you prefer to see a single gray border box around the entire drawing, do not select the Show 
page breaks checkbox.

4. Click OK.



Layers

Layers are viewed and printed in "stacking order"--their top to bottom order in the Layers Setup dialog 
box. Initially, layers are "stacked" in the order in which they are created, but you can change their order at 
anytime. In addition, you can link 3D layers to automatically create a 3D model. For a detailed explanation
of how layers work in MiniCAD, see What are Layers?.

For additional information, see the following topics:

How do I create a new layer?

How do I change the stacking order of layers?

How do I link 3D layers to create a 3D model?



How do I create a new layer?
1. On the Organize menu, click Layers…

2. In the dialog box that appears, click New. (You'll see that MiniCAD automatically creates a new layer--
for example, Layer-2--and lists it in the box after Layer:) If you want to, you can type over the name 
MiniCAD assigns, renaming the layer. 

3. Decide if you want this new layer to be your active (working) layer.

· If you do, make sure to select the Active Layer checkbox.

· If you don't, make sure that the Active Layer checkbox is not selected.

4. Decide how you want MiniCAD to display and print this new layer when you are working in other 
layers:

· Select the Normal checkbox if you want to see all objects in your new layer even if it is not the 
active layer. (Normal layers are marked with a "X" in the list.)

· Select the Grayed checkbox if you want all 2D objects in your new layer to display as grayed 
(ghosted) when it is not the active layer. Note 3D objects, text, and fills are not displayed in 
grayed layers. (Grayed layers are marked with a "x" in the list.)

· Select the Invisible checkbox if you want all objects in your new layer to be invisible (hidden) 
when it is not the active layer. 

5. Decide if you want to change the Transfer Mode: setting--in most cases, these settings are useful only
if you are working with 24-bit color and are not using a Postscript printer or a plotter.

· Select Paint if you want to make objects in your new layer solid, obscuring any objects that are in
layers stacked below it.

· Select Overlay if you if you want to make objects in your new layer transparent so they do not 
obscure any objects that are in layers stacked below it.

· Select Invert if you want a photo negative (reverse) image to appear any time an object in your 
new layer overlaps an object in any other layer.

· Select Erase if you want objects in your new layer to display all foreground patterns as white and
all background patterns as transparent.

· Select Not Paint if you want to make objects in your new layer solid and, rather than obscuring 
any objects in layers stacked below, to invert the overlapping areas--display as photo negatives.

· Select Not Overlay if you want to give objects in your new layer a transparent effect and to invert
layer colors.

· Select Not Invert if you want to give objects in your new layer a transparent effect and to make 
overlapping black pixels from other layers white and overlapping white pixels transparent.

· Select Not Erase if you to give objects in your new layer a transparent effect and to make 
overlapping white pixels from other layers black and overlapping black pixels transparent. 

6. Decide if you want to set a separate scale for your new layer. If you do, click Scale…, set the new 
scale in the dialog box that appears, and click OK. (For directions, see How do I change the scale of 
an individual layer?.)

7. Decide if you want to change the foreground and background pen and fill colors. If you do, click 
Colors… and in the dialog box that appears, select the new Fill foreground: and background: and Pen
foreground: and background: colors. Click OK.

8. If you want your new layer to have a Z and DZ height, type these values. (For information on how 
MiniCAD uses them to create 3D models, see How do I link 3D layers to create a 3D model?.)

9. Click Done.





How do I change the stacking order of layers?
1. On the Organize menu, click Layers…

2. In the dialog box that appears, you will see the current stacking order of layers under Layer:--the first 
layer listed is the top layer, and the last layer listed is the bottom layer.

3. Select a layer that you want to move, and use one of the commands under Move:

· If you click Top, MiniCAD will move the selected layer to the top of the list, making it the top 
layer.

· If you click Up, MiniCAD will move the selected layer up one position in the list.

· If you click Down, MiniCAD will move the selected layer down one position in the list.

· If you click Bottom, MiniCAD will move the selected layer to the bottom of the list, making it the 
bottom layer. 

4. When you have the layers in the order that you want them, click Done. 



How do I link 3D layers to create a 3D model?

MiniCAD allows you to set Z and DZ values for each layer. When the Z values for your layers are set in 
proper relation to each other, MiniCAD will automatically "link" them and create a 3D model.

The easiest way to link layers is to assign the Z and DZ values when you create them. This is because 
MiniCAD will automatically add the Z and DZ height of your first layer and insert the sum value as the Z 
height for the next layer you create. (For detailed instructions, see How do I create a new layer?.) 

However, you can also add or change Z and DZ heights at any time:

1. On the Organize menu, click Layers…

2. In the dialog box that appears, select an existing layer from the Layer: list. 

3. Assign a Z value--this value represents the distance between the ground plane (0") and the first layer.
For example, if the bottom layer is to be six feet below ground, you would type -6' after Z:

4. Assign a DZ value--the height of that particular layer. For example, if you were designing a building 
with eight-foot ceilings, you would type 8' after DZ: 

5. When you are done assigning Z and DZ heights, click Done.



Classes

If possible, you will want to set up your classes before you begin drawing. That way, you can tag each 
object as you create it. For a detailed explanation of MiniCAD classes, see What are Classes?.

For additional information, see the following topics:

How do I create a new class?

How do I rename an existing class?



How do I create a new class?
1. On the Organize menu, click Classes…

2. In the dialog box that appears, select New… Type the name you want to assign in the text box after 
Give a name to this class: and click OK.

3. Decide if you want the objects in this class to display in your drawing. 

· If you do want objects in this class to be visible, select Normal. (Normal classes are marked 
with a "X" in the list.)

· If you want objects in this class to be hidden, select Invisible. (For example, if you create a 
"Stock #" class for objects in your drawing, but you don't want these stock numbers to print as 
part of your drawing.)

4. Click OK.



How do I rename an existing class?
1. On the Organize menu, click Classes…

2. In the dialog box that appears, select Rename… Type your new name in the text box after Rename 
this class: and click OK. The Rename dialog box will close, taking you back to the Classes dialog box.

3. Click OK.



How do I work with template files?

If you typically use the same initial settings in your drawing files--scale, units, snap and reference grids, 
page setup, drawing size, layers, classes--you can create a template file with these settings. Then, rather 
than change all of these settings before you begin drawing, you only need to open the correct template 
file. In MiniCAD, template files are called stationery pads. (For a detailed explanation of MiniCAD 
stationery, see Stationery Pads.)

For additional information, see the following topics:

Creating Stationery Pads

Opening Stationery Pads



Creating Stationery Pads
1. Make sure you have added or set all the elements you want to be part of your stationery pad--along 

with initial settings, you can also add symbols, worksheets, and other MiniCAD objects to your 
stationery pads.

Important 
You must save all MiniCAD stationery pads in the same directory as your MiniCAD program files.

2. On the File menu, click Save As Stationery… 

3. In the dialog box that appears, select the directory that you want the stationery pad saved in--you can 
place stationery pads in any directory as long as it is part of the main directory where your MiniCAD 
program files are stored. 

4. Type the name you want to give to your stationery pad in the box after New file name:

5. Click Save.



Opening Stationery Pads
1. On the File menu, click Open… In the dialog box that appears, select the stationery pad that you want

to open.

2. Click Open.



How do I move around in a drawing?

MiniCAD gives you several ways to move around within a drawing file, allowing you to look at the whole 
drawing or at select portions of it. The following navigation tools work for both 2D and 3D drawings.

Pan Tool

Scroll bars

Autoscroll

Arrow Keys

Zoom Buttons



Pan Tool

This tool, located on the 2D Tools palette, is the fastest way to move around a drawing. You use it to 
"grab" your drawing and move it around the screen.

1. Select the Pan Tool. 

2. Move the Selection Arrow into the drawing window--you'll see that the standard arrow cursor changes
into a hand. 

3. Click and hold down the left mouse button, and drag the drawing around the screen. 

4. When the drawing is where you want it, release the mouse button.



Scroll bars

Like most Windows programs, MiniCAD has scroll bars that run along the right and bottom edges of the 
drawing window. They also can be used to move your drawing around the screen. However, they are best
used for small movements-- because they require the screen to redraw more frequently, they are much 
slower than the Pan Tool for large movements.

Note 
In MiniCAD you can choose to display or hide the scroll bars. This option is in the Preferences dialog box.

1. Move the cursor over to the scroll bars--you don't need to switch to the selection tool.

2. Then, move the drawing by either

· clicking on a scroll arrow, or

· dragging the scroll box.

3. When the drawing is where you want it, move the cursor back into the Drawing Window and continue 
working.



Autoscroll

MiniCAD gives you a way to automatically move your drawing either one half-screen up or to the left--
called autoscroll. 

1. Select the Selection Arrow on either the 2D or 3D Tools palette. 

2. Press and hold down the left mouse button--you'll see that the arrow cursor turns into a pointed finger.
Then drag the cursor on top of a scroll bar. 

· If you drag it over the right scroll bar, MiniCAD will move your drawing one half-screen to the left.

· If you drag it over the bottom scroll bar, MiniCAD will move your drawing up one half-screen.



Arrow Keys

You can use the arrow keys on your keyboard to move the drawing around your screen. Pressing a key 
once will move the drawing one half-screen in the direction of the arrow. For example, pressing the up 
arrow will move your drawing up by one half-screen. 



Zoom Buttons

For anyone who's worked with a 35mm camera and a zoom lens, the concept of "zoom" is familiar. In 
MiniCAD, zoom works in a similar way--you "zoom in" to get a close-up view of your drawing and "zoom 
out" to get a broader view. MiniCAD has several different ways to zoom in and out, which are listed below.

Zoom In Tool

Zoom Out Tool

Marquee Zoom

Fit To Window Command

Fit to Objects

Normal Scale



Zoom In Tool

The Zoom In tool is an easy way to quickly magnify your drawing. Each time you double-click the Zoom In
tool on either the 2D Tools palette or the Views Bar, MiniCAD doubles the magnification of the drawing. 

Note
There are also keyboard shortcuts for zooming in and out. See General Keyboard Shortcuts.



Zoom Out Tool

Each time you double-click the Zoom Out tool on either the 2D Tools palette or the Views Bar, MiniCAD 
will reduce by one-half the magnification of your drawing. 

Note
There are also keyboard shortcuts for zooming in and out. See General Keyboard Shortcuts.



Marquee Zoom

Using "marquee zoom". you can pick a section of your drawing to magnify. 

1. Select the Zoom In tool--you'll see that the arrow cursor turn into cross hairs (two crossed lines).

2. Drag a box around the portion of the drawing that you want to zoom in on--this dashed box is called a 
"marquee box"--and then release the left mouse button. MiniCAD will automatically enlarge the 
section you selected so that it fills the Drawing Window.



Fit To Window Command

Using the Fit to Window command on the Page menu, you can tell MiniCAD to magnify or reduce your 
drawing so that it fills the Drawing Window: On the Page menu, click Fit To Window. 



Fit to Objects

Using the Fit to Objects command on the Page menu, you can tell MiniCAD to magnify your drawing so 
that objects in the drawing fill the Drawing Window. To magnify all objects:

1. Make sure that no objects are selected.

2. On the Page menu, click Fit to Objects.

To magnify a particular object or group of objects to fill the Drawing Window:

1. Select the object or objects you want to magnify.

2. On the Page menu, click Fit to Objects.



Normal Scale
The Normal Scale command automatically magnifies or reduces your drawing so that it displays in its 
actual size--100 percent: On the Page menu, click Normal Scale. 

Hint
If you have an object selected when you select Normal Scale, MiniCAD will center that object in the 
Drawing Window.



How do I print a drawing?

MiniCAD can print or plot to any device you have selected in your Print Manager. The actual parameters 
of your printed or plotted file are determined by your Printer Setup and Drawing Size settings (see Printer 
Setup and Drawing Size).

Remember
Your Printer Setup and Drawing Size settings determine how your drawing is printed.

When you send a MiniCAD file to a printer, all visible objects, layers, and classes will print. In addition, 
any worksheets that are placed on the drawing will also print. (For directions for printing individual 
worksheets, see the Print command.)

1. On the File menu, click Print… 

2. The available options in the dialog box that appears will depend on the printer/plotter you have 
chosen. For example, it may ask you to specify which pages and how many copies you want to print.

3. Click Print.



How can I draw objects?

In MiniCAD, objects are drawn using either the mouse, the keyboard, or a mouse-keyboard combination. 
The following are MiniCAD's basic drawing methods. For step-by-step instructions for using each of 
MiniCAD's specific drawing tools--for example, the Line Tool or the Arc Tool--see Palettes and Tools. 

Drawing an Object Using the Mouse

Drawing an Object Using the Keyboard



Drawing an Object Using the Mouse

The mouse is the easiest way to draw in MiniCAD. Depending on the type of object you want to draw, you
select the tool button and draw using either the Click-Drag or the Click-Click mode.

· The Click-Drag Mode is where you click and continue to hold down the left mouse button while 
drawing an object, releasing it when the object is the size and shape you want. The Rectangle Tool is 
an example of an object tool that uses the Click-Drag Mode.

· The Click-Click Mode is where you click the mouse to mark the start point of an object, and then 
click again at each of the object's corners or vertexes. The Polyline Tool is an example of an object 
tool that uses the Click-Click Mode. 

For additional information, see the following topics:

Using the Data Display Bar with the Mouse



Using the Data Display Bar with the Mouse

Combining the mouse with the Data Display Bar is a precise way to draw an object. This method is 
especially useful for creating objects that are smaller than your current Snap Grid. While drawing an 
object using either the Click-Click or Click-Drag mode, press the TAB key--if you're using the Click-Drag 
mode, you need to be holding down the left mouse button when you press TAB. You'll see that the X: field
is selected. Type the X value and press TAB again to move to the next field.



Drawing an Object Using the Keyboard

All of MiniCAD's drawing tools can be manipulated using the keyboard. If you double-click a drawing tool 
in the 2D or 3D Tools palette, a dialog box will appear that allows you to type in exact specifications--a 
highly accurate way to draw. 



How do I create text?

MiniCAD has text handling capabilities similar to those found in desktop publishing programs. You can 
create single lines as well as blocks of text. And because MiniCAD "sees" all text as 2D objects, you can 
manipulate text like other 2D objects--for example, move, duplicate, array, or rotate it.

For additional information, see the following topics:

Creating a Line of Text

Creating Text Blocks



Creating a Line of Text

Use these directions if you want to type a sentence or less of text--for example, if you want to type a page
header. 

1.  On the 2D Tools palette, select the Text Tool--you'll see that the arrow cursor changes to a box 
with a vertical line. 

2. Move the cursor to the spot on the drawing where you want the text to begin and click--a blinking 
cursor will appear. Type your text. 
3. If you want to add another line of text to your drawing, move the cursor to a new location on the 
drawing, click, and type your text.
4. When you are finished typing lines of text, "deselect" the Text Tool by selecting another tool, such 
as the 2D Selection Tool. 



Creating Text Blocks

Use these directions if you want to type more than a sentence of text--for example, a paragraph of 
specification details. 

1.  On the 2D Tools palette, select the Text Tool--you'll see that the arrow cursor changes to a box 
with a vertical line. 

2. Move the cursor to the spot on the drawing where you want the text to begin and click but don't 
release the left mouse button. While holding down the mouse button, draw a rectangle to mark the area 
where you want your text to be placed, and then release the button--a "marquee box" will appear with a 
blinking cursor in the upper-left corner.

Hint 
Only use hard returns to mark the end of a paragraph or section--MiniCAD will automatically "wrap" 
text to the next line when it reaches the edge of a text box.

3. Type your text--you'll see that text automatically "wraps" to the next line when it reaches the right 
edge of the box. 

4. If you want to add another text block, move the cursor to a new location, draw another marquee box, 
and type your text.

5. When you are finished typing text blocks, "deselect" the Text Tool by selecting another tool, such as 
the 2D Selection Tool. 



How do I format text?

MiniCAD allows you to change the font, style, size, color, justification, and line spacing (leading) of text. 
You can change each one of these options for whole blocks of text or for select characters and words 
only. The following directions cover basic formatting techniques only. For a full description of all the 
available options for formatting text, see the Text menu and commands. 

For additional information, see the following topics:

Formatting Lines or Blocks of Text

Formatting Select Characters or Words

Changing Your Default Text



Formatting Lines or Blocks of Text

Use these directions if you want to change the look of an entire line or block of text.

1. Select the text that you want to change--you'll see that black squares mark the corners of the selected
text. 

2. On the Text menu, choose the text option you want to change--for example, Font, Size, or Style. 

3. In the shortcut menu that appears, click the new specification--for example, the new type size.



Formatting Select Characters or Words

Use these directions if you want to change only a select part of a line or block of text.

1. On the 2D Tools palette, select the Text Tool--you'll see that the arrow cursor changes to a box with a 
vertical line.

2. Position the cursor at the start of the portion of text that you want to change and click--you'll see that 
a blinking cursor has appeared where you clicked the mouse.

3. While holding down the left mouse button, drag the cursor through the text you want to change so that
it is "highlighted." 

Hint 
You can easily select a whole word with the text tool--simply double-click anywhere within the word.

4. On the Text menu, choose the text option you want to change--for example, Font, Size, or Style. 

5. In the shortcut menu that appears, click the new specification--for example, the new font style.



Changing Your Default Text

MiniCAD allows you to change the initial (default) text settings. Then, from that point forward, all text that 
you type--in that drawing or any other--will use your new font, size, style, justification, and line-spacing 
settings.

1. On the 2D Tools palette, choose the 2D Selection Tool.

2. Make sure that no objects or text are selected in your drawing--if needed, click the selection arrow on 
a blank portion of the Drawing Window.

3. On the Text menu, choose the text option you want to change--for example, Font, Size, or Style. 

4. In the shortcut menu that appears, click the new specification--for example, the new font. Now 
anytime you add text, MiniCAD will use your new text setting. 



How can I select objects, including text?

There are several ways that you can select objects or groups of objects in MiniCAD. These include 
everything from simple mouse movements to menu commands and macros created using MiniPascal, the
built-in programming language.

Using the Mouse

Using the Select All Command

Creating a Custom Selection Macro



Using the Mouse 

The following are ways you can use the mouse to select a single object or a group of objects in your 
drawing.

Clicking

Shift-Clicking

Drawing a Marquee Box

Drawing an Control-Marquee Box



Clicking an object to select it

The simplest way to select a single object is to use the Selection Tool (found on the 2D and the 3D Tools 
palettes) and click directly on the object. 

· If the object has a fill pattern, you can click anywhere on the object to select it. 

· However, if the object has an outline only and no fill pattern, you need to click directly on the object's 
outline. 



Shift-Clicking to select a group of objects

 To select more than one object at a time, use the SHIFT key along with the mouse. While pressing 
the SHIFT key, use the Selection Tool (found on the 2D and the 3D Tools palettes) to click each object. 
· If an object has a fill pattern, you can click anywhere on the object to select it. 

· However, if an object has an outline only and no fill pattern, you need to click directly on the object's 
outline. 

When you've finished selecting objects, release the SHIFT key. 



Drawing a Marquee Box

You can use the mouse to draw a marquee box around several 2D and 3D objects--this will select all 
objects that fit inside the box.

1.  On the 2D or 3D Tools palette, select the Selection Tool--the cursor will change to an arrow. 

2. While holding down the left mouse button, draw a "marquee box" (rectangle) around the objects 
you want to select, and then release the mouse button. 

Objects within the marquee box are selected.



Drawing an Control-Marquee Box

If you hold down the control key while drawing a marquee box around 2D and 3D objects, MiniCAD 
selects all objects that your box touches--not just the ones that fit inside the box. 

All objects touching the marquee box are selected.



Using the Select All Command

If you want to select all visible 2D and 3D objects in your active layer, there is a one-step way to do this. 
On the Edit menu, choose Select All--you'll see that all the objects pictured have been selected.



Creating a Custom Selection Macro
With MiniCAD's built-in programming language, you can create a macro that selects all objects that meet 
a highly specific set of criteria--for example, all objects drawn with solid black lines. The following example
shows how to create a macro that does just that--you can easily adapt it to select objects with a different 
criteria set. 

1. On the Organize menu, choose Custom Selection…

2. In the Custom Selection dialog box that appears      

· Choose Select Only (under Command listings). 

· Choose Create Command Macro (under Option listings). 

· Then click Criteria.

3. In the dialog box that appears: 

· Select Line Style from the left pop-up menu and the solid line from the right pop-up menu. 

· Click More Choices.

· Select Pen Fore Color in the bottom-left pop-up menu and black from the right pop-up color 
palette.

· Click OK.

4. In the Assign Name dialog box that appears, type the name you want to give to this new macro, and 
click OK. 

Your new macro is placed in the Commands palette--to run it, just double-click the command name. 
(To display the Commands palette, on the Window menu, choose Commands.) 

Note 
For detailed instructions about creating other kinds of macros, see the MiniCAD MiniPascal Manual.



How do I resize objects?

To resize 2D objects, you can use either the mouse or the keyboard. To resize 3D objects, you must use 
the keyboard.

Resizing objects with the Mouse

Resizing objects with the Keyboard



Resizing with the Mouse
1. Select the 2D object you want to resize--you'll see that black squares appear on each corner, or in a 

"box" around non-square objects such as circles.

2. Select one of the black squares, and while holding down the left mouse button, drag the mouse to 
resize the object:

· To resize both width (DX) and height (DY), drag the mouse at a 45º angle.

· To resize one dimension only, drag the mouse in a straight line. 

3. When the object is the size you want, release the left mouse button. 

Proportional Resize Disproportional Resize



Resizing with the Keyboard
1. Select the 2D or 3D object you want to resize.

2. On the Window menu, choose Object Info, which will open that palette.

3. Select the field you want to change, and type in the new coordinate. Then press the RETURN key--
MiniCAD will resize the object.

4. If you want to change another dimension, select its field--either with the mouse or by pressing the 
TAB key until the correct field is selected--and type in the new coordinate.



How do I stack objects, including text?

In each individual layer, MiniCAD automatically stacks 2D and 3D objects--places them on top of each 
other--in the order that you create them. If objects overlap, they may obscure one another. 

At anytime, though, you can change the stacking order of an object. MiniCAD lets you make an object the
top or bottom object, or send an object forward or backward one object at a time. To change the stacking 
order of an object within a layer:

1. Select the 2D or 3D object you want to "restack."

2. On the Tool menu, choose Send.

3. In the pop-up menu that appears, choose either Send Forward, Send Backward, Send to Front, or 
Send to Back--MiniCAD will change the object's stacking order.



How do I duplicate objects, including text?

To help streamline your work, MiniCAD lets you duplicate--make an exact copy--of any object in your 
drawing. There are several ways that you can duplicate objects or groups of objects in MiniCAD. These 
include several menu commands and a combination mouse-keyboard movement.

Using the Copy and Paste Commands to duplicate an object

Using the Duplicate Command to duplicate an object

Using the Duplicate Array Command to duplicate an object

Using Control-Drag to duplicate an object



Using the Copy and Paste Commands to duplicate an object

Like many other software programs, MiniCAD allows you to "copy" an object to the Windows Clipboard, 
where it is temporarily stored. You then can "paste" the clipboard object into that same drawing file, into 
another MiniCAD file, or into another software program's file if that program also has copy and paste 
commands.

Hint 
If you hold down the control key while pasting a clipboard object, MiniCAD will place the object in the 
same place in the new drawing window as it was in the old window.

When you paste a clipboard object into a MiniCAD file, MiniCAD will automatically center the object in the 
drawing window. And, as long as you do not exit MiniCAD before pasting the clipboard object, it will retain 
MiniCAD's high resolution.

1. Select the 2D/3D object or objects you want to copy.

2. On the Edit menu, choose Copy--although you can't see it, MiniCAD has placed a copy of the object 
on your Windows Clipboard. (If you want, you could open your Clipboard to see the object you just 
copied.)

3. Go to the drawing file and the layer that you want to add the object to.

4. On the Edit menu, choose Paste--you'll see that MiniCAD has pasted the object in the center of your 
drawing window.



Using the Duplicate Command to duplicate an object

You can use MiniCAD's Duplicate command to copy an object or group of objects. Depending on the 
default setting that's selected in your MiniCAD Preferences, the duplicated object or objects will either be 
"offset"--placed on top but off-center of the original--or placed directly on top of the original. (For more 
information, see the MiniCAD Preferences command.)

1. Select the 2D/3D object or objects you want to copy.

2. On the Edit menu, choose Duplicate--MiniCAD will place a copy of the selected object or objects on 
top of the original.



Using the Duplicate Array Command to duplicate an object

With the Duplicate Array command, MiniCAD allows you to control how many copies of selected objects 
are made and how these copies are arrayed--placed--in your drawing. 

1. Select the 2D/3D object or objects you want to copy.

2. On the Edit menu, choose Duplicate Array…

3. In the dialog box that appears, type the number of copies you want in the text box after Copies:

Hint
You can also open the Duplicate Array dialog box by holding down the control key when you select 
Duplicate.

4. Decide whether you want multiple copies to be arrayed in either a rectangle or a circle:
Rectangular Array Circular Array

· If you select Rectangular Array, type the number of columns you want the copies placed in after
Columns.

· If you select Circular Array, type the rotation angle you want MiniCAD to use when placing the 
copies after Angle:.

5. Decide if you want to use set coordinates or "hand place" the starting point of the copied images:

· If you want to use set coordinates, tell MiniCAD how far from the original you want the copies 
to be placed by typing in X: and Y: coordinates. 

· If you want to hand-place the copies, select Next Mouse Click.

6. Decide if you want the copies to be a different size than the original. 

· If you do, select the Resize Duplicate checkbox and type in the X scale: and Y scale:

· If you don't, make sure the Resize Duplicate checkbox is not selected.

7. Decide if you want the copies to be rotated. 

· If you do, select the Rotate Duplicate checkbox and type the rotation you want to use for the 
copies after Angle: 

· If you don't, make sure the Rotate Duplicate checkbox is not selected.

8. Click OK. 

· If you used set coordinates, MiniCAD will automatically place the duplicate copies.



· If you selected Next Mouse Click, move the mouse to the point where you want the copies 
placed, and click the left mouse button.



Using Control-Drag to duplicate an object

If you want to make one copy of a selected object or group of objects, there is an easy way to do this. 

1. Select the 2D/3D object or objects you want to copy.

2. While holding down the control key, press the left mouse button and drag a copy off the original.

3. Release the left mouse button when the copy is where you want it.



How do I move objects, including text?

There are several ways that you can move 2D and 3D objects in MiniCAD using the mouse or the 
keyboard. Some methods are designed for moves within a layer, while others work best when moving 
objects between layers.

Using the Mouse to move an object

Using the Cut and Paste Commands to move an object

Using the Move Command for 2D Objects

Using the Move 3D Command for 3D Objects

Using the Object Info Palette to move an object



Using the Mouse to move an object

Within a layer, the easiest way to move a single 2D or 3D object--or a group of 2D or 3D objects--is to use
the mouse.

1. Select the 2D/3D object or objects you want to move. 

2. While holding down the left mouse button, drag the object or group of objects to a new location. Then 
release the mouse button.



Using the Cut and Paste Commands to move an object

Between layers, the easiest way to move objects is with the Cut and Paste commands.

1. Select the 2D/3D object or objects you want to move. 

2. On the Edit menu, choose Cut--MiniCAD deletes the object from the layer you are working in and 
places a copy of it on your Windows Clipboard. (If you want, you could open your Clipboard to see the
object you just cut.)

Hint 
If you hold down the control key while pasting a clipboard object, MiniCAD will place the object in the 
same place in the new layer as it was in the old layer.

3. Go to the drawing layer that you want to paste the object in.

4. On the Edit menu, choose Paste--you'll see that MiniCAD has pasted the object in the center of your 
drawing window.



Using the Move Command for 2D Objects

If you want to move a single 2D object--or a group of 2D objects--an exact distance horizontally and/or 
vertically within a layer, the Move Command is an easy and precise method.

1. Select the 2D object or objects you want to move. 

2. On the Tool menu, choose Move and then Move…

3. In the dialog box that appears, select whether the coordinates you want to enter are Cartesian or 
Polar.

· If you select Cartesian, type the distance for the X Offset: and/or the Y Offset: that you want the 
object to move.

· If you select Polar, type the Distance: and/or the Angle: that you want the object to move.

4. Click OK. 



Using the Move 3D Command for 3D Objects

If you want to move a single 3D object--or a group of 3D objects--an exact horizontal distance, vertical 
distance, and/or change its height within a layer, the Move 3D Command is an easy and precise method.

1. Select the 3D object or objects you want to move. 

2. On the Tool menu, choose Move and then Move 3D…

3. In the dialog box that appears, select whether the coordinates you want to enter are X Y Z (Cartesian)
or I J K (Polar).

· If you select Cartesian, type the distance for the X Offset:, the Y Offset:, and/or the Z Offset: that
you want the object to move.

· If you select Polar, type the distance for the I Offset:, the J Offset:, and/or the K Offset: that you 
want the object to move.

4. Click OK. 



Using the Object Info Palette to move an object

You can precisely move single objects or groups of objects with the Object Info palette.

1. If it isn't already displayed, open the Object Info palette--on the    menu, choose Object Info.

2. Select the 2D/3D object or objects you want to move. 

3. In the Object Info palette, type the distances you want the object or group of objects to move: 

· For 2D objects, type the distance you want the object--or group of objects--to move horizontally 
or vertically after the X: and/or Y: 

· For 3D objects, select the button for Cartesian (X: Y: Z:) or for Polar (I:    J:    K:) coordinates, 
and then type the distance you want the object--or group of objects--to move after the 
coordinates.

4. After you have finished typing distances in the Object Info palette, click the object--you'll see it move.



How do I rotate objects, including text?

You can easily rotate a 2D or 3D object--or a group of 2D or 3D objects--by using the Rotate Command. 
You can use one of MiniCAD's four preset options--Rotate Left 90º, Rotate Right 90º, Flip Horizontal, or 
Flip Vertical. Or you can specify your own rotation angle.

Using One of the Preset Options to rotate objects

Specifying a Rotation Angle for 2D Objects

Specifying a Rotation Angle for 3D Objects



Using One of the Preset Options to rotate objects
1. Select the 2D/3D object or objects you want to rotate.

2. On the Tool menu, choose Rotate.

3. In the pop-up menu that appears, choose the preset option you want--Rotate Left 90º, Rotate Right 
90º, Flip Horizontal, or Flip Vertical. 



Specifying a Rotation Angle for 2D Objects
1. Select the 2D object or objects you want to rotate.

2. On the Tool menu, choose Rotate.

3. In the pop-up menu that appears, choose Rotate… 

4. In the dialog box that appear, type the degrees you want the object or objects to rotate after Angle:

5. Click OK.



Specifying a Rotation Angle for 3D Objects
1. Select the 3D object or objects you want to rotate.

2. On the Tool menu, choose Rotate.

3. In the pop-up menu that appears, choose Rotate 3D… and a dialog box will appear.

4. Select the point you want MiniCAD to use as the center of the rotation:

· If you select Working Plane Center, MiniCAD will make the rotation using the center of your 
working plane.

· If you select Object Center, MiniCAD will make the rotation using the center of the selected 
object.

· If you select Next Mouse Click, MiniCAD will make the rotation using the place you click the 
mouse in your Drawing Window. 

5. Type the degrees you want the object or objects to rotate after Rotation Angle:

6. Select the Rotation Axis: 

· For Ground Planes, select either X, Y, or Z.

· For Working Planes, select either I, J, or K.

7. Click OK.

· If you selected Working Plane Center or Object Center, MiniCAD will automatically rotate the 
object or group of objects.

· If you selected Next Mouse Click, you first need to click the left mouse button at the point in your 
Drawing Window that you want to use as the center of the rotation. MiniCAD will then rotate the 
object or group of objects.



How do I change an object's attributes?

At anytime, you can change an object's pen color, fill color, fill pattern, line weight, line pattern, or line 
marker. 

The following explain how to change the attributes of an object that has already been created. To learn 
how to change the default attributes for objects, see the Edit Attributes command.

Changing an Object's Pen

Changing an Object's Fill



Changing an Object's Pen

In MiniCAD, you can change an object's outline pen to either a solid, dashed, or pattern line of any 
thickness. And, depending on the number of colors supported by your monitor, you can pick pen colors 
from a palette of up to 256 colors. (MiniCAD 's color palette will automatically display as many colors as 
your monitor can handle.)

If I want a solid line, how do I change an object's pen color?

If I want a dashed line, how do I change an object's pen color?

If I want a line that has a pattern, how do I change an object's pen color?

For all types of lines, how do I change the thickness of a pen line?

If I want no outline, how do I change an object's pen color?



If I want a solid line, how do I change an object's pen color?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select Solid from the Pen pop-up menu.

4. From the Color pop-up menu, select the new color--you'll see that MiniCAD has changed the object's 
pen color. 



If I want a dashed line, how do I change an object's pen color?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select Dashed from the Pen pop-up menu.

4. From the Color pop-up menu, select the new color--you'll see that MiniCAD has changed the object's 
outline to a dashed line in the color you selected. 



If I want a line that has a pattern, how do I change an object's pen color?
1. Select the 2D or 3D object that you want to change.
2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select Pattern from the Pen pop-up menu--you'll see that the attribute palette now has one pattern 
pop-up menu and two color pop-up menus.

4. Select the new line pattern from the Pattern pop-up menu.

5. Select the new foreground pen color from the top color pop-up menu.

6. Select the new background pen color from the bottom color pop-up menu--you'll see that MiniCAD 
has changed the object's pen color and pattern.



For all types of lines, how do I change the thickness of a pen line?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. In the Line pop-up menu, either 

· Select one of the preset line weights.

· Or, if you want to specify a line weight, select Set Thickness… Then, in the dialog box that 
appears, select the measurement system you want to use--Points, Mils, or mm--type the 
thickness you want after Line Thickness: and click OK.



If I want no outline, how do I change an object's pen color?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select None from the Pen pop-up menu--you'll see that MiniCAD has removed the object's outline. 



Changing an Object's Fill

In MiniCAD, you can change an object's fill to either a solid color, to a hatch, or to a combination of color 
and pattern. You also can change an object's fill setting to "transparent" if you want it to have no fill 
pattern.

Depending on the number of colors supported by your monitor, you can pick fill colors from a palette of up
to 256 colors. (MiniCAD 's Color palette will automatically display as many colors as your monitor can 
handle.) Currently, MiniCAD lets you pick from 64 available fill patterns. 

If I want a solid color, how do I change an object's fill?

If I want a hatch, how do I change an object's fill?

If I want a pattern, how do I change an object's fill?

If I want a transparent object, how do I change its fill?

How do I hide part of a drawing?

How do I create reversed text?



If I want a solid color, how do I change an object's fill?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select Solid from the Fill pop-up menu.

4. From the Color pop-up menu, select the new color--you'll see that MiniCAD has changed the object's 
fill color. 



If I want a hatch, how do I change an object's fill?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select Hatch from the Fill pop-up menu.

4. From the Hatch pop-up menu, select the new hatch--you'll see that MiniCAD has filled the object with 
the hatch pattern you selected. 



If I want a pattern, how do I change an object's fill?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select Pattern from the Fill pop-up menu--you'll see that the attribute palette now has one pattern 
pop-up menu and two color pop-up menus.

4. Select the new fill pattern from the Pattern pop-up menu.

5. Select the new foreground fill color from the top color pop-up menu.

6. Select the new background fill color from the bottom color pop-up menu--you'll see that MiniCAD has 
changed the object's fill color and pattern.



If I want a transparent object, how do I change its fill?
1. Select the 2D or 3D object that you want to change.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. Select None from the Fill pop-up menu--you'll see that MiniCAD has made the object transparent. 



How do I hide part of a drawing?
If you want to obscure a portion of a drawing, you can do so by creating a "mask"--an object the same 
color as your background that covers up the selected area of your drawing.

1. On the 2D Tools palette, select the Rectangle Tool. (If you prefer, you can use the Circle Tool or the 
Polygon Tool.)

2. Draw a rectangle over the portion of your drawing that you want to mask.

3. Change the rectangle's pen and fill colors to the same color as your background--unless you have 
changed the background, this will be white.

4. If needed, resize or move the rectangle so that it completely masks the portion of your drawing.



How do I create reversed text?
You can easily create reversed text in MiniCAD. All you need to do is create a "filled" object and place 
white text on top of it.

1. Make sure that your default setting won't automatically place a fill pattern behind text:

· On the File menu, choose MiniCAD Preferences…

· In the dialog box that appears, choose the "tab" named Display.

· Make sure that the No Fill Behind Text checkbox is selected.

· Click OK.

2. Draw a rectangle that is slightly larger than the reversed text you want to create.

3. Change the rectangle's fill to black or any other dark color. 

4. On the 2D Tools palette, choose the Text Tool, and type your text.

5. If needed, change the pen color of your text to white.

6. Drag the white text on top of your filled rectangle--if necessary, change the stacking order so that the 
text is truly on top of the rectangle.



What is the MiniCAD Worksheet function?

MiniCAD's worksheet function lets you create worksheets similar to those you could create in 
spreadsheet programs, such as Excel™. However, there are two advantages to working with MiniCAD 
worksheets. First, you can create and use these worksheets inside your MiniCAD files, without leaving the
main Drawing Window. Second, with MiniCAD worksheets, you have the flexibility of storing and returning
data as either a spreadsheet row or a database row. 

For additional information, see the following topics:

Spreadsheet Rows

Database Row

Changing a Row's Type



Spreadsheet Rows

This type of worksheet row has cells--represented as columns--that contain formulas or data. With them, 
you can have MiniCAD automatically make calculations using the data in your drawing. For example, you 
could create a simple worksheet that had three columns of data: Room Name, Area, and Total Area. You 
then could have MiniCAD calculate and list the area and total area for each room in your drawing. And, 
anytime you made a change to a room's size or shape, MiniCAD would automatically recalculate the 
data--automatically listing the room's new area and total area in your worksheet. 

For related information see the following:

Database Row
Changing a Row's Type



Database Row

This kind of worksheet row lists information about object types (including symbols) in your drawing, using 
the data you have attached to each object type with a record format. Individual record formats can contain
numerous fields of information. When you create a database row in your worksheet, it will act as a header
row. Then all the objects that have that record format attached to them will be displayed as sub-rows 
under the main database row, with each field in that record format displaying in a separate cell (column). 

For related information see the following:

Spreadsheet Row
Changing a Row's Type



Changing a Row's Type

In MiniCAD worksheets, rows are automatically set up as spreadsheet rows. To change a spreadsheet 
row into a database row or vice versa:

1. Move the cursor so that it is directly over the number of the row you want to change--or over the 
empty cell if the row has not yet been created.

2. Click the cell, and then click either Spreadsheet or Database in the shortcut menu.



What is an independent worksheet?

With MiniCAD, you can create an independent worksheet--one that does not directly use information from
the file. 

1. If it isn't already displayed, open the Resources palette--on the Window menu, click Resources.

2. Click New…    In the dialog box that appears, select worksheet, and then click Create.

3. In the Create Worksheet dialog box that appears:

· Type the name you want to give your worksheet in the textbox after Name:

· Type the number of horizontal rows you want your new worksheet to have in the textbox after 
Rows:

· Type the number of vertical columns (cells) you want your new worksheet to have in the textbox 
after Columns:

· Click OK.

4. Your new worksheet will appear. You can now assign names and functions to your columns, as well 
as select whether you want individuals rows to be spreadsheet or database rows.



What is an interactive worksheet?

With MiniCAD, you can use objects and attached record format data from your drawing to create an 
interactive worksheet.    

You can create an interactive worksheet in your drawing file at any time. However, it usually is easier if 
you first create record formats, as well as part or all of your drawing. 

Use the following directions to create a new worksheet with database rows that use record formats you've
created and attached to objects in your drawing. 

Creating a Worksheet with Record Formats

Creating a Worksheet with Symbols



Creating a Worksheet with Record Formats
1. On the Organize menu, click Create Database Worksheet.

2. In the dialog box that appears:

· Type the name you want to use for your worksheet in the textbox after Title:

· In the shortcut menu after List all: select Objects with a record.

· Select the record format you want in the shortcut menu after Listing objects with record:

Hint
If you want to use all columns, you can simply click Add All.

· Select the record fields you want to use in the worksheet from the listing under Possible columns:
and then click Add--this moves the selected fields to the Worksheet columns: scrolling box.

· If you want to change the order of columns, select the column name(s) that you want to move, 
and click Up or Down to change their order in the list and, therefore, the worksheet.

· If you want objects with different record formats that have an identical field value listed together in
one row, click the checkbox before Summarize items with the same and then select the field from 
the shortcut menu.

· If you want to customize other features of your worksheet, click Options…    In the dialog box that 
appears:

· Decide where you want your new database placed--select the checkbox for either New 
worksheet or Append to existing worksheet (and select the worksheet's name from the 
shortcut menu)

· If you want to search symbols for any embedded record formats or other symbols, select the 
Search in symbols checkbox.

· Click OK.

3. In the Create Database Worksheet dialog box, click OK. MiniCAD will create and display your new 
worksheet.



Creating a Worksheet with Symbols
1. On the Organize menu, click Create Database Worksheet.

2. In the dialog box that appears:

· Type the name you want to use for your worksheet in the textbox after Title:

· In the shortcut menu after List all: select Symbols.

Hint
If you want to use all columns, you can simply click Add All.

· Select the symbols you want to use in the worksheet from the listing under Possible columns: and 
then click Add--this moves the selected fields to the Worksheet columns: scrolling box.

· If you want to change the order of columns, select the column name(s) that you want to move, and 
click Up or Down to change their order in the list and, therefore, the worksheet.

· If you want, select the Summarize items with the same checkbox, and then select Symbol Name or 
Quantity from the shortcut menu.

· If you want to customize other features of your worksheet, click Options…    In the dialog box that 
appears:

· Decide where you want your new database placed--select the checkbox for either New worksheet
or Append to existing worksheet (and select the worksheet's name from the shortcut menu).

· If you want to search symbols for any embedded record formats or other symbols, select the 
Search in symbols checkbox.

· Click OK.

3. In the Create Database Worksheet dialog box, click OK. MiniCAD will create and display your new 
worksheet. Notice that the database rows you created are marked by a diamond.



How do record formats work?

Creating record formats in your drawing file is the first step to creating database rows in your worksheets. 
You can attach record formats, which store a wide range of data, to any object (including symbols) in your
drawing. There are two types of information that can be stored in record formats:

· Data you attach to your MiniCAD object, such as its price or part number.

· Data that is an intrinsic part of your MiniCAD object, such as the area of a room or the length of a 
wall.

MiniCAD's flexibility lets you create the object or the record format first. Either way, any data you attach to
an object becomes a permanent part of it--staying with the object even when you import or cut-and-paste 
it into another drawing. This doesn't mean that you can't change the values of the data, though. 

· For directions on editing data you attach to an object, see How do I edit data in a record format.

· Data that is an intrinsic part of your object (such as its width or length) can be edited with the Object 
Info palette. For information on how to use this palette, see the Object Info Palette.

For additional information, see the following topics:

How do I create a record format?

How do I edit data in a record format

How do I attach a record format to a symbol?

How do I attach a record format to an object?



How do I create a record format?

In MiniCAD, you can create as many record formats as you need in a drawing file. Here's how to create a 
single format:

1. If it isn't already displayed, open the Resources palette--on the Window menu, click Resources.

2. Click New...    In the dialog box that appears, select Record Format and then click Create.

3. Type the name you want to give to the record format in the textbox after Name:

4. Select the Type: of format you want to create:

· Click Integer if you plan to use a positive or negative whole number within the range of -32,767 
and 32,767. (The Integer format uses less memory than Number.)

· Click Number if you plan to use fractions or decimals, if you want to specify a number format, or if
you want to use numbers smaller than -32,767 or larger than 32,767. 

· Click Boolean if you plan to use a data value that is either true (1) or false (0).

· Click Text if you plan to use a sequence of characters, such as words or sentences.

5. If you selected Number for your format type, click Format…    In the dialog box that appears, select 
the number format you want to use and click OK.

Important
To save the record format(s) you create, be sure to save your document before closing it. 

6. Type the data value you want to use in the textbox after Default:

· For Integer and Number formats, type the numerical value you want to assign to the record.

· For Booleans, type 1 (true) or 0 (false). 

· For Text, type up to 256 characters.

7. Click OK--this will return you to the Resources palette, which will list the new record format you just 
created.

For related information see the following:

How do I edit data in a record format
How do I attach a record format to a symbol?
How do I attach a record format to an object?



How do I edit data in a record format

After you've created a record format in your drawing, you can edit its data at any time. MiniCAD lets you 
edit the record format two ways. 

· If you want to edit the record format data for an existing object(s), you must select the object(s) and 
edit the format in the Object Info palette.

· If you want to edit the record format for new objects, you can change the format's data in the 
Resources palette--doing this will change the data attached to all new objects that you attach the 
revised format to. 



How do I change the record format for an existing object?
1. If it isn't already displayed, open the Object Info palette--on the Window menu, click Object Info. Then,

select the Data pane on this palette.

Tip
A macro that lets you easily select a particular type of object in your drawing exists in the Design and 
Drafting Toolkit--you'll find it inside the Goodies directory.

2. Select the object or objects--with that record format attached to them--that you want to change.

3. Now make your changes in the Object Info palette:

· Click the name of the record field you want to change in the Field List box.

· Then, change the data in the Edit Field box.

· When you are done editing, press the TAB key.

MiniCAD changes the record format data for all selected objects. For any new object, though, 
MiniCAD will attach the old record format. To change the record format for new objects, see How do I 
change the record format for new objects?.

Remember
To edit data that is an intrinsic part of your object (such as its width or length) use the Object Info palette. 
See the Shape Pane.



How do I change the record format for new objects?
1. If it isn't already displayed, open the Resources palette--on the Window menu, click Resources.

2. Double-click the name of the record you want to edit in the Resources palette--or, if you prefer, you 
can select the record format's name in the Resources palette and then click Edit…

3. To edit the format, click New...      In the dialog box that appears, select Record Format and then click 
Create. 

4. Type the name you want to give to the record format in the textbox after Name:

5. Select the Type: of format you want to create:

· Click Integer if you plan to use a positive or negative whole number within the range of -32,767 
and 32,767. (The Integer format uses less memory than Number.)

· Click Number if you plan to use fractions or decimals, if you want to specify a number format, or if
you want to use numbers smaller than -32,767 or larger than 32,767. 

· Click Boolean if you plan to use a data value that is either true (1) or false (0).

· Click Text if you plan to use a sequence of characters, such as words or sentences.

6. If you selected Number for your format type, click Format…    In the dialog box that appears, select 
the number format you want to use and click OK.

Important
To save the record format(s) you create, be sure to save your document before closing it. 

7. Type the data value you want to use in the textbox after Default:

· For Integer and Number formats, type the numerical value you want to assign to the record.

· For Booleans, type 1 (true) or 0 (false). 

· For Text, type up to 256 characters.

8. Click OK--this will return you to the Resources palette, which will list the new record format you just 
created. From this point forward, when you attach that record to an object, it will use the changed 
format.



How do I attach a record format to a symbol?

Once you have created a record format in your drawing, you can attach it to any object or symbol that is 
part of the same drawing file.

1. If it isn't already displayed, open the Resources palette--on the Window menu, click Resources.

2. Select the symbol's name in the Resources palette, and then click Attach…

3. In the dialog box that appears, select the record format you want to attach to the symbol, and then 
click OK. This will attach the record format to each instance of the symbol in your drawing.

4. To see a list of records attached to a symbol in your drawing: 

· If it isn't already displayed, open the Object Info palette--on the Window menu, click Object Info.

· Select the Data pane on this palette.

· Select an instance of the symbol--you'll see a list of any attached record format(s).

For related information see the following:

How do I attach a record format to an object?



How do I attach a record format to an object?

Once you have created a record format in your drawing, you can attach it to any object or symbol that is 
part of the same drawing file.

1. If it isn't already displayed, open the Object Info palette--on the Window menu, click Object Info.

2. Select the Data pane on this palette.

3. Now select the object that you want to attach a record format(s) to.

4. If you want to name the selected object, type the name you want to use in the top textbox.

5. In the field box right below the name textbox, you'll see a list of record formats in your file. Click the 
empty checkbox in front of its name--a dialog box will appear, confirming that you want to delete 
(unattach) the attached record from the object.

For related information see the following:

How do I attach a record format to a symbol?



How do I work with and change my worksheet?

Like other spreadsheet programs, MiniCAD uses a similar setup of cells. In a MiniCAD worksheet, rows 
are numbered sequentially (starting with 1), and columns are labeled alphabetically (starting with A). 
Together, the cell's row number and column letter indicate the cell's address. In addition, you can make a 
number of formatting changes, as well as adding calculation formulas to individual cells. 



MiniCAD Functions

The following functions are available for MiniCAD worksheets. Functions are calculation tools that allow 
you to make decisions, take actions, and return values automatically. 

Worksheet functions take a value or values (arguments), perform some action on them, and return a 
value or values. Functions that begin with a capital letter use search criteria as an argument. Lower case 
functions, known as worksheet functions, take a number value or a cell range. Arguments for trigonometry
functions must be in radians. 

acos function

Angle function

Area function

asin function

atan function

average function

BotBound function

cos function

Count function

def2rad function

exp function

Height function

if function

int function

LeftBound function

Length function

ln function

log function

max function

min function

Perim function

rad2deg function

RightBound function

round function

sin function

sqrt function

sum function

tan function

TopBound function



Width function

XCenter function

YCenter function



Acos function
Syntax acos(number)

Description Returns the arccosine of a number. The arccosine is the angle whose cosine is number.
The returned angle is given in radians in the range 0 to p.

Arguments number is the cosine of the angle, and must be from -1 to 1.

Example acos(cos(x))=x

See Also cos function



Angle function
Syntax Angle(criteria)

Description Returns the angle of lines and walls, the span angle of arcs (in degrees), and the slope 
angle of slabs (in degrees).



Area function
Syntax Area(criteria)

Description Returns the total area of 2D objects.

See Also Perim function



Asin function
Syntax asin(number)

Description Returns the arcsine of a number. The arcsine is the angle whose sine is number. The 
returned angle is given in radians in the range -p/2 to p/2.

Arguments number is the sine of the angle you want and must be from -1 to 1.

Notes To express the arctangent in degrees use the rad2deg function (or multiply the result by
180/pi).

See Also Sin function



Atan function
Syntax atan(number)

Description Returns the arctangent of a number. The arctangent is the angle whose tangent is 
number. The returned angle is given in radians in the range -p/2 to p/2.

Arguments number is the tangent of the angle you want.

Notes To express the arctangent in degrees, multiply the result by 180/p.

See Also Tan function



Average function
Syntax average(number1, number2...) 

Description Returns the average (mean) of the arguments.

Arguments number1, number2,... are 1 to 14 numbers for which you want to find the mean value.

See Also Max function, Min function, Sum function



BotBound function
Syntax BotBound(criteria) 

Description Returns the minimum y coordinate of an object.

See Also LeftBound function, RightBound function, TopBound function



Cos function
Syntax cos(number) 

Description Returns the cosine of a given angle.

Arguments number is the angle in radians for which you want the cosine

See Also Acos function



Count function
Syntax Count(criteria)

Description Returns the number of objects.

See Also Sum function, Max function, Min function



DEG2RAD function
Syntax deg2rad(number)

Description Converts number from degrees to radians.

Arguments number is the value in degrees you want converted to radians.

See Also RAD2DEG function



Exp function
Syntax exp(number)

Description Returns e raised to the power of number. The constant e equals 2.71828182845904, 
the base of the natural logarithm.

Arguments number is the exponent applied to the base e.

See Also Ln function



Height function
Syntax Height(criteria) 

Description Returns the Dy (height) of objects.

See Also Width function



If function
Syntax if (logicaltest, valueIfTrue, valueifFalse)

Description Returns one value if logicaltest is true, and another value if it is false.

Notes Use this function to conduct conditional tests on values and formulas and to branch 
based on the results of that test. The outcome of the test determines the value returned
by the if function.

The logicaltest can be any value or expression that can be evaluated to true or false.

Up to seven if statements can be nested as valueIfTrue, valueIfFalse arguments to 
construct elaborate formulas. Boolean statements within an if statement must be in 
parentheses. Text within an if statement should be enclosed within quotation marks. 



Int function
Syntax int(number) 

Description Removes any fractional part of a number.

Arguments number is the real number you want to round down to an integer.

See Also Round function



LeftBound function
Syntax LeftBound(criteria) 

Description Returns the left side minimum x (left boundary) of the object

See Also RightBound function, TopBound function, BotBound function



Length function
Syntax Length(criteria) 

Description Returns the length of lines or walls.

See Also Width function



Ln function
Syntax ln (number) 

Description Returns the natural logarithm (base e).

Arguments number is the positive real number for which you want the logarithm

See Also Exp function



Log function
Syntax log(number) 

Description Returns the base 10 logarithm of a number.

Arguments number is the positive real number for which you want the logarithm.

See Also Ln function, Exp function



Max function
Syntax max(number1, number2,...) 

Description Returns the largest number in the list of arguments

Arguments number1, number2,... are 1 to 14 numbers for which you want to find the maximum 
value.

See Also Min function, Average function



Min function
Syntax min(number1, number2,...) 

Description Returns the smallest number in the list of arguments

Arguments number1, number2,... are 1 to 14 numbers for which you want to find the maximum 
value.

See Also Max function, Average function



Perim function
Syntax Perim(criteria)

Description Returns the perimeter of objects.



RAD2DEG function
Syntax rad2deg(number) 

Description Converts number from radians to degrees.

Arguments number is the value in radians you want converted to degrees.

See Also DEG2RAD function



RightBound function
Syntax RightBound(criteria) 

Description Returns the right side minimum x (right boundary) of the object.

See Also LeftBound function, TopBound function, BotBound function



Round function
Syntax round(number, numdigits) 

Description Rounds a number to the specified number of digits.

Arguments number is the number you want to round

numdigits specifies the number of digits to which you want to round number.

See Also Int function



Sin function
Syntax sin(number)

Description Returns the sine of a given angle.

Arguments number is the angle in radians for which you want the sine

See Also Asin function



Sqrt function
Syntax sqrt(number) 

Description Returns a positive square root.

Arguments number is the number for which you want the square root



Sum function
Syntax sum(number1, number2,...) 

Description Returns the sum of all the numbers in the list of arguments.

Arguments number1, number2,... are 1 to 14 arguments for which you want the sum.

See Also Average function, Count function, Max function, Min function



Tan function
Syntax tan(number) 

Description Returns the tangent of the given angle.

Arguments number is the angle in radians for which you want the tangent



TopBound function
Syntax Topbound (criteria) 

Description Returns the maximum y (top boundary) of the object.

See Also LeftBound function, RightBound function, BotBound function



Width function
Syntax Width(criteria) 

Description Returns the Dx (width) of objects.

See Also Height function



XCenter function
Syntax XCenter(criteria)

Description Returns the center of objects in x direction.



YCenter function
Syntax YCenter(criteria) 

Description Returns the center of objects in y direction. 



What are search criteria?

Search criteria are what you use to find a specific type of object within a file. For example, you could use 
search criteria to find specifically-sized doors, walls of a certain color, or objects costing less than a 
certain amount of money. The following are search criteria codes that can be used in a MiniCAD formula 
in a worksheet. They are placed in a formula, with proper parentheses and syntax, by the Search Criteria 
dialog box. They also can be typed directly in the formula edit bar.

Search Criteria Code

Object Name N
Class Name C
Layer Name L
Fill Pattern FP
Line Weight LW
Line Style LS
Object Type T
Symbol Name S
Selected Status Sel
Object Record R
Pen Pattern PP
Fill Foreground FF
Fill Background FB
Pen Foreground PF
Pen Background PB
Arrowhead AR
Visibility V
Every Object All

What operators does MiniCAD use?

MiniCAD worksheets support the following operators. If the operator can be created with a special key 
combination, it is shown.

Arithmetic Operators
The arithmetic operators perform basic mathematical operations. They combine numeric values and 
produce numeric results.

Operation Symbol

Addition +
Subtraction -
Multiplication *
Division /
Exponentiation ˆ    or    **

Comparison Operators
Comparison operators compare two values and produce the logical value TRUE or FALSE.



Operation Symbol

Equal =
Not Equal
(Control =)

<>      or      ¹ 

Less than <
Less than or equal to
(Control <)

<=      or      £

Greater than > 
Greater than or equal to
(Control >)

>=      or      £

Reference Operator

The reference operator combines two cell references into a single joint reference.

Operation Symbol

Range ..

For additional information, see the following topics:

Reserved words and characters



Reserved words and characters

The following additional special words and characters are reserved for use in MiniCAD worksheet 
formulas.

Reserved symbol/words Description

( Left bracket 
) Right bracket 
, Comma 
; Semicolon
: Colon

(Control v) Square Root 

Sum or S
(Control w) Summation

p
(Control p) Pi 

TRUE True
FALSE False

What industry-specific overlays does MiniCAD have?

Built into the core MiniCAD program are several industry-specific overlays. Each one automatically 
customizes the menus and tool palettes in your working environment--giving you direct access to targeted
tools and resources, and removing unneeded ones that only clutter your workspace. In addition to the 
standard (default) overlay, you'll find these additional overlays in MiniCAD 7:

· AEC Overlay (AEC)

· Civil Overlay (CIVIL)

· Electrical Overlay (ELECTRIC)

· Mechanical Overlay (MECH)

· Terrain Modeler Overlay (TERRAIN)

· Toolkit Overlay (TOOLKIT)



How do I switch overlays?

In MiniCAD, you can change the active overlay in your drawing window with just a few clicks of the 
mouse. In addition, you can switch overlays at any point during your drawing process and as many times 
as you need to. 

1. On the File menu, choose Overlays.

2. In the pop-up menu that appears, choose the new overlay that you want to choose--MiniCAD will 
automatically switch overlays, customizing the available tools and menu commands in your working 
environment.



What is QuickTime?

QuickTime is a separate animation extension, produced by Apple Computer. It comes with a "Viewer," 
which allows users to watch many different types of animation, including those with and without sounds. 
For example, you are able to view the tool and command animations on the MiniCAD 7 Design and 
Drafting CD because the QuickTime extension is included with your MiniCAD program. 



How can I view QuickTime animations?

QuickTime™ for Windows must be installed on your machine to view QuickTime animations. We've 
included a copy of this program on the Design and Drafting CD in case you do not already have it. Even if
you didn't install QuickTime when you installed MiniCAD 7, you still may have it on your hard drive--many 
software programs, particularly games, use QuickTime.

If you do need to install QuickTime, you can use the MiniCAD CD-ROM to do it:

1. Insert the MiniCAD 7 Design and Drafting CD in your CD-ROM drive. 

2. Run the file "Qtinstall.exe" using your CD drive. (For example, if you are using Windows 95, choose 
Start and then Run "d:.exe"; if you are using Windows 3.1, from the File menu, select Run and then 
"d:.exe".)



Introduction to MiniCAD Palettes

Eight palettes form the core of the MiniCAD 7 program. Not only do these palettes display all of the 
program's drawing tools, they also let you access MiniCAD's numerous resources--including symbols, 
macros, and worksheets--without leaving the main Drawing Window.

Each of MiniCAD's overlays--the Standard (default) overlay as well as the industry-specific ones--opens a
different combination of palettes in your Drawing Window. However, that doesn't mean that you are limited
to using only the palettes that first appear. MiniCAD lets you show or hide any combination of palettes in 
any drawing file at any time. (The only exception is the Electrical Overlay, which removes access to the 
unneeded 3D Tools palette.)

Note
You can find a detailed list of which palettes display with each overlay in the Toolkit Menu.

All eight palettes can be clicked on the Windows menu--the 2D, 3D, and Dimensioning tools palettes are 
grouped together in the Tools shortcut menu, while the Attributes, Constraints, Object Info, Resources, 
and Working Planes palettes are each listed individually. A palette with a checkmark next to its name in 
the menu listing shows in the Drawing Window; a palette without a checkmark is hidden. In addition to 
closing (hiding) a palette by clicking its name in the menu listing (removing the checkmark), you can also 
close a palette by clicking the close box in the upper-right corner of the palette's title bar.

Note
When selecting a palette or item on a palette, be careful not to hold down the left mouse button while 
moving your cursor over the rulers--you could activate the program's Autoscroll feature.

MiniCAD lets you move palettes around a file's Drawing Window--simply click on a palette's title bar and 
drag the palette to a new location. The palette will stay at this new location in the file's Drawing Window 
until you move it again or close the file without saving it. 



2D Tool Palette

The standard 2D Tools palette displays 18 different tool buttons. However, from these 18 buttons, you can
access 36 different tools. In addition, when you have the A/E/C Overlay selected, there are an additional 
four tool buttons added to the bottom of this palette, giving you access to an additional 10 drawing tools.

On the palette, you'll see that some tool buttons have an arrowhead in their lower-right corner. When you 
click and hold down the left mouse button on one of these tool buttons, a shortcut tool palette will appear. 
Drag the selection arrow to the tool you want to select, and then release the left mouse button. MiniCAD 
will display that tool button in the 2D Tools palette. 

Tool Description

The Pan tool is used to move the view of the active 
drawing.

The Move Page tool is used to move the drawing 
around the drawing page. This tool is on the Pan 
tool's pop-out menu.

The Selection tool is used to select a 2D object in the
drawing window.

The Zoom In tool magnifies the view of the drawing.

The Zoom Out tool reduces the view of the drawing.

The Text tool is used to place text anywhere on a 
drawing.

The Single Line tool is used to create constrained 
and unconstrained single lines.

The Double Line tool is used to create constrained 
and unconstrained double lines. This tool is on the 
Line tool's pop-out menu.

The Leader Line tool is used to create a 2-segment, 
leader line. This tool is on the Line tool's pop-out 
menu.

The Arc tool draws circular arcs of any degree, at any 



angle.

The Quarter Arc tool creates arcs that are one 
quarter of an ellipse, with an angle limited to 90º. This 
tool is on the Arc tool's pop-out menu.

The Rectangle tool is used to create a rectangle or a 
square.

The Rotated Rectangle tool is used to create a 
rectangle at any angle. This tool is on the Rectangle 
tool's pop-out menu.

The Rounded Rectangle tool is used to create 
rectangles with rounded corners. This tool is on the 
Rectangle tool's pop-out menu.

The Polyline tool is used to create a connected series
of arcs, curves and lines that are treated as a single 
entity.

The Freehand     Line   tool produces a polygon along a 
path that is specified by dragging the mouse. This tool
is on the Polyline tool's pop-out menu.

The Ellipse tool is used to draw circles and ellipses.

The Single Line     Polygon   tool is used to create 
polygonal shapes.

The Double     Line     Polygon   tool is used to create 
double line polygons. This tool is on the Polygon 
tool's pop-out menu.

The Regular     Polygon   tool is used to create a closed 
polygon whose sides are equal in length. This tool is 
on the Polygon tool's pop-out menu.

The Symbol Insertion tool is used to place symbols 
in the drawing in 2D or Plan projection.

The Symbol Paint tool is used to place multiple 
copies of the active symbol in the drawing by dragging
the mouse. This tool is on the Insert Symbol tool's 
pop-out menu.

The 2D Locus tool is used to place a 2D reference 
point (represented by a diagonal cross) on the 
drawing. This tool is on the Insert Symbol tool's pop-
out menu.

The Trim tool is used to remove a portion of an object 
using another object as a cutting tool.

The Offset tool is used to create a new object whose 



outline is at a constant distance from the selected 
object. This tool is on the Trim tool's pop-out menu.

The Extend tool lengthens or "extends" one object to 
meet another object. This tool is on the Trim tool's 
pop-out menu.

The Reshape tool is used to edit polygons and 
polylines, including freehand lines. 

The Resize tool is used to scale an object. This tool is
on the Reshape tool's pop-out menu.

The Shear tool skews all of the vertices of a 
rectangle, polygon or ellipse. This tool is on the 
Reshape tool's pop-out menu.

The Clip tool is used to cut objects. It can cut lines, 
arcs, rectangles, ellipses, polygons, and polylines. 
This tool is on the Reshape tool's pop-out menu.

The Fillet tool is used to places an arc (fillet) between 
two objects, making the arc tangent to each object at 
the fillet's end points.

The Chamfer tool is used to place a line between two 
linear objects, at a specified distance from the 
intersection of the lines or objects. This tool is on the 
Fillet tool's pop-out menu.

The Eyedropper tool is used to "pick up" attributes 
from one object and apply them to another.

The Mirror tool is used to make a mirror image of a 
selected object.

The Duplicate Along Path tool is used to replicate an
object (or group of objects) at regular intervals along a
path.    This tool is on the Mirror tool's pop-out menu.

The Rotate 2D tool is used to rotate a selected object.

The Property Bounds tool is used to create a 
polygon based on bearing and distance values. The 
boundary line can be made of line segments or 
curves.

The Parking Space tool is used to create evenly-
spaced lines for parking lots. 

The Wall tool is used to create walls.

The Butt-Join Wall tool is used to join walls with 
corners butted together instead of mitered. 

The Y-Join Wall tool is used to join multiple walls that 



come together at odd angles and cannot be joined 
using the other wall-joining tools.

The Duplicate Symbol in Wall tool is used to 
replicate the active symbol (typically a door or 
window) at a specified interval in a wall.

The Number Stamp tool is used to place a marker 
with an identifying number on the drawing. The 
number automatically increments each time the tool is
used. 

The Revision Cloud tool on the on the 2D Tool 
palette is used to create a revision cloud.

The Straight Stair tool is used to create stairs.

The Fancy Door tool is used to create a door in a 
front elevation. The door can have raised panels, 
rectangular windows, and a semicircular top window.

The Shutters tool is used to create window shutters in
front elevation.

 Pan Tool
You can use this tool on the 2D Tools palette to "grab" your drawing and move it around the screen, 
changing what piece of it displays in the drawing window. Here's how:

1. Select the Pan Tool, and move the Selection Arrow into the Drawing Window--you'll see that the 
standard arrow cursor changes into a hand.

2. Click and hold down the left mouse button, and drag the drawing around the screen. Notice that the 
rulers remain fixed.

3. When the drawing is where you want it, release the mouse button.



 Move Page Tool
Rather than changing just your view of your drawing, the Move Page Tool on the 2D Tools palette also 
changes your drawing's position. When you use it, your drawing moves while the rulers remain fixed. This
tool allows you to change the position of your drawing on the printed page:

1. Select the Move Page Tool, and move the Selection Arrow into the Drawing Window--you'll see that 
the standard arrow cursor changes into a mini page.

2. Click and hold down the left mouse button, and drag the dashed outline box around the screen. 
Notice that the ruler markings change as you drag the box, and that your original page position 
continues to display, helping you measure your movement.

3. When the drawing page is where you want it, release the mouse button.



 2D Selection Tool
When you move your mouse into the drawing window, the standard arrow cursor will automatically 
change into an icon that matches the tool you have selected. For that reason, you must use the 2D 
Selection Tool on the 2D Tools palette if you want to select an object--including text--in your Drawing 
Window. When this tool is active, your cursor will remain an arrow within the Drawing Window. For more 
information on selecting MiniCAD objects, see How can I select objects, including text?.



 Zoom In Tool
The Zoom In Tool on the 2D Tools palette gives you an easy way to magnify your drawing. Each time you 
double-click it, MiniCAD doubles the magnification of your drawing. 

Note
Your drawing's current level of magnification always displays in the Mode Bar.

In addition, you can use the Zoom In Tool to show you a close-up view of a select part of the drawing. 
This is called a Marquee Zoom:

1. Click the Zoom In Tool, and move the Selection Arrow into the Drawing Window--you'll see that the 
standard arrow cursor changes into cross hairs (two crossed lines).

2. Drag a marquee box around the portion of the drawing that you want to magnify, and then release the
left mouse button. MiniCAD will enlarge the drawing portion you selected so that it fills the Drawing 
Window.

Note
MiniCAD also has additional zoom keyboard commands. For more information, see General 
Keyboard Shortcuts.



 Zoom Out Tool
The Zoom Out Tool on the 2D Tools palette, gives you an easy way to reduce the magnification of your 
drawing. Each time you double-click it, MiniCAD reduces by one-half the magnification of your drawing. 



 Text Tool
This tool on the 2D Tools palette lets you add both lines and blocks of text to your drawing. When you 
click the Text Tool and move the Selection Arrow into the Drawing Window, the standard arrow cursor 
changes into the text cursor (a vertical line). For information about the differences between lines and 
blocks of text, as well as how to create and format both, see How do I create text? and How do I format 
text?.



 Single Line Tool
With this tool on the 2D Tools palette, you can create both constrained and unconstrained lines by 
drawing with the mouse or by using a mouse-keyboard combination. MiniCAD's default settings for 
constrained lines are 30º, 45º, and 90º angles, as well as their complements. For information about 
setting additional angle constraints, see MiniCAD Preferences command. 

For additional information, see the following topics:

Drawing single lines with the mouse

Creating single lines with a mouse-keyboard combination



Drawing single lines with the mouse

1.  Select the Single Line Tool from the 2D Tools palette, and move the Selection Arrow 
into the Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two 
crossed lines).

2. Select either the Constrained single line or the Unconstrained single line mode button on the Mode 
Bar.

    Constrained single line

    Unconstrained single line
3. Press the left mouse button to mark the line's starting point; while continuing to hold down the 
mouse button, drag the mouse horizontally, vertically, or diagonally.

Important
MiniCAD's default mode for line drawing is Click-Drag. If you have changed this setting in your 
Preferences dialog box, use the Click-Click drawing mode.

4. When the line is the length you want, release the mouse button.



Creating single lines with a mouse-keyboard combination

1.  Double-click the Single Line Tool on the 2D Tools palette. 

2. In the dialog box that appears, decide how you want to specify the line's size:

· Select Cartesian, if you want to type ±X: and ±Y: coordinates. 

· Select Polar, if you want to type L: and A: coordinates.

3. Decide how you want to place the line in your drawing. 

· To hand place the line, select the Use Next Click checkbox.

· To place it at an exact location in your drawing, type in the X Pos: and Y Pos: coordinates. 

4. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the line's 
location in your drawing.



 Double Line Tool
With this tool on the 2D Tools palette, you can easily draw a wide variety of constrained and 
unconstrained double lines. In addition, you can choose how far apart you want the double lines to be, 
how you want the lines offset from your mouse cursor as you draw, and if you want a cavity line between 
them.

1. Select the Double-Line Tool from the 2D Tools palette, and move the Selection Arrow into the Drawing
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

2. Select either the Constrained single line or the Unconstrained single line mode button.

3. Select the mode button for the offset method you want to use:

If you want your cursor to draw the top/right line, click the first mode button.

If you want the lines to be equal distance from your cursor, click the second mode button.

If you want your cursor to draw the bottom/left line, click the third mode button.

If you want to specify an offset value, click the last mode button.

4.  Click the Double Line Preferences button and set your preferences:

· Type the distance you want between your double lines in the textbox after Separation:

· If you picked the fourth mode button (to specify an offset value), type the distance you want the 
top/right line of your polygon to be from your cursor as you draw after Control Offset:

· Select the Option you want to use:

· Select Create Lines if you want to draw parallel lines:

· Select Create Polygons if you want to draw a double-line polygon with closed ends:

· Select Create Lines and Polygons if you want to draw parallel lines that can have a fill pattern
between them.

· If you want a cavity line to be drawn between your double lines, click Cavity Lines... Then, in the 
dialog box that appears, click New

· If you want the cavity line offset, type the distance you want to use after Offset:

· Click the down arrow after Line: In the shortcut menu that appears, select the line thickness 
and style for the cavity line.

· If you want the cavity line to have a fill pattern, select the Filled Cavity checkbox; then type in 
the Width: of the fill and select a fill pattern from the Fill: shortcut menu. Then click OK.



· Now click OK in the Double-Line Preferences dialog box.

5. Press the left mouse button to mark the line's starting point; while continuing to hold down the mouse 
button, drag the mouse horizontally, vertically, or diagonally.

6. When the line is the length you want, release the mouse button. 



 Leader Line Tool
With the Leader Line Tool on the 2D Tools palette, you can create constrained or unconstrained leader 
lines.

1. Select the Leader Line Tool from the 2D Tools palette, and move the Selection Arrow into the Drawing
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

2. Select either the Constrained single line or the Unconstrained single line mode button.

    Constrained leader line

    Unconstrained leader line
3. Press the left mouse button to mark the line's starting point; while continuing to hold down the mouse 

button, drag the mouse horizontally, vertically, or diagonally.

4. When the first part of the leader line is the length you want, release the mouse button.

5. Then move the mouse to the end point of the second part of the leader line, and click.

Note
Leader lines use the default end markers (arrows). To change your default line settings, see the 
Attributes Palette. 



 Quarter Arc Tool
This tool on the 2D Tools palette creates an arc, using a 90º angle, that measures one-quarter of a 
circle/ellipse. (Elliptical quarter arcs are labeled as polylines, not arcs, in MiniCAD's Object Info palette.) 
You can create a quarter arc by drawing with the mouse or by using a mouse-keyboard combination.

For additional information, see the following topics:

Drawing Quarter Arcs with the mouse

Creating Quarter Arcs with a mouse-keyboard combination



Drawing Quarter Arcs with the mouse

1.  Select the Quarter Arc Tool on the 2D Tools palette, and move the Selection Arrow into 
the Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two 
crossed lines). 

2. Press the left mouse button to mark the start point of your arc; while continuing to hold down the 
mouse button, drag the mouse to draw your arc. 

Note
The ratio of your arc's height to its width displays in the Data Display Bar (a quarter arc for a circle 
has a ratio of 1.000). 

3. When you arc is the size and shape (circle/ellipse) you want, release the mouse button, marking the 
end point of your arc.



Creating Quarter Arcs with a mouse-keyboard combination

1.  Double-click the Quarter Arc Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Type the Width (x): and Height (y): of the arc you want to create. 

· Decide how you want to place the arc in your drawing. 

· To hand place the arc, select the Use Next Click checkbox.

· To place it at an exact location in your drawing, type in the X: and Y: coordinates. 

3. Select the Quadrant of the arc you want to create and an Align Point To position--the center point of 
the circle/ellipse.

Note
You can use the Data Display Bar to verify an arc's angle, length, and location in a drawing. 

4. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the arc's 
location in your drawing.



 Arc Tool
This tool on the 2D Tools palette, which creates circular or elliptical arcs of any angle, has five different 
modes. Using the mouse, you can draw an arc by radius, 3 points, tangent, 2 points and center, or 2 
points and radius. In addition, you can create arcs by using a mouse-keyboard combination. (All elliptical 
arcs are labeled as polylines, not arcs, in MiniCAD's Object Info palette.) 

For additional information, see the following topics:

Drawing an Arc by Radius with the mouse

Drawing an Arc by 3 Points with the mouse

Drawing an Arc by Tangent with the mouse

Drawing an Arc by 2 Points and Center with the mouse

Drawing an Arc by 2 Points and Radius with the mouse

Creating arcs with a mouse-keyboard combination



Drawing an Arc by Radius with the mouse

1.  

 Select the Arc Tool on the 2D Tools palette and the Arc by Radius mode button on the Mode bar; 
then move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into tiny cross hairs (two crossed lines). 
2. Press the left mouse button to mark the center or your circle; while continuing to hold down the 

mouse button, drag the mouse to draw your radius. Release the mouse button. 

3. Now press and hold down the left mouse button while you draw your arc. Release the mouse button 
when the arc is the size you want.



Drawing an Arc by 3 Points with the mouse

1.  

 Select the Arc Tool on the 2D Tools palette and the Arc by 3 Points button on the Mode bar; then 
move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor changes 
into a bull's-eye symbol.
2. Click the left mouse button to mark the arc's start point.

3. Then click the mouse to mark the point you want your arc to pass through.

4. Click the mouse a third time to mark the arc's end point. 



Drawing an Arc by Tangent with the mouse

1.  

 Select the Arc Tool on the 2D Tools palette and the Arc by Tangent button on the Mode bar; then 
move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor changes 
into tiny cross hairs (two crossed lines). 
2. Press the left mouse button at the tangent point; while continuing to hold down the mouse button, 

drag the mouse to create a vector for the tangent line, and release the mouse button.

3. Click the mouse to mark the arc's end point. The arc you've created will touch but not intersect with 
the tangent line.



Drawing an Arc by 2 Points and Center with the mouse

1.  

 Select the Arc Tool on the 2D Tools palette and the Arc by 2 Points and Center button on the Mode 
bar; then move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into a bull's-eye symbol.
2. Click the mouse to mark the start point of your arc.

3. Press the left mouse button at the arc's end point; while continuing to hold down the mouse button, 
drag the mouse to draw the arc's radius. Then release the mouse button.



Drawing an Arc by 2 Points and Radius with the mouse

1.  

 Select the Arc Tool on the 2D Tools palette and the Arc by 2 Points and Radius button on the Mode 
bar; then move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into a bull's-eye symbol.
2. Press the left mouse button to mark the start point of your arc; while continuing to hold down the 

mouse button, drag the mouse to the end point of your arc and release the button.

3. In the dialog box that appears, type the length of your radius in the textbox after Radius: and click OK.



Creating arcs with a mouse-keyboard combination
1. Double-click the Arc Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Type the Width (x): and Height (y): of the arc you want to create. 

· Decide how you want to place the arc in your drawing. 

· To hand place the arc, select the Use Next Click checkbox.

· To place it at an exact location in your drawing, type in the X: and Y: coordinates. 

· Select an Align Point To position for the arc.

· Type the Arc Angle: and, if any, the Start Angle: 

3. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the arc's 
location in your drawing.



 Rectangle Tool
Using this tool on the 2D Tools palette, you can create rectangles by drawing with the mouse or by using 
a mouse-keyboard combination.

For additional information, see the following topics:

Drawing rectangles or squares with the mouse

Creating rectangles with a mouse-keyboard combination



Drawing rectangles or squares with the mouse

1.  Select the Rectangle Tool from the 2D Tools palette, and move the Selection Arrow into
the Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two 
crossed lines).

2. Press the left mouse button to mark the rectangle's corner; while continuing to hold down the mouse 
button, drag the mouse diagonally.

Hint
To draw a perfect square, make sure the Constrain Symmetrical tool (on the Constraints palette) is 
selected. 

3. When the rectangle is the size and shape you want, release the mouse button.



Creating rectangles with a mouse-keyboard combination

1.  Double-click the Rectangle Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Type the Width (x): and Height (y): of the rectangle you want to create. 

· Decide how you want to place the rectangle in your drawing. 

· To hand place the rectangle, select the Use Next Click checkbox.

· To place it at an exact location in your drawing, type in the X: and Y: coordinates. 

· Select an Align Point To position for the rectangle.

3. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the rectangle's 
location in your drawing.



 Rotated Rectangle Tool
Using the mouse, you can draw a rectangle that is rotated at an angle. (Rotated rectangles are labeled as
polylines, not rectangles, in MiniCAD's Object Info palette.) 

1. Select the Rotated Rectangle Tool from the 2D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed
lines).

2. Press the left mouse button to mark a corner; while continuing to hold down the mouse button, drag 
the mouse diagonally.

3. When the rotated rectangle is the size and shape you want, release the mouse button.



 Rounded Rectangle Tool
MiniCAD lets you create rounded rectangles with symmetrical and/or proportional corners. 

· MiniCAD's default is set for Proportional corners--this creates rectangles with corners that always 
round to be 1/3 of both the X and the Y lengths. 

· Symmetrical corners are ones where the rounded corners have the same X and Y measurements.

· Rounded rectangles with both symmetrical and proportional corners have the same horizontal and 
vertical arc lengths.

Or, if you prefer, you can create rounded rectangles using exact X and Y measurements. For all types of 
rounded rectangles, you can either draw them with a mouse or create them with a mouse-keyboard 
combination.

For additional information, see the following topics:

Drawing rounded rectangles with the mouse

Creating rounded rectangles with a mouse-keyboard combination



Drawing rounded rectangles with the mouse

1.  Select the Rounded Rectangle Tool from the 2D Tools palette. Then click the 
preferences button that appears, and select the type of corners you want:

· Select the Symmetrical and/or the Proportional checkbox. 

· Or, if you prefer, type in the precise Corner X: and Corner Y: measurements.

2. Move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into tiny cross hairs (two crossed lines).

3. Press the left mouse button to mark a corner; while continuing to hold down the mouse button, drag 
the mouse diagonally.

4. When the rounded rectangle is the size and shape you want, release the mouse button.



Creating rounded rectangles with a mouse-keyboard combination

1.  Double-click the Rounded Rectangle Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Type the Width (x): and Height (y): of the rounded rectangle you want to create. 

· Select the type of corners you want:

· Select the Symmetrical and/or the Proportional checkbox. 

· Or, if you prefer, type in the precise Corner X: and Corner Y: measurements.

· Decide how you want to place the rounded rectangle in your drawing: 

· To hand place the rounded rectangle, select the Use Next Click checkbox.

· To place it at an exact location in your drawing, type in the X: and Y: coordinates. 

· Select an Align Point To position for the rounded rectangle.

3. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the rounded 
rectangle's location in your drawing.



 Polyline Tool
This tool creates open and closed polylines--objects made of a series of connected arcs, curves, and 
lines. Using the mouse or a mouse-keyboard combination, you can create polylines that use these four 
control point modes:

If you want your polyline curves to use 90º control points, use the Polyline by Corner Point mode.

If you want your polyline curves to pull towards--but not touch--control points, select the Polyline by Bézier
Control Point mode. 

If you want your polyline curves to pass through control points, select the Polyline by Cubic Spline Point 
mode.

If you want your polyline curves to act as though a fillet has been placed at the control point, select the 
Polyline by Arc Point mode. (For the largest fillet possible, set your Fillet Radius to "0".)

If you draw a polyline with the mouse, you can only use one type of control point. However, if you use the 
mouse-keyboard combination, you can use a different mode for each control point.

For additional information, see the following topics:

Drawing polylines with the mouse

Creating polylines with a mouse-keyboard combination



Drawing polylines with the mouse

1.  Select the Polyline Tool from the 2D Tools palette, and move the Selection Arrow into 
the Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two 
crossed lines).

2. Click the left mouse button to mark the polyline's start point.

3. Drag the mouse to the next control point for your polyline and click to mark it. Continue adding control
points this way. 

4. To stop drawing the polyline, double-click to mark the polyline's end point. 



Creating polylines with a mouse-keyboard combination

1.  Double-click the Polyline Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Set the Total Vertices: you want for your polyline by clicking Add--the default setting is one vertex, 
so if you want 3 vertices, you need to click Add two times. (If you need to eliminate a vertex, there
is a Delete! button near the bottom of this dialog box.)

· If you want your polyline to be a closed object, select the Close Object checkbox.

· For your first vertex, type the X: and Y: position and select the control point mode.

· Click Next to select your second vertex, and set its X: and Y: position and control point mode. 
Continue until you have set these for each vertex in your polyline.

3. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the polyline's 
location in your drawing.



 Freehand Tool
This tool lets you use the mouse to draw any shape polyline you want. MiniCAD automatically places 
vertices in the polygon.

1. Select the Freehand Tool on the 2D Tools palette, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

2. Press the left mouse button to mark the start of your polyline; while continuing to hold down the 
mouse button, draw your polyline by dragging the mouse around the screen.

3. When you are finished drawing the polyline, release the mouse button.



 Ellipse Tool
This tool on the 2D Tools palette creates both ellipses and true circles. Using the mouse, you can draw 
ellipses and circles using four different modes. You can also create ellipses by using a mouse-keyboard 
combination. 

For additional information, see the following topics:

Drawing an Ellipse by Box with the mouse

Drawing a Circle by Radius with the mouse

Drawing a Circle by Diameter with the mouse

Drawing a Circle by Three Points with the mouse

Creating ellipses with a mouse-keyboard combination



Drawing an Ellipse by Box with the mouse

1.  

 Select the Ellipse Tool on the 2D Tools palette and the Ellipse by Box button on the Mode bar; then 
move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor changes 
into tiny cross hairs (two crossed lines). 

Hint
To draw a circle, press the shift key while you draw or select the Constrain Symmetrical tool (on the 
Constraints palette). 

2. Press the left mouse button to mark a point on the circle's circumference; while continuing to hold 
down the mouse button, drag the mouse diagonally to draw your ellipse--a bounding box will display 
to help you measure and draw your ellipse. 

3. When the ellipse is the size and shape you want, release the mouse button. 



Drawing a Circle by Radius with the mouse

1.  

 Select the Ellipse Tool on the 2D Tools palette and the Circle by Radius button on the Mode bar; then
move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor changes 
into tiny cross hairs (two crossed lines). 
2. Press the left mouse button to mark the center point of your circle; while continuing to hold down the 

mouse button, drag the mouse to mark the length of your circle's radius.      

3. When the circle has the radius you want, release the mouse button. 



Drawing a Circle by Diameter with the mouse

1.  

 Select the Ellipse Tool on the 2D Tools palette and the Circle by Diameter button on the Mode bar; 
then move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into tiny cross hairs (two crossed lines). 
2. Press the left mouse button to mark the center point of your circle; while continuing to hold down the 

mouse button, drag the mouse to mark the length of your circle's diameter.      

3. When the circle has the diameter you want, release the mouse button. 



Drawing a Circle by Three Points with the mouse

1.  

 Select the Ellipse Tool on the 2D Tools palette and the Circle by Three Points button on the Mode 
bar; then move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into a bull's-eye symbol. 
2. Click the left mouse button to mark a point on the circumference of your circle.

3. Click to mark a second point on the circumference. Then click to mark the third (and final) point. 



Creating ellipses with a mouse-keyboard combination

1.  Double-click the Ellipse Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Type the Width (x): and Height (y): of the ellipse you want to create. 

· Decide how you want to place the ellipse in your drawing. 

· To hand place the ellipse, select the Use Next Click checkbox.

· To place it at an exact location in your drawing, type in the X: and Y: coordinates. 

· Select an Align Point To position for the ellipse.

3. Click OK. If you have selected the Use Next Click checkbox, click the mouse to select the ellipse's 
location in your drawing.



 Single-Line Polygon Tool
This tool on the 2D Tools palette draws open and closed polygons that have a single outline. In MiniCAD, 
you can create polygons with as few as two vertices. There is no limit for the number of sides in your 
polygon or for their length. You can draw polygons with the mouse, or create them using a mouse-
keyboard combination:

For additional information, see the following topics:

Drawing single-line polygons with the mouse

Creating single-line polygons with a mouse-keyboard combination



Drawing single-line polygons with the mouse

1.  Select the Single-Line Polygon Tool from the 2D Tools palette, and move the Selection 
Arrow into the Drawing Window--you'll see that the standard arrow cursor changes into tiny cross 
hairs (two crossed lines).

2. Click the left mouse button to mark the polyline's start point (first vertex).

3. Drag the mouse to the next vertex. Continue adding vertices this way. 

4. To stop drawing the polygon, double-click to mark the polygon's end point (final vertex). If you want to 
create a closed polygon, double-click the first vertex--MiniCAD will automatically join the first and last 
vertex, creating a closed polygon.



Creating single-line polygons with a mouse-keyboard combination

1.  Double-click the Single-Line polygon Tool on the 2D Tools palette.

2. In the dialog box that appears:

· Set the Total Vertices: you want for your polygon by clicking Add--the default setting is one vertex,
so if you want 3 vertices, you need to click Add two times. (If you need to eliminate a vertex, there
is a Delete! button near the bottom of this dialog box.)

· If you want your polygon to be a closed object, select the Close Object checkbox.

· For your first vertex, type the X: and Y: position.

· Click Next to select your second vertex, and set its X: and Y: position. Continue until you have set
these coordinates for each vertex in your polygon.

3. Click OK. 



 Double-Line Polygon Tool
With this tool on the 2D Tools palette, you can easily draw a wide variety of closed polygons that have two
outlines, or draw two parallel lines. Your double-line polygons can have as few as two vertices, and there 
is no limit for the number of sides in your polygon or for their length. In addition, you can choose how far 
apart you want the double lines to be, how you want the lines offset from your mouse cursor as you draw, 
and if you want a cavity line between them.

1. Select the Double-Line Polygon Tool from the 2D Tools palette, and move the Selection Arrow into the
Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed
lines).

2. Select the mode button for the offset method you want to use:

If you want your cursor to draw the top/right line, click the first mode button.

If you want the lines to be equal distance from your cursor, click the second mode button.

If you want your cursor to draw the bottom/left line, click the third mode button.

If you want to specify an offset value, click the last mode button.

3.  Click the Double Line Preferences button and set your preferences:

· Type the distance you want between your double lines in the textbox after Separation:

· If you picked the fourth mode button (to specify an offset value), type the distance you want the 
top/right line of your polygon to be from your cursor as you draw after Control Offset:

· Select the Option you want to use:

· Select Create Lines if you want to draw parallel lines:

· Select Create Polygons if you want to draw a double-line polygon with closed ends:

· Select Create Lines and Polygons if you want to draw parallel lines that can have a fill 
pattern between them.

· If you want a cavity line to be drawn between in the center of your polygon double lines, click 
Cavity Lines… Then, in the dialog box that appears, click New

· If you want the cavity line offset, type the distance you want to use after Offset:

· Click the down arrow after Line: In the shortcut menu that appears, select the line thickness 
and style for the cavity line.

· If you want the cavity line to have a fill pattern, select the Filled Cavity checkbox; then type in 



the Width: of the fill and select a fill pattern from the Fill: shortcut menu. Then click OK.

· Click OK.

4. Click the left mouse button to mark the polygon's start point (first vertex).

5. Drag the mouse to the next vertex. Continue adding vertices this way. 

6. To stop drawing the polygon, double-click to mark the polygon's end point (final vertex).



 Regular Polygon Tool
This tool on the 2D Tools palette is used to draw single-line closed polygons, in which all sides of the 
polygon are the same length. It has three modes. All three let you create regular polygons with as few as 
three sides or as many as 4,000 sides. 

1. Select the Regular Polygon Tool from the 2D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed
lines).

2. Select the mode button for polygon drawing method that you want to use:

Select the Inscribed Polygon mode button if you want to create your polygon by drawing its radius.

Select the Circumscribed Polygon mode button if you want to create a polygon with a radius that is 
equidistant from the center of the polygon and the mid-point of any of the polygon's sides.

Select the Edge-Drawn Polygon mode button if you want to create your polygon by drawing one of its 
sides.

3.  Click the Regular Polygon Setting button, type the Number of Sides: you want your polygon to 
have, and click OK. 

4. Press the left mouse button to mark the start of your polygon; while continuing to hold down the 
mouse button, draw your polygon by dragging the mouse.
5. When the polygon is the size you want, release the mouse button.



 2D Symbol Insertion Tool
This tool on the 2D Tools palette let you precisely place a single MiniCAD 2D and hybrid (2D/3D) symbol 
in your drawing when it is in 2D/Plan projection. 

1. To place a symbol with this tool, you must first make it active--using the Resources palette, click on 
the symbol's name and then click the select button.

2. Select the 2D Symbol Insertion Tool from the 2D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into cross hairs (two crossed 
lines).

3. Place the symbol in your drawing:

· To place the symbol as is, move the cursor to the place in your drawing where you want to insert 
it, and click. 

Important
If you insert a symbol in a wall, MiniCAD automatically places it on the wall's control point, 
rotating it to match the wall's angle. To remove a wall symbol, drag it out of the wall--MiniCAD will 
automatically seal the cut space in the wall.

· If you want to rotate the symbol before you place it, move the cursor to the place in the drawing 
where you want to insert it and press the left mouse button; while continuing to hold down the 
button, drag the mouse to rotate the symbol. When the symbol is at the angle your want, release 
the mouse button

4. If you want to place another copy of the symbol in your drawing, move your cursor to another location 
and click. To place a different symbol, go to step 1 and follow the directions.

Note
For more information on selecting symbols with the Resource palette, see Working with Symbol 
Resources.



 Symbol Paint Tool
This tool on the 2D Tools palette lets you quickly array multiple copies of a symbol in your drawing when it
is in 2D Plan Projection mode--think of it as a can of spray paint that lets your spray copies of the symbol 
at set intervals, using your Snap Grid settings. For example, you could use it to fill a large area on your 
drawing will tree symbols.

The Symbol Paint Tool, which only works when you have the Snap to Grid constraint set, has two modes.

Note
For more information, see Snap To Grid (2D) and the Set Grid command.

1. Make sure that you have the Snap to Grid selected on the Constraints palette and that your grid is set
for the intervals you want to use. 

2. Make the symbol active in your drawing--using the Resources palette, click on the symbol's name and
then click Select. 

3. Select the 2D Symbol Paint Tool from the 2D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed
lines).

4. Select the mode that you want to use:

Select the No replace mode button if you want MiniCAD to place new symbols on top of existing 
symbols in your drawing.

Select the Replace underlying symbol mode button if you want MiniCAD to replace existing symbols 
with the new symbol any time you spray it near the existing symbol's center.

5. Press the left mouse button to mark the placement of your first symbol; while continuing to hold down 
the mouse button, drag the mouse to "spray" copies of the symbol. When you are done, release the 
mouse button.



 2D Locus Tool
This tool on the 2D Tools palette places a 2D locus--reference point--in your drawing when it is in 2D Plan
Projection mode. Because they are merely reference points, you cannot reshape or resize loci.

Note
If you select the Snap to Loci Preference command, you can easily create a vertical and horizontal "snap 
line." See MiniCAD Preferences command. 

1. Select the 2D Locus Tool from the 2D Tools palette, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

2. Move the cursor to the place in your drawing when you want to add a locus and click. You can 
continue to add as many loci this way as you want.



 Trim Tool
This tool on the 2D Tools palette lets you cut off (trim) any object where it intersects with another object or
objects, cutting away the portion of the object that does not intersect. Only the object you selected to trim 
will be affected--the other objects will stay the same. 

1. Select the object(s) that you want to remain untouched.

2. Select the Trim Tool from the 2D Tools palette, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into a hand with a pointed finger.

3. Click the edge of the object you want trimmed--MiniCAD will trim the object at that point, cutting away 
any portions of it that do not fit within the selected object(s).

4. If you want to trim another edge of that same object, move the finger pointer to that edge and click.



 Extend Tool
This tool on the 2D Tools palette lets you extend (lengthen) any line, arc, polygon, or polyline so that it 
meets another object directly in its path. The Extend Tool has two different modes. However, both require 
that when lengthened, the object you are extending will intersect your target object.

Extend object to boundary object mode

Extend to selected boundary object(s)



Extend object to boundary object mode

Use this mode if you want to physically extend the object yourself.

1. Select the object that you want to be your "boundary object"--the one you want to extend a particular 
line, arc, polygon, or polyline to.

2.  Then click the Extend object to boundary object button on the Mode bar.

3. Press the left mouse button on the object you want to extend; while continuing to hold down the 
mouse button, drag the object so that it extends to the boundary object, and release the mouse button.



Extend to selected boundary object(s)

Use this mode if you want MiniCAD to automatically extend the object to the nearest boundary object that 
you have selected.

1. Select the object (or objects) that you want to be your "boundary object"--the one you want to extend 
a particular line, arc, polygon, or polyline to.

2.  Then click the Extend to selected boundary object(s) button on the Mode bar.

3. Click the object you want to extend--MiniCAD will automatically extend it to the nearest boundary 
object in its path.



 Offset Tool
This tool on the 2D Tools palette lets you create a new object (or group of objects) that is "offset" by a 
specified distance from your original object. With the Offset Tool, you can easily create parallel lines, arcs,
and polylines. Or you can take a closed object (rectangle, ellipse, polygon) and create a larger, duplicate 
version that surrounds the original object by an equal distance on all sides. The Offset Tool has two 
modes.

For additional information, see the following topics:

Offset by distance mode

Offset by a point mode



Offset by distance mode

Use this mode if you want MiniCAD to place the offset object(s) at a specified distance from the original.

1. Select the object(s) that you want to create an offset version of, and then select the Offset Tool from 
the 2D Tools palette.

2.  Click the Offset by Distance button. 

3.  Click the Offset Tool Setting button. In the dialog box that appears:
· Type the distance you want the new object offset from the original in the textbox after Offset.

· If you have selected more than one object to create an offset copy of, select the Multiple Objects 
checkbox.

· Click OK.

3. Click the mouse on the side of the original object that you want MiniCAD to place the offset copy. If 
you want to place more than one copy, click again to indicate a direction--MiniCAD will place an offset
copy at the distance you specified from the last offset copy you placed.



Offset by a point mode

Use this mode if you want MiniCAD to place the offset object(s) at a position you select with the mouse.

1. Select the object(s) that you want to create an offset version of, and then select the Offset Tool from 
the 2D Tools palette.

2.  Click the Offset by Point button. 

2.  If you have selected more than one object to create an offset copy of, click the Offset Tool 
mode button. In the dialog box that appears, select the Multiple Objects checkbox, and click OK.
3. Click the mouse where you want to place the offset copy. If you want to place more than one 
copy, click again at a new location--MiniCAD will place an offset copy in each location that you click the 
mouse.



 2D Reshape Tool
This tool on the 2D Tools palette lets you reshape all polygons and polylines--including lines drawn with 
the Freehand Tool, which are considered polygons in MiniCAD. The 2D Reshape Tool has five different 
modes, letting you:

    Move handles of polygons.

    Change an existing vertex

    Add a vertex

    Delete a vertex.
    Hide or show the polyline's or polygon's edges.

In addition, MiniCAD lets you specify exact radius measurements for fillet control points.

Note
Any object that cannot be reshaped with this tool will continue to display standard "bounding box" handles
only.



 Move handles of polygons mode
Use this mode button with the 2D Reshape Tool if you want to reshape a 2D polyline or polygon by 
moving its object handles.

1. Select the polyline or polygon that you want to change.

2.  

 Select the 2D Reshape Tool and the Move handles of polygons mode button.
3. Move the mouse cursor to the handle point that you want to move--you'll know you have "picked" 
a handle point that you can move when the cursor changes becomes a double-headed arrow.

Hint
To select more than one handle at a time, draw a marquee box. You can also draw a free-form 
marquee, by pressing the control key while drawing a marquee (your cursor will look like a tiny lasso).

4. Press the left mouse button; while continuing to hold down the mouse button, drag the handle point to
it new location, and then release the mouse button. 



 Change vertex mode
Use this mode button with the 2D Reshape Tool if you want to change an existing vertex to a different 
type of control point.

1. Select the polyline or polygon that you want to change.

2.  

 Select the 2D Reshape Tool and the Change Vertex mode button.
3. Choose what type of control point you want to change the existing vertex into:

· If you want the vertex to use a 90º control point, select the Change vertex to corner point mode.

· If you want your polyline/polygon curve to pull towards--but not touch--the vertex, select the 
Change vertex to Bézier control point mode. 

· If you want your polyline/polygon curve to pass through the vertex, select the Change vertex to 
cubic spline point mode.

· If you want the vertex to be a fillet, select the Change vertex to fillet (circular arc) point mode, and
then click the Fillet Setting mode button. In the dialog box that appears, type the Fillet Radius 
measurement and click OK. (For the largest fillet possible, set your Fillet Radius to "0".) 

4. Move the mouse cursor to the vertex you want to change--you'll know you have "picked" a vertex 
when the cursor becomes a circular arrow.

5. Click the left mouse button. 



 Add vertex mode
Use this mode button with the 2D Reshape Tool if you want to add a vertex to the polygon/polyline. 

1. Select the polyline or polygon that you want to change.

2.  

 Select the 2D Reshape Tool and the Add Vertex mode button.
3. Choose what type of control point you want to the new vertex to be:

· If you want the vertex to use a 90º control point, select the Add a corner point vertex to the object 
mode.

· If you want your polyline/polygon curve to pull towards--but not touch--the vertex, select the Add a
Bézier control point to the object mode. 

· If you want your polyline/polygon curve to pass through the vertex, select the Add a cubic spline 
vertex to the object mode.

· If you want the vertex to be a fillet, select the Add a fillet (circular arc) vertex to the object mode, 
and then click the Fillet Setting mode button. In the dialog box that appears, type the Fillet Radius
measurement and click OK. (For the largest fillet possible, set your Fillet Radius to "0".) 

4. Move the mouse cursor to the existing vertex that you want the new vertex added next to--you'll know
you can add the vertex when the cursor looks like this:

 

5. Click the left mouse button. 



 Delete vertex mode
Use this mode button with the 2D Reshape Tool if you want to delete an existing vertex on the 
polygon/polyline. 

1. Select the polyline or polygon that you want to change.

2.  

 Select the 2D Reshape Tool and the Delete Vertex mode button. 
3. Move the mouse cursor to the existing vertex that you want to delete--you'll know you can delete 
the vertex when the cursor looks like this:

 
4. Click the left mouse button. 



 Hide or show edges mode
Use this mode button with the 2D Reshape Tool if you want to hide--but not erase/delete--a portion of the 
object's edge. 

1. Select the polyline or polygon that you want to change.

2.  

 Select the 2D Reshape Tool and the Hide or show edges mode button. 
3. Move the mouse cursor to the vertex in the center of the edge that you want to hide--you'll know 
you have "selected" a vertex when the cursor changes to an unfilled arrow head that looks like this: .
4. Click the left mouse button. If you click again in the same spot, you'll show the portion of the 
object that you just hid.



 Resize Tool
This tool on the 2D Tools palette--which lets you resize rectangles, polygons and ellipses, using a fixed 
point on the drawing as the fulcrum--is best used for visual effects. Essentially, it allows you to move and 
simultaneously reshape the object(s) around one set point in your drawing. If you want to rescale an 
object, you should use the Scale Objects command.

1. Select the object or objects you want to change, and then select the Resize Tool from the 2D Tools 
palette.

2. Click on the point in your drawing that you want to serve as the fulcrum. 

· If you select a fulcrum point that is at the exact center of the object, the resized object will be 
symmetrical.

· However, if the fixed point you select is not at the center of the object, the resized object will 
change proportions.

3. Now, press the left mouse button on an object edge and, while continuing to hold down the mouse 
button, drag the object into its new size, shape, and/or location.



 Shear Tool
This tool on the 2D Tools palette simultaneously skews all of the vertices of a rectangle, polygon, ellipse, 
or polyline, using a fixed point on the drawing as a fulcrum. Think of it as placing a thumbtack on one 
point in the object--or the drawing-- and reshaping every other object point except the one you have 
"tacked" down. The Shear Tool is best used for illustrative purposes when you want to fake a 3D 
perspective.

1. Select the object or objects you want to change, and then select the Shear Tool from the 2D Tools 
palette.

2. Click on the point in your drawing that you want to "tack" down. 

3. Now, press the left mouse button on the object and, while continuing to hold down the mouse button, 
drag the object to shear it.



 Clip Tool
This tool on the 2D Tools palette lets you cut out pieces from the 2D objects in your drawing--lines, arcs, 
rectangles, ellipses, polygons, and polylines. In addition, you can use this tool to split an object in your 
drawing.

Note
The Clip Tool is similar to the Clip Surface command but requires fewer steps. 

1. Select the object or objects that you want to cut, and then select the Clip Tool from the 2D Tools 
palette.

2. Select the cutting mode you want to use:

If you want to cut a hole in your object(s), click the Removes area inside of marquee from selected 
object(s) mode button.

If you want to trim everything away from one piece of your object(s), click the Removes area outside 
of the marquee from selected object(s) mode button.

If you want to split your object(s), making them into new objects, click the Splits selected object(s) at 
the marquee boundary mode button.

3. Press the left mouse key and, while continuing to hold it down, draw your marquee box. Then release 
the mouse button.



 Fillet Tool
This tool on the 2D Tools palette lets you add a highly specific fillet (arch) between two objects--lines, 
boxes, polygons, polylines, circles (but not ovals), and circular arcs--in your drawing, making each of the 
fillet's endpoints tangent to one of the objects. With rectangles, polygons, or polylines, you can use the 
tool to place a fillet between adjacent sides of the object. In addition, you can use this tool to trim or split 
objects at the fillet's endpoints.

Note
You cannot place a fillet between parallel or concentric objects. In addition, if you try to place "split" or 
"trim" fillets between a mixture of objects that can and cannot be split/trimmed, the fillet will work only on 
the objects it can and will ignore the rest.

Here are some examples of the types of fillets you can create with MiniCAD:

Single Object Fillet Without Trim 

Single Object Fillet With Trim 

Line to Line Fillet With Trim 

Circle to Circle Fillet

For additional information, see the following topics:

Placing a Fillet between two objects

Placing a Fillet within an object



Placing a Fillet between two objects

1.  Select the Fillet Tool from the 2D Tools palette, and then select the mode you want to 
use:

If you want to add a fillet to your drawing that won't alter existing objects, click the Places fillets 
without affecting other objects mode button.

If you want to create a fillet between lines and/or arcs that splits these objects, click the Splits 
lines/arcs at the fillet endpoints mode button.

If you want to create a fillet between lines and/or arcs that will trim or extend these objects, click the 
Trims or extends lines/arcs to meet the fillet endpoints mode button.

2.  Click the Fillet Settings preferences button, and type the measurement you want to use in the 
textbox after Fillet Radius, and click OK.

3. Now, press the left mouse button on one of the objects and, while continuing to hold down the 
mouse button, drag the mouse to the other object you want the fillet drawn between. Then release the 
mouse button.
4. If you want, you can draw another fillet--MiniCAD will continue to use the Fillet Radius 
measurement you just typed until you change it.



Placing a Fillet within an object

1.  Select the Fillet Tool from the 2D Tools palette, and then select the mode you want to 
use:

If you want to add an independent fillet to your object, click the Places fillets without affecting other 
objects mode button.

If you want to create a fillet    that splits the objects, click the Splits lines/arcs at the fillet endpoints 
mode button.

If you want to create a fillet that trims or extends the objects, click the Trims or extends lines/arcs to 
meet the fillet endpoints mode button.

2.  Click the Fillet Settings preferences button, and type the measurement you want to use in the 
textbox after Fillet Radius, and click OK.

3. Now, draw the fillet or fillets:
· To draw a single independent fillet between two adjacent edges of an object--or a fillet that splits, 

or trims these edges--press the left mouse button on one edge of the object and, while continuing
to hold down the mouse button, drag the mouse to the other edge. Then release the mouse 
button.

· To have MiniCAD automatically place independent or trim fillets between all adjacent edges of an 
object, click on the object. 

4. If you want, you can draw another fillet--MiniCAD will continue to use the Fillet Radius measurement 
you just typed until you change it.



 Chamfer Tool
This tool on the 2D Tools palette lets you place a chamfer (line) between two objects or adjacent sides of 
an object--rectangles, polygons, polylines, or line segments--placing the chamfer at a specified distance 
from where the objects intersect. In addition, you can place chamfers that will trim or split objects at the 
chamfer endpoints, or extend them to meet at the chamfer endpoints.

Note
You cannot place a chamfer between parallel lines.

The Chamfer Tool has three modes, each of which you can set by a line length and angle or by two line 
lengths. 

1. Select the Chamfer Tool from the 2D Tools palette, and then select the mode you want to use:

If you want to add a chamfer to your drawing that won't alter existing objects, click the Places chamfer
without affecting other objects mode button.

If you want to create a chamfer between line segments that will split them, click the Splits lines at the 
chamfer endpoints mode button. 

If you want to create a chamfer between lines or adjacent edges of an object that will trim or extend 
them, click the Trims or extends lines to meet the chamfer endpoints mode button.

2.  Click the Chamfer Settings Preferences mode button, and select the method you want to 

· Select First & Second Line if you want to use a precise distance from each chamfer endpoint to 
the intersection, type a measurement in the textboxes after First Line and Second Line, and then 
click OK.

· Select First Line & Angle if you want to place one chamfer endpoint at a precise distance from the
intersection, and then draw the chamfer to the next object using a specified angle. Type a 
measurement in the textbox after First Line and an angle degree in the textbox after Angle, and 
then click OK.

3. Now, press the left mouse button on one of the objects to mark the chamfer end point; then while 
continuing to hold down the mouse button, drag the mouse to the other object you want the chamfer 
drawn between, and release the mouse button.



 Eyedropper Tool
This tool on the 2D Tools palette lets you transfer any or all attributes from one object to another in a 
single step, including:

· Pen settings--solid or pattern, and single color or foreground and background colors.

· Fill settings--the pattern and its foreground and background colors.

Note
For more information about all of the attributes you can give to MiniCAD objects, see the Attributes 
Palette.

· Line settings--weight (thickness), line style, and any markers (arrowheads, etc.) and their size.

· Other object information--the object's class and any database records attached to it.

The eyedropper has two modes--one to record an object's attributes and another to transfer those 
attributes to another object:

Changing an object's attributes

Changing your default attributes



Changing an object's attributes

1.  

 Select the Eyedropper Tool from the 2D Tools palette, and then the Pick up attributes mode button.
2. Click the Filter Preferences mode button. In the dialog box that appears, select the attributes you 

want the Eyedropper Tool to record:

· To copy pen attributes, select the Pen checkbox and the checkbox for each of the individual pen 
settings you want to copy. For example, to copy a solid pen, select the Foreground Color 
checkbox.

· To copy fill attributes, select the Fill checkbox and the checkbox for each of the individual fill 
settings you want to copy. 

· To copy line attributes, select the Line checkbox and the checkbox for each of the individual line 
settings you want to copy. 

· Select the Record checkbox if you want to copy any record information that is attached to an 
object.

· Select the Class checkbox if you want to copy any class information that is attached to an object.

3. Click OK. Then use the mouse to move the eyedropper cursor to the object whose attributes you want
to copy, and click it. (You'll hear a "slurp" sound.)

4.  Select the Put down attributes mode button--the mouse cursor changes from an eyedropper to a 
paint can. Move the cursor to the object whose attributes you want to change, and click. (You'll hear a
"splat" sound.)



Changing your default attributes

Use these directions if you want to change your default attributes settings to match the attributes used by 
a particular object. From that point on, then, all new objects you draw will use the attributes you "picked 
up." 

1.  

 Select the Eyedropper Tool from the 2D Tools palette, and then the Pick up attributes mode button.
2. Click the Filter Preferences mode button. In the dialog box that appears, select the attributes you 
want the Eyedropper Tool to record:

· To copy pen attributes, select the Pen checkbox and the checkbox for each of the individual pen 
settings you want to copy. For example, to copy a solid pen, select the Foreground Color 
checkbox.

· To copy fill attributes, select the Fill checkbox and the checkbox for each of the individual fill 
settings you want to copy. 

· To copy line attributes, select the Line checkbox and the checkbox for each of the individual line 
settings you want to copy. 

· Select the Record checkbox if you want to copy any record information that is attached to an 
object.

· Select the Class checkbox if you want to copy any class information that is attached to an object.

3. Select the Pick Up Sets Defaults checkbox, and then click OK. 

4. Use the mouse to move the eyedropper cursor to the object whose attributes you want to copy, and 
click it. (You'll hear a "slurp" sound.) 

5. MiniCAD has now changed the default settings that you selected in the Filter dialog box. Each new 
object you draw from this point will use your new attributes until you change them.



 2D Mirror Tool
This tool on the 2D Tools palette has two options. You can use it to change a 2D object into its mirror 
image, or to add a mirror-image copy of an object to your drawing:

Changing an object into its mirror image

Adding a mirror-image copy to your drawing



Changing an object into its mirror image
1. Select the object you want to change, and then select the Mirror Tool on the 2D Tools palette.

2.  Click the Mirror mode button, and move the Selection Arrow into the Drawing Window--you'll see
that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

3. Draw the axis you want to mirror the object on--press the left mouse button at the start of the axis;
while continuing to hold down the mouse button, drag the mouse to draw the axis line, and then release 
the mouse button--MiniCAD will flip the object, placing it on the opposite side of the axis line you drew.



Adding a mirror-image copy to your drawing

1.  Select the object you want to copy and mirror, and then select the Mirror Tool on the 
2D Tools palette.

2.  Click the Mirror and Duplicate mode button, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

3. Draw the axis, telling MiniCAD where to mirror the object--press the left mouse button at the start 
of the axis; while continuing to hold down the mouse button, drag the mouse to draw the axis line, and 
then release the mouse button--MiniCAD will add a flipped copy of the object on the other side of the axis 
line you drew.



 Duplicate Along Path Tool
This tool on the 2D Tools palette lets you create and place several copies of a 2D object or a group of 2D 
objects in your drawing. You can either place the object(s) along an existing path in your drawing or 
create a path when you duplicate the object(s). 

In addition, you can set the spacing between duplicates--either visually or with a precise measurement. 
Or you can tell MiniCAD the number of duplicates you want placed on the path, and let the program 
determine the spacing needed so that each one is an equal distance from the next

For additional information, see the following topics:

Using an existing path and a set distance between duplicates

Using an existing path and specifying the number of duplicates

Creating a path and using a set distance between duplicates

Creating a path and specifying the number of duplicates



Using an existing path and a set distance between duplicates

1.  Select the 2D object or objects you want to duplicate, and then select the Duplicate 
Along Path Tool on the 2D Tools palette.

2.  

 Select the Click on a path object mode button, and then click the Duplicate Along Path Preferences 
mode button.
3. In the dialog box that appears, select Fixed Distance, and then choose how you want to 
determine the spacing:

· If you want to use a pre-measured distance, select Distance: and type the measurement in its 
textbox. 

· If you want to visually determine the distance when you place the duplicates, select With Drag.

4. Select where you want the duplicates to start:

· If you want the first duplicate to begin at a set distance from your mouse click, select Distance: 
and type the measurement in the textbox after it.

· If you want the first duplicate to begin exactly at your mouse click, select Next Click.

5. If you want the centers of your object to rotate so that they are always tangent to the path, select the 
Tangent to Path checkbox; if not, make sure this checkbox is not selected. Then click OK.

6. Place your duplicates:

· If you typed an exact distance, move the cursor to where you want to place the first duplicate. 
Then press the left mouse button, and while continuing to hold down the button, drag the cursor 
to indicate what direction on the path to place the duplicates. Then release the mouse button.

· If you selected "with drag," move the cursor to where you want to place the first duplicate. Then 
press the left mouse button, and while continuing to hold down the button, drag the cursor in the 
direction you want the duplicates placed , continuing until you have all the duplicates you want. 
Then release the mouse button. 



Using an existing path and specifying the number of duplicates

1.  Select the 2D object or objects you want to duplicate, and then select the Duplicate 
Along Path Tool on the 2D Tools palette.

2.  

 Select the Click on a path object mode button, and then click the Duplicate Along Path Preferences 
mode button.
3. In the dialog box that appears, select Number of Duplicates and type how many in the textbox 
after Number:
4. If you want the centers of your object to rotate so that they are always tangent to the path, select 
the Tangent to Path checkbox; if not, make sure this checkbox is not selected. Then click OK.
5. Select where you want the duplicates to start:

· If you want the first duplicate to begin at a set distance from your mouse click, select Distance: 
and type the measurement in the textbox after it.

· If you want the first duplicate to begin exactly at your mouse click, select Next Click.

6. If you want the centers of your object to rotate so that they are always tangent to the path, select the 
Tangent to Path checkbox; if not, make sure this checkbox is not selected. Then click OK.

7. Place your duplicates--move the cursor to where you want to place the first duplicate. Then press the 
left mouse button, and while continuing to hold down the button, drag the cursor to indicate what 
direction on the path to place the duplicates. Then release the mouse button.



Creating a path and using a set distance between duplicates

1.  Select the 2D object or objects you want to duplicate, and then select the Duplicate 
Along Path Tool on the 2D Tools palette.

2.  

 Select the Draw a polygon path mode button, and then click the Duplicate Along Path Preferences 
mode button.
3. In the dialog box that appears, select Fixed Distance, and then choose how you want to 
determine the spacing:

· If you want to use a pre-measured distance, select Distance: and type the measurement in its 
textbox. 

· If you want to visually determine the distance when you place the duplicates, select With Drag.

4. If you want the centers of your object to rotate so that they are always tangent to the path, select the 
Tangent to Path checkbox; if not, make sure this checkbox is not selected. Then click OK.

5. Slowly click on the location in your drawing where you want the first duplicate placed--the start point 
of your polygon path. 

6. Drag the mouse to the next control point for your polygon path and click to mark it. Continue adding 
control points this way. 

7. To stop drawing your polygon path, double-click to mark the end point. 



Creating a path and specifying the number of duplicates

1.  Select the 2D object or objects you want to duplicate, and then select the Duplicate 
Along Path Tool on the 2D Tools palette.

2.  

 Select the Draw a polygon path mode button, and then click the Duplicate Along Path Preferences 
mode button.
3. In the dialog box that appears, select Number of Duplicates and type how many in the textbox 
after Number:
4. If you want the centers of your object to rotate so that they are always tangent to the path, select 
the Tangent to Path checkbox; if not, make sure this checkbox is not selected. Then click OK.
5. Slowly click on the location in your drawing where you want the first duplicate placed--the start 
point of your polygon path. 
6. Drag the mouse to the next control point for your polygon path and click to mark it. Continue 
adding control points this way. 
7. To stop drawing your polygon path, double-click to mark the end point. 



 Rotate Selection Tool
This tool on the 2D Tools palette lets you rotate a 2D object or a group of 2D objects in your drawing. 

1. Select the 2D object or objects you want to rotate, and then select the Rotate Selection Tool on the 
2D Tools palette.

2. Press the left mouse button, and while continuing to hold down the mouse button, drag a fulcrum line 
(a temporary "handle" to rotate your object) and then release the button.

3. Use the mouse--without pressing either button--to rotate your object(s). When you have the rotation 
angle you want, click the mouse button.



 Property Bounds Tool
This tool on the 2D Tools palette creates a polygon--made of a series of boundary lines or curves--that is 
based on bearing and distance data. 

Note
The Property Bounds tool displays only when you are using the A/E/C overlay.

1. Select the Property Bounds Tool from the 2D Tools Palette.

2. Click your mouse at the starting point you want to use for your property bounds polygon. 

Note
Your first property bounds entry must be a line.

3. In the dialog box that appears, enter the data to draw your first property line:

· In the textbox after Distance: type the "real world" distance for the property line--for example, if 
you are using the scale 1":10' and you want a 50-foot boundary line, type 50'.

Note
These are the directions that lines will be drawn from your starting point when you type these 
angles.

· In the textbox after Bearing: type the angle from your starting point that you want the line drawn--
if you type either 0º or 360º, the line will be drawn.

· Click Apply.

4. Now draw your next property boundary--remember that all bearing angles are calculated from your 
starting point in the direction you specify, not the end point of the line you've just drawn.

· If you want to draw a property line, enter Distance: and Bearing: settings, and click Apply.

· If you want to use an angle to create your boundary, select Curve. Then type the length 
you want to use in the textbox after Radius: and delta angle you want to use after Delta:    Click 
Apply and then Done. (If you click Cancel, you will erase all property bounds you just created.)

5. If you are using lines, continue drawing property bounds, using the directions in step 4. (You can 
remove the lines you've created one at a time by clicking Remove.)

6. When you are done drawing your property bounds, click Done. (If you click Cancel, you will erase all 
property bounds you just created.)



 Parking Space Tool
This tool lets you easily create a parking lot, dividing it into straight or angled parking spaces and 
automatically drawing the lines to mark individual spaces. 

Note
The Parking Space tool displays only when you are using the A/E/C overlay.

1. Select the Parking Space Tool from the 2D Tools palette. Then either click the Parking Space Tool 
preferences mode button or click anywhere in the Drawing Window. A preferences dialog box will 
appear.

2. In the textbox after Space Length: type the measurement you want to use for the length of each 
space.

3. In the textbox after Angle: type the degree angle that you want your parking spaces to meet the 
header line at--if you want them to meet head on (no seeming angle), type 90º.

4. Set the width of your parking spaces:

· If you want all spaces to be the exact same size across, type the measurement you want to use 
in the textbox after Width:

· If you want to set a minimum width--letting MiniCAD figure out how to fill the area with whole 
parking spaces--select the Maximize width checkbox and type in a Min. Width: 

5. Set any other preferences you want to use:

· If you want to simultaneously draw spaces on both sides of the header line, select the Both Sides 
checkbox.

· If you want the front end of the parking spaces to meet the header line at an angle--staggering 
the front ends of all the spaces--select the Angled Header checkbox.

Angled Header Non-Angled Header

 



· If you want a line to mark the front end of each space, select the Header Stripe checkbox.

· If you want a line to mark the outside edge of the first space, select the Begin Stripe checkbox.

· If you want a line drawn at the outside edge of the last space, select the End Stripe checkbox.

6. Click OK. Then move the cursor to where you want the header line to start, and press the left mouse 
button; while continuing to hold down the button, drag the cursor to draw your row of parking spaces. 

7. When the spaces are drawn exactly where you want them, release the mouse button.

Depending on which tool you select, the Wall Tool, Butt Join Walls Tool, Y-Join Walls Tool, or Duplicate 
Symbol in Wall Tool displays in the 2D Tools palette when you are working with the A/E/C overlay. 



 Wall Tool
This tool on the 2D Tools palette creates one of MiniCAD's exclusive hybrid objects, simultaneously 
adding both a 2D and a 3D version of the wall to your drawing. However, you must be in 2D Plan 
projection mode to use the Wall Tool. 

Note
The Wall tool displays only when you are using the A/E/C overlay.

Each wall section you draw is treated as a separate object, but once you draw a wall, you can join it to 
other walls. You also can add cavity lines and fills to your MiniCAD walls, cap and trim them, or insert 
symbols (such as doors and windows) into them. 

There are two ways to create walls in MiniCAD--you can draw them will the mouse, or you can create 
them using a mouse-keyboard combination.

For additional information, see the following topics:

Drawing walls with a mouse

Creating walls with a mouse-keyboard combination

Joining Walls

Removing Breaks in Walls



Drawing walls with a mouse

There is one important thing you need to keep in mind when you draw walls with the mouse: MiniCAD will
automatically make the walls the same height as the layer you are drawing in. Because the default height 
for all layers is 0 (zero), if you don't set a layer height, all walls you draw will be flat. 

Hint
You can change the height of individual walls using the Object Info palette. However, if you want all your 
walls to be the same height, it is probably easiest to set the D Z height for the layer before you begin 
drawing. 

1. Make sure you are in 2D Plan projection mode and, if you want, that you have set a DZ height for the 
layer you are working in.

2.  Select the Wall Tool from the 2D Tools palette, and the Create wall mode button.

3. Select the Offset mode you want to use when drawing your walls; this will affect how the wall is 
positioned on the page relative to the control line you draw with the mouse:

If you want the control line you draw to mark the back edge of the wall, click the first mode button.

If you want the control line you draw to be in the exact center of your wall, click the second mode 
button.

If you want the control line you draw to mark the front edge of the wall, click the third mode button.

If you want to specify an offset value for the control line in the wall you draw, click the last mode 
button.

4.  Click the Wall Preferences mode button. In the dialog box that appears, set the 
preferences you want to use:

· Type the thickness of your wall (the amount of space between the two wall lines drawn) in the 
textbox after Separation:

· If you selected the fourth offset mode button (the one that allows you to specify an offset value for
the control line in the wall you draw), type the distance you want that line to be offset from the 
center of the wall in the textbox after Control Offset:

· Specify what caps (end lines), if any, you want on your wall--in the shortcut menu after Caps:, 
pick None, Start, End, or Both.

· Specify the type of walls you want--Flat or Round--in the shortcut menu after Type:

Important
Once you use cavity lines in a drawing, MiniCAD will continue to use the cavity line settings until 
you change them. If you no longer want cavity lines in your walls, click Cavity Lines... and then 
Delete and OK.

· If you want to create a cavity (marked region) inside your wall, click Cavity Lines... Then, if you 
haven't created a wall with a cavity in your drawing, click New in the dialog box that appears--this 
will let you access the other setting options in this box:

· If you want your cavity line to be offset from the center of your wall, type a measurement in 



the textbox after Offset:

· In the shortcut menu after Line: select the type of line you want to mark your wall cavity.

· If you want a Filled Cavity select this checkbox, and then type the Width: you want to use for 
the fill and select the fill pattern from the shortcut menu after Fill: Then click OK.

· If you want to use the program's new Auto Join Wall feature, select the Auto Join checkbox.

Note
Remember that the inside and outside edges of your wall will be drawn around the control 
line according to the mode you chose in step 3.

· When you've finished setting your Wall Preferences, click OK.

5. Move the cursor to where you want the wall control line to start, and press the left mouse button; 
while continuing to hold down the button, drag the cursor to draw your wall. 

6. When the wall is drawn exactly where you want it, release the mouse button.



Creating walls with a mouse-keyboard combination

There is one important thing to remember when creating walls with this method: MiniCAD will place walls 
using a center control line--wherever you tell MiniCAD to place the wall, it will use that location as the 
exact center of the wall and draw the front and back edges of the wall on either side of it.

1.  Make sure you are in 2D Plan projection mode, and then double-click the Wall Tool on 
the 2D Tools palette.

2. In the dialog box that appears, set the wall size:
· If you want to use Cartesian coordinates, select Cartesian and type the wall's ±X: and ±Y: 

coordinates, and height (±Z:). 
· If you want to use Polar coordinates, select Polar and type the wall's length (L:), angle (A:), and 

relative height (±Z).

3. Then type the Thickness: of your wall. 

4. Specify what caps (end lines), if any, you want on your wall--in the shortcut menu after End Caps:, 
pick None, Start, End, or Both.

5. Specify the type of walls you want--Flat or Round--in the shortcut menu after Type:

6. If you want to create a cavity (marked region) inside your wall, click Cavity Lines… Then, if you 
haven't created a wall with a cavity in your drawing, click New in the dialog box that appears--this will 
let you access the other setting options in this box:

Important
Once you use cavity lines in a drawing, MiniCAD will continue to use the cavity line settings until you 
change them. If you no longer want cavity lines in your walls, click Cavity Lines... and then Delete and
OK.

· If you want your cavity line to be offset from the center of your wall, type a measurement in the 
textbox after Offset:

· In the shortcut menu after Line: select the type of line you want to mark your wall cavity.

· If you want a Filled Cavity select this checkbox, and then type the Width: you want to use for the 
fill and select the fill pattern from the shortcut menu after Fill: Then click OK.

· Decide how you want to place the wall in your drawing--remember that with both methods, 
MiniCAD will place your wall using the center control line.

· To hand place the wall, select the Next Click checkbox.

· To place it at an exact location in your drawing, type in the X Pos: and Y Pos: 

7. Click OK. If you have selected the Next Click checkbox, move the mouse to the place you want your 
wall to start, and click.



Joining Walls

Once you create wall segments, you can easily join them with the Join Wall mode button. It automatically 
determines and forms the correct type of joint--"T" "L" or "X"--between two wall segments. 

Note
You can also use the Join command to connect wall segments.

1.  

 Select the Wall Tool from the 2D Tools palette, and then select the Join Wall mode button.
2. Press the left mouse button to select one of the wall segments you want to join; while continuing 
to hold the mouse button down, drag a dashed line to the other wall segment. Then release the mouse 
button.



Removing Breaks in Walls

The third mode button for the Wall Tool lets you easily cleanup any breaks in your walls that were created 
when you were editing them. In addition, it will also remove any end caps on those walls.

1.

 Select the Wall Tool from the 2D Tolls palette, and then select the Remove wall breaks/caps mode 
button.
2. Use the mouse to draw a marquee box around the walls you want to cleanup to select them--as 
soon as you release the left mouse button, MiniCAD will automatically remove any breaks or end caps on 
the walls you selected.



 Butt-Join Tool
When you draw and automatically join walls with the Wall Tool, any wall corners will be mitered together. 
This type of join is fine for conceptual designs. However, to match building structures, you will want to 
create butt-joined walls--this will give you more accurate "takeoffs" and ensure that beams and other 
structural pieces are sized correctly.

Note
The Butt-Join tool displays only when you are using the A/E/C overlay.

1. Select the Butt-Join Tool from the 2D Tools palette.

2. Press the left mouse button to select the non-bearing wall; while continuing to hold the mouse button 
down, drag a dashed line to the bearing wall. Then release the mouse button.



 Y-Join Tool
This tool on the 2D Tools palette lets you join three walls that come together at different angles--for 
example, when a bay window ends at the party wall of a townhouse.

Note
The Y-Join tool displays only when you are using the A/E/C overlay.

1. Draw two of the wall segments, and then use the Join Wall mode button on the Wall Tool to join them.

2. Draw the third wall, stopping just shy of the junction of the other two wall segments.

3. Use the 2D Selection Tool to select the joined wall segments (the first two that you drew and joined).

4. First select the Y-Join Tool button, and then click the third (as yet unjoined) wall segment. MiniCAD 
will automatically join this wall segment with the first two segments.



 Duplicate Symbol in Wall Tool
This tool on the 2D Tools palette allows you to precisely place multiple copies of a symbol (such as a 
window) within a wall you have drawn. There are two modes to this tool--one places the symbols using 
their original orientation, the other flips them (for example, if you want to change the direction a door 
swings open). In addition, you can either hand place the symbols or let MiniCAD place them for you.

Note
The Duplicate Symbol in Wall tool displays only when you are using the A/E/C overlay.

For additional information, see the following topics:

Hand placing symbols in walls

Using dimensions to place symbols in walls



Hand placing symbols in walls
1. To place a symbol with this tool, you must first make it active--using the Resources Palette, click on 

the symbol's name and then click the select button. 

2.  Select the Duplicate Symbol in Wall tool from the 2D Tools palette, and then select 
the placement mode you want to use:

If you want the symbol to be placed using its orientation in the Resources palette, click The symbol 
will not be flipped mode button

If you want the symbol to be flipped when it is placed, click The symbol will be flipped mode button.

3.  Now click the Duplicate Symbol in Wall Preferences mode button. In the dialog box that 
appears, set your placement preferences:

· For placing your first symbol, select Next Click for the Start Offset.
· Decide how many duplicate symbols you want and how you want to place them:

· If you want to hand place all symbols, select Next Click for Spacing. Then select the 
Copies: checkbox, and then type "1".

· If you want to hand place only the first symbol, select the textbox option for Spacing and type 
the distance you want between duplicate symbols. Then select the Copies: checkbox, and 
type the total number of symbols you want placed.

4. Click OK. Then move the cursor to the place on the wall that you want to insert your first symbol, and 
click.

5. If you opted to hand place all symbols, move your cursor to each place on the wall that you want a 
symbol inserted and click.



Using dimensions to place symbols in walls
1. To place a symbol with this tool, you must first make it active--using the Resources Palette, click on 

the symbol's name and then click the select button. 

2.  Select the Duplicate Symbol in Wall tool from the 2D Tools palette, and then select 
the placement mode you want to use:

If you want the symbol to be placed using its orientation in the Resources palette, click The symbol 
will not be flipped mode button

If you want the symbol to be flipped when it is placed, click The symbol will be flipped mode button.

3.  Now click the Duplicate Symbol in Wall Preferences mode button. In the dialog box that 
appears, set your placement preferences:

· Select the textbox option for Start Offset and type the distance from the wall edge that you want 
the first symbol placed.

· Now select the textbox option for Spacing and type the distance you want between duplicate 
symbols. 

· Select the Copies: checkbox, and type the total number of symbols you want placed in the wall in
the textbox.

4. Click OK. Then click anywhere on the wall that you want to insert the symbols. 



 Number Stamp Tool
This tool on the 2D Tools palette allows you to easily mark objects in your drawing and keep count of 
them, using either numbers or letters. In addition, you can use the Number Stamp Tool to attach and track
database records.

Note
The Number Stamp tool displays only when you are using the A/E/C overlay.

1. Select the Number Stamp Tool from the 2D Tools palette, and then select the preferences mode 
button.

2. In the dialog box that appears, select the outline shape, if any, that you want around your 
numbers/letters:

· If you want to use an outline shape, select the Shape checkbox. Then select the shape you want 
to use and type its measurements in the textbox.

· If you don't want an outline, make sure that the Shape checkbox is not selected.

3. If you want to attach a database record to your number stamps, click Attach...    Then in the dialog 
box that appears, click the name of the record you want to use and click Attach.

Hint
You can also use the number stamp tool to invisibly track data base information. In the preferences 
dialog box, attach a record only and leave all other textboxes and checkboxes blank.

4. Specify the identification information you want to use: 

· In the textbox after Start ID: type the letter or number you want to start with.

· If you want a symbol (such as "<" or "#") or a text string (such as "part #") to precede the stamp 
numbers/letters, type it in the textbox after Leader:

· If you want a symbol or text string to follow the stamp numbers/letters, type it in the textbox after 
Trailer:

5. Click OK. Move the Selection Arrow into the Drawing Window--you'll see that the standard arrow 
cursor changes into tiny cross hairs (two crossed lines). 

6. Click once on each object you want to number.

Note
Like other objects, number stamps can be moved around or resized in your drawing.



 Revision Cloud Tool
This tool on the 2D Tools palette allows you to add "revision clouds" to your drawing, which identify 
changes to your drafting plan. You can either create an oval shaped revision cloud, or a more free-form 
polygon version.

Note
The Revision Cloud tool displays only when you are using the A/E/C overlay.

For additional information, see the following topics:

Creating an oval revision cloud

Creating a polygon revision cloud



Creating an oval revision cloud

1.  

 Select the Revision Cloud tool from the 2D Tools palette, and then the Revision Cloud by Oval 
mode button.
2. Press the left mouse button in the center of the changed area you want to mark; while continuing to 

press the mouse button, drag the cursor to form your revision cloud.

3. When the cloud is where you want it, release the mouse button.



Creating a polygon revision cloud

1.  

 Select the Revision Cloud tool from the 2D Tools palette, and then the Revision Cloud by 
Polygon mode button.
2. Press the left mouse button to mark the approximate start of your revision cloud; while continuing to 

press the mouse button, drag the cursor to the next point on your polygon and release the button.

3. Press the left mouse button, drag the cursor to the next point on your polygon, and then release the 
button. Continue this way until you reach the last point of your polygon.

4. Now press the left mouse button, drag the cursor to your original polygon point, and then release the 
button--this will complete the revision cloud polygon. 



 Straight Stair Tool
This tool on the 2D Tools palette lets you easily create 2D, 3D, or hybrid (2D/3D) straight stairs. In 
addition, you can have an open or a closed riser, and you can show the necessary clearance for the 
ceiling above. 

Note
The Straight Stair tool displays only when you are using the A/E/C overlay.

No matter what type of stairs you are drawing, you must be in 2D Projection mode, Top/Plan view. (If you 
try to select the Straight Stair Tool while in any other projection mode, a dialog box will appear asking you 
if you want to switch to Plan projection. And if you are in any other view, MiniCAD will automatically switch
to Top/Plan view.)

1.  

 Select the Straight Stair Tool from the 2D Tools palette. Then select the preferences mode button.
2. In the dialog box that appears, select the preferences you want to use:

· Select the checkbox or checkboxes for the kind of stairs you want to create--2D, 3D, or hybrid 
(select 2D and 3D). For 3D stairs, also select either the Ascending or Descending checkbox.

· If you want to create a landing with your stairs, select the Square Landing checkbox.

· If you are creating 2D stairs and what to have MiniCAD automatically show the continuation of a 
staircase from one floor to the next with a stair break, select the Draw 2D Stair Break checkbox.

· If you are creating 3D stairs, you can create Open Risers by selecting the checkbox and then 
typing values for Tread Thickness and Stringer Thickness. 

· If you want to Denote Head Clearance in your drawing, select that checkbox and then type a 
Minimum Clearance measurement and the Ceiling height. 

· Type how deep you want the individual stairs to be in the textbox after Tread:

· You can either use a set riser measurement or have MiniCAD calculate risers:

· If you want to use a set measurement, type it in the checkbox after Riser:

· If you want MiniCAD to make the calculation, select the Fit to Height checkbox. When you do,
MiniCAD will show you how many risers are needed, as well as their Minimum: and 
Maximum: riser heights.

· Type the Width: of your staircase in this textbox.

· If you are creating 3D stairs, type the starting elevation you want your stairs to start at in the 
textbox after Starting Z:    In most cases, you will want this to be 0 (zero), having your stairs start 
at the bottom of your layer. 

3. Set the alignment you want to use for drawing your stairs.

· If you are drawing stairs without a landing, you can choose to align the top left, center, or right of 
the stairs. Select the mode button for the alignment you want to use.

 Align top left of stair.

 Align top center of stair.

 Align top right of stair.
· If you are drawing stairs that have a landing, you can choose to align the top left, right, or center 

of either the first stair or of the landing

· First, select either the Landing or the First Stair mode button.



 First Stair mode.

 Landing mode.
· Then choose the alignment you want to use--left, center, or right.

4. Position the cursor at the starting point of your stairs and press the left mouse button; while continuing
to hold down the mouse button, drag the mouse to draw your staircase.

5. When your staircase is where you want it, release the mouse button.



 Fancy Door Tool
This tool on the 2D Tools palette lets you create a 2D door that has raised panels, as well as rectangular 
or semi-circular windows. Once you've created a door this way, you can convert it to a 3D polygon or 
extrude it to create a door that will display in 3D projection modes. (For information about these functions,
see the 3D Polygon Tool and the Extruded Polygon Tool.) 

Note
The Fancy Door    tool displays only when you are using the A/E/C overlay.

The one thing you need to keep in mind when drawing fancy doors is that you individually set the 
preferences for and then draw each section--door frame, window type, or raised panels.    

1.  Select the Fancy Door Tool on the 2D Tools palette.

2. Create the door frame: 

·  

 Select the Create Door mode button, and then click on the Preferences mode button. 
· In the dialog box that appears, type the measurement you want to use for the width of the door 
frame, and click OK.
· Position the cursor at the starting point of the door frame and press the left mouse button; while 
continuing to hold down the mouse button, drag the mouse to draw your door.
· When your door is the size you want, release the mouse button.
3. If you wish, add windows to the door:

·  

 Select the mode button for the type of window you want to create

·  Click the preferences mode button. 
· In the dialog box that appears, type the measurement you want to use for the width of the window
bevel, and click OK.
· Position the cursor inside the door frame at the starting point of your window, and press the left 
mouse button; while continuing to hold down the mouse button, drag the mouse to draw your window.
· When your window is the size you want, release the mouse button.
4. If you wish, add raised panels to the door:

·  

 Select the Raised Panels mode button, and then click on the preferences mode button. 
· In the dialog box that appears, type the measurement you want to use for the width of the pattern 
bevel, plus the number of rows and the number of columns. Then click OK.
· Position the cursor inside the door frame at the starting point of your raised panel, and press the 
left mouse button; while continuing to hold down the mouse button, drag the mouse to draw your panels.
· When your block of raised panels is the size you want, release the mouse button.



 Shutter Tool
This tool on the 2D Tools palette lets you easily create 2D shutters. Once you've created shutters this 
way, you can convert them into 3D polygons or extrude them so they will display in 3D projection modes. 
(For information about these functions, see the 3D Polygon Tool and the Extruded Polygon Tool.)

1. Double-click the Shutter Tool on the 2D Tools palette.

2. In the dialog box that appears, type in the measurements you want to use for the shutter's Frame 
Width and Slat Width, and then click OK.

3. Position the cursor at the starting point of your shutter, and press the left mouse button; while 
continuing to hold down the mouse button, drag the mouse to draw your shutter.

4. When your shutter is the size you want, release the mouse button.



3D Tool Palette

The standard 3D Tools palette displays 10 different tool buttons. However, from these 10 buttons, you can
access 16 different tools.

On the palette, you'll see that some tool buttons have an arrowhead in the lower-right corner. When you 
click and hold down the left mouse button on one of these tool buttons, a shortcut tool palette will appear. 
Drag the selection arrow to the tool you want to select, and then release the left mouse button. MiniCAD 
will display that tool button in the 3D Tools palette. 

Tool Description

The Light Creation tool allows you to place multiple 
sources of light in your drawing.

The 3D Selection tool is used to select objects in 3D 
orthogonal views.

The Walkthrough tool is used to visualize an 
architectural model.

The Translate View tool moves the 3D projection 
around the page.

The Flyover tool is used to move the view of the 
drawing by dragging the mouse. It changes the angle of 
view, while constraining the viewer to an upright 
position.

The Rotate View tool is used to rotate a selected object 
in 3D space.

The Set Working Plane tool is used to set the working 
plane based on either a currently extant object's plane 
or three points in space specified by the user.

The 3D Reshape tool is used to edit extrudes, walls, 
roofs and 3D polygons.

The Extruded Rectangle tool creates 3D rectangles 
without drawing them in 2D first.

The 3D Polygon tool is used to create 3D polygons 
without drawing them in 2D first.

The Extruded Polygon tool is used to extrude objects 
in 3D without drawing them in 2D first.



The 3D Symbol Insertion tool is used to insert symbols
in 3D orthogonal projections.

The 3D Locus tool is used to place a 3D reference point
(represented by a triad) on the drawing.

The 3D Mirror tool is used to make a mirror image of a 
selected object in 3D space. 

The Rotate View tool is used to change a model's angle
of view.

The Align Plane tool allows you to align 3D objects to 
the working plane in both rotation and translation.

 Light Creation Tool
This tool on the 3D Tools palette allows you to place multiple sources of light in your drawing. In MiniCAD 
7, you can create three types of light:

· Directional--This type of light most closely approximates the Sun used in previous versions of 
MiniCAD. A directional light source will project light with equal rays in the direction you specify onto 
your drawing. 

· Point--This type of light works like a bare light bulb. A point light source will radiate light in all 
directions from its location in your drawing. 

· Spot--This type of light works like a flash light, or a conventional spot light, allowing you to change the
direction and diffusion of light. A spot light source projects light beams in the direction you specify, 
using the diffusion angle you set.

There are two different ways that you can create and place lights in your drawing--Using the Mouse and 
Using a Mouse-Keyboard combination.

For additional information, see the following topics:

Adding Light Sources with the Mouse

Adding Light Sources with a Mouse-Keyboard Combination



Adding Light Sources with the Mouse
1. Select the Light Tool from the 3D Tools palette, and then select the mode button that matches the type

of light you want to create--Directional Light, Point Light, or Spot Light.

2. Click the Light Preferences mode button or click anywhere in the Drawing Window. 

3. In the dialog box that appears:

· Decide if you want the light you are creating to radiate light your drawing.

· If you want to view the light rays in your drawing, click On.

· If you want to temporarily hide the light rays in your drawing, click Off.

· Set the brightness of the light. You can either type the percentage you want to use in the textbox 
after Brightness: or drag the slider to can the brightness setting.

· If you want to change the light's Color:, click the color wheel. In the dialog box that appears, click 
the color you want to use and then click OK.

· If you want the light to Cast Shadows, select this checkbox.

· If you are creating a Point Light, select the falloff distance you want to use from the shortcut menu
after Dist Falloff:

· If you are creating a Spot Light:

· Specify the spread and beam you want the light to use--you can type angle values in the 
textboxes after Spread: and Beam:, or you can drag the point handles in the illustration box.

· Select the falloff distance you want to use from the shortcut menu after Dist Falloff:

· Select the beam angle falloff you want to use from the shortcut menu after Ang Falloff:

4. Click OK--you'll see that the standard arrow cursor has changed into tiny cross-hairs (crossed lines). 
Click the point in your drawing where you want to place the light.



Adding Light Sources with a Mouse-Keyboard Combination
1. Double-click the Light Tool on the 3D Tools palette.

2. In the dialog box that appears, select the type of light you want to use--Directional, Point, or Spot--and
then click its Options… button. 

3. Select the settings you want to use for the light in the options dialog box--be sure to type the 
coordinates you want to use in placing the light.

4. Click OK.



 3D Selection Tool
When you move your mouse into the Drawing Window, the standard arrow cursor will automatically 
change into an icon that matches the tool you have selected. For that reason, you must use the 3D 
Selection Tool if you want to select, move, or resize 3D objects in orthogonal views. For more information 
on selecting MiniCAD objects, see How can I select objects, including text?.

When this tool is active, your cursor will remain an arrow within the Drawing Window. In addition, you'll 
see a dotted line that branches from your X and Y locations in the Drawing Window--this line helps you 
also identify the Z location of the Selection Arrow in your drawing.

When you click the 3D Selection Tool, you'll see that five mode buttons are added. These mode buttons 
allow you to quickly switch back and forth between five different 3D views. If you click on these mode 
buttons, your Drawing Window will change to show these standard views:

 Top View

 Front View

 Right View

 Right Isometric View

 Left Isometric View
Note
For more information about the views you can select from the 3D Menu, see the Standard Views 
command.



 Walkthrough Tool
This tool on the 3D Tools palette allows you to simulate a "walkthrough" of your 3D model. You can move 
closer to it, back away, turn right or left, and look up or down--all mimicking the movements you might 
make if you were literally walking through and viewing the design as a real-world model.

To use the Walkthrough Tool, you must be in the Perspective projection mode. If you try to select this tool 
when you are in a different projection mode, a dialog box will appear, asking if you want to switch to 
perspective projection. Once there, the different walkthrough movements can be controlled either by 
dragging the mouse or by clicking mode buttons.

The best way to learn how to use this tool is to experiment, comparing how the drawing responds to 
different movements. Here are some directions to get you started.

1. Make sure you are in Perspective projection mode (see the Perspective command, and then select 
the Walkthrough Tool from the 3D Tools palette.

2. Move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into crossed, double-headed arrows. 

3.  Position yourself level with the model and directly facing its front by clicking the Reset mode 
button.

4. Try moving around with just the mouse. Imagine that your Drawing Window has four quadrants. 
Whenever you hold down the left mouse button, you can move forward, backward, left, and right by 
dragging the mouse in these directions. (The place where all these quadrants meet is the "still area"--
when you move the mouse there, the walkthrough movement will stop): 

 
5. If you press the shift key while dragging your mouse as directed above, you will see only the 
ground plane and a bounding box--a box surrounding the outer edges of your model. For complex 
models, this may make it easier to move around.
6. If you press the control key while dragging your mouse up or down, you can raise or lower the 
model and the ground plane: 
7. You also can obtain the following movements by clicking the mode buttons:

 Click this button to raise the ground plane and lower your vantage point.

 Click this button to lower the ground plane and raise your vantage point.

 Click this button to look down, changing the perspective of the model as if you were looking down at 
a real-world model.



 Click this button to look up, changing the perspective of the model as if you were looking up at a real-
world model.



 Translate View Tool
This tool on the 3D Tools palette gives you another way to look at your 3D model. However, unlike the 
Walkthrough Tool, you can use the Translate View Tool in any 3D projection mode. You can use this tool 
either by dragging the mouse or by clicking mode buttons. Here are some directions to get you started.

1. Select the Translate View Tool from the 3D Tools palette, and then move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into crossed, double-headed 
arrows. 

2. Try moving around with just the mouse. Imagine that your Drawing Window has four quadrants. 
Whenever you hold down the left mouse button, you can move the center of your ground plane--and 
all the objects on it--forward, backward, left, and right by dragging the mouse in these directions. 

3. If you press the shift key while dragging your mouse as directed above, you will see only the ground 
plane and a bounding box--a box surrounding the outer edges of your model. For complex models, 
this may make it easier to move around.

4. If you press the control key while dragging the mouse up or down vertically, you can move forward 
(drag up) and backward (drag down).

5.  

 The two mode buttons for the Translate View Tool work like binoculars--letting you focus in and out 
on the picture in your Drawing Window.



 Flyover Tool
As its name implies, this tool on the 3D Tools palette lets you look down at a 3D model by raising your 
vantage point. In addition, you also can lower your viewpoint to look up at the model, or move around the 
model to either the left or right as if you were walking around it. All of these movements simulate the 
views you would have if you were moving in those directions around a real-world model.

You can use the Flyover Tool in any of the 3D projections modes. While you are using the tool to move, 
your model will display in wireframe even if you have it set to render. Every time your movement stops, 
though, MiniCAD will render the new view of your model. Additionally, if you have a highly complex 
drawing, MiniCAD may temporarily "strip away" some of the detail so that your movement does not move 
too slowly. Again, when your movement stops, the detail will return.

The different directional movement of the Flyover Tool can be controlled either by dragging the mouse or 
by clicking mode buttons. The best way to learn how to use this tool is to experiment, comparing how the 
drawing responds to different movements. Here are some directions to get you started.

Hint
You will have the most control over the rotation movement if you use the Reference Plane buttons on the 
Working Planes palette with the Flyover Tool.

1. Select the Flyover Tool from the 3D Tools palette, and then select the mode button that matches what 
you want your movement to center around:

 Rotate Around Center of Working Plane

 Rotate Around Center of Ground Plane

 Rotate Around Center of Object(s) Selected

2. Move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 
changes into a circular arrow. 

3. Try moving around with just the mouse. Imagine that your Drawing Window has four quadrants. 
Whenever you hold down the left mouse button, you can move upward, downward, left, and right by 
dragging the mouse in these directions. 

4. If you press the shift key while dragging your mouse, you will see just the outer edges of your 
model and the ground plane. For complex models, this may make it easier to move around.



5. If you press the control key while dragging your mouse, you'll get these movements:

6. You also can obtain these same movements by clicking these mode buttons:

 Lower View and Raise Model Up

 Raise View and Lower Model

 Move Model Closer

 Move Model Away



 Rotate View Tool
This tool on the 3D Tools palette lets you rotate your drawing 360º in any direction. The best way to learn 
how to use this tool is to experiment, comparing how the drawing responds to different movements. Here 
are some directions to get you started.

1. Select the Rotate View Tool from the 3D Tools palette, and then select the mode button that matches 
what you want your movement to center around:

 Rotate Around Center of Working Plane

 Rotate Around Center of Ground Plane

 Rotate Around Center of Object(s) Selected
2. Select the mode button that matches the direction you want to rotate the drawing:

 Rotate Clockwise

 Rotate Counter-Clockwise
3. Move the Selection Arrow into the Drawing Window--you'll see that the standard arrow cursor 

changes into a circular arrow. 

4. Whenever you hold down the left mouse button, you can rotate the object fully, flipping it in the 
direction that you drag the mouse.



 Set Working Plane Tool
This tool on the 3D Tools palette lets you change the position and angle of your working plane. You can 
set it to match a plane (side) on a rendered object. Or you set it by defining a plane with three points on 
rendered or wireframe objects. 

Setting, and resetting, your working plane helps you take advantage of one of MiniCAD's unique 
features--the ability to draw in isometric views.

For additional information, see the following topics:

Setting the Working Plane with an Object

Setting the Working Plane with Three Points



Setting the Working Plane with an Object

1.  Select the Set Working Plane Tool from the 3D Tools palette, and move the Selection 
Arrow into the Drawing Window--you'll see that the standard arrow cursor changes into a pointed 
finger.

2. Move the cursor to the side of the rendered object that you want to set the working plane against and 
click.



Setting the Working Plane with Three Points

1.  Select the Set Working Plane Tool from the 3D Tools palette, and move the Selection 
Arrow into the Drawing Window

· If you are in wireframe mode, the standard arrow cursor changes into dashed cross-hairs (two 
crossed lines).

· If you are in a rendered mode, the standard arrow cursor changes into a pointed finger when you 
touch an object's plane.

2. Select your three points. First, move the cursor to the first snap point you want to use and press the 
left mouse button; while continuing to hold down the button, drag the cursor to your second snap point
and release the button. Now click on the third snap point--MiniCAD will automatically reset the 
Working Plane to the plane that intersects all three points.



 3D Reshape Tool
You can use this tool on the 3D Tools palette to reshape, one at a time, the heights of extrudes--3D 
objects that are not meshes. In addition, you can use it to reshape walls, to move symbols in walls, and 
the angle (rise/run) of roofs.

Note
You can use this tool to change the rise/run (angle) of a roof, as long as it is at least 0º and no more than 
85º.

For additional information, see the following topics:

Changing the Height of Extrudes

Reshaping Walls

Moving Symbols Within a Wall



Changing the Height of Extrudes
1. Select the extruded object that you want to reshape.

2.  Then select the 3D Reshape Tool from the 3D Tools palette--you'll see that an 
additional two control points are added to the center edges of the extrude.

3. Move the cursor to one of these new endpoints--you'll know the mouse is touching one when the 
standard arrow cursor changes into a double-headed, unfilled arrow.
4. Press the left mouse button to select the control point; while continuing to hold the button down, 
drag the mouse to change the height of the extrude. When it is the height you want, release the mouse 
button.



Reshaping Walls

You can use the 3D Reshape Tool to change the height or length of walls, to add control points to create a
peak in a wall, or to delete one of these control points that you've added.

1. Select the 3D Reshape Tool from the 3D Tools palette, and then select the wall you want to reshape.

2. To change the wall's height:

·  Select the Reshape 3D Walls mode button.

· Move the cursor to an endpoint on one of the corners--you'll know the mouse is touching one 
when the standard arrow cursor changes into a double-headed, unfilled arrow.
· Press the left mouse button to select the control point; while continuing to hold the button down, 
drag the mouse to change the wall's height. 
· When it is the length you want, release the mouse button.
3. To change the wall's length:

·  Select the Reshape 3D Walls mode button.

· Move the cursor to a control point in the center edge of the wall--you'll know the mouse is 
touching one when the standard arrow cursor changes into a double-headed, filled arrow.
· Press the left mouse button to select the control point; while continuing to hold the button down, 
drag the mouse to change the wall's length. 
· When it is the height you want, release the mouse button.
4. To add a control point to a wall:

·  Select the Add 3D Wall Peaks mode button.

· Move the cursor to an endpoint on one of the corners--you'll know the mouse is touching one 
when the standard arrow cursor changes into a hollow box with arrows pointing away from all four 
corners.
· Press the left mouse button to select the control point; while continuing to hold the button down, 
drag the mouse to add the control point and peak to the wall. 
· When the peak is where you want it, release the mouse button.
5.  To delete one of the control points you've added:

·  Select the Delete 3D Wall Peaks mode button.

· Move the cursor to the peak control point you want to delete--you'll know the mouse is touching it 
when the standard arrow cursor changes into a hollow box with arrows pointing away from all four 
corners.
· Click on the peak control point--MiniCAD will delete the control point and change the wall into a 
level height. 



Moving Symbols Within a Wall
1. Select the 3D Reshape Tool from the 3D Tools palette.

2. Drag the cursor to the one of the edges of the symbol you want to move--you'll know the mouse is 
touching one when the standard arrow cursor changes into a hollow box with arrows pointing away 
from all four corners.

3. Press the left mouse button to select the symbol; while continuing to hold the button down, drag the 
mouse to move the symbol. When it is in the new location, release the mouse button.



 Extruded Rectangle Tool
This tool on the 3D Tools palette lets you draw rectangles that have a height in any 3D layer and 
projection. Because they have a location in 3D space, extruded rectangles can be manipulated like other 
3D objects--they can be rotated, placed in perspective, and translated in 3D space. 

Unlike 2D rectangles, extruded rectangles must be rendered if you want them to have a "fill pattern." 
MiniCAD considers extruded rectangles "mesh objects" (not extruded objects), meaning you can edit 
them later on. 

1. Select the Extruded Rectangle Tool from the 3D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed
lines).

2. Click the left mouse button to mark one of the rectangle's corner points.

3. In the dialog box that appears, type the height you want to use for your polygon in the textbox after 
Height (Z): and click OK.

4. Drag the mouse, without pressing the left mouse button, until the rectangle is the size and at the 
position you want. Then click the mouse button to complete the extruded rectangle. 



 3D Polygon Tool
This tool on the 3D Tools palette lets you draw polygons that have a location in 3D space. While they are 
flat objects (their Z height will equal zero), you can rotate them, place them in perspective, and translated 
them in space like any other 3D object. Unlike their 2D counterparts, 3D polygons must be rendered to 
have a "fill pattern."

1. Select the 3D Polygon Tool from the 3D Tools palette, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

2. Click the left mouse button to mark the polyline's start point (first vertex).

3. Drag the mouse to the next vertex. Continue adding vertices this way. 

4. To stop drawing the polygon, double-click to mark the polygon's end point (final vertex). If you want to 
create a closed polygon, double-click the first vertex--MiniCAD will automatically join the first and last 
vertex, creating a closed polygon.



 Extruded Polygon Tool
Unlike the 3D polygon tool, the Extruded Polygon Tool lets you draw 3D polygons that have a height. 
These polygons also can be rotated, placed in perspective, and translated in 3D space. They, too, must 
be rendered if you want them to have a "fill pattern." Because MiniCAD considers these polygons "mesh 
objects" (not extruded objects), you can later edit their individual vertices. 

1. Select the Extruded Polygon Tool from the 3D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed
lines).

2. Click the left mouse button to mark the polyline's start point (first vertex).

3. In the dialog box that appears, type the height you want to use for your polygon in the textbox after 
Height (Z): and click OK.

4. Drag the mouse to the next vertex. Continue adding vertices this way. 

5. To stop drawing the polygon, double-click to mark the polygon's end point (final vertex). If you want to 
create a closed polygon, double-click the first vertex--MiniCAD will automatically join the first and last 
vertex, creating a closed polygon.



 3D Symbol Insertion Tool
This tool on the 3D Tools palette lets you precisely place a single 3D symbol in your drawing when it is in 
Orthogonal projection mode. 

Note
For more information on selecting symbols with the Resource palette, see Working with Symbol 
Resources.

1. To place a symbol with this tool, you must first make it active--using the Resources palette, click on 
the symbol's name and then click the select button.

2. Select the 3D Symbol Insertion Tool from the 3D Tools palette, and move the Selection Arrow into the 
Drawing Window--you'll see that the standard arrow cursor changes into cross hairs (two crossed 
lines).

3. Place the symbol in your drawing:

· To place the symbol as is, move the cursor to the place in your drawing where you want to insert 
it, and click. 

· If you want to rotate the symbol before you place it, move the cursor to the plane in the drawing 
where you want to insert it and press the left mouse button; while continuing to hold down the 
button, drag the mouse to rotate the symbol. When the symbol is at the angle your want, release 
the mouse button

4. If you want to place another copy of the symbol in your drawing, move your cursor to another location 
and click. To place a different symbol, go to step 1 and follow the directions.



 3D Locus Tool
This tool on the 3D Tools palette places a 3D locus--reference point--in your drawing. Because they have 
no dimensions, you cannot reshape 3D loci.

Note
3D loci are placed more reliably if the Snap To Objects constraint button is active. For more information, 
see the Constraints Palette. 

1. Select the 3D Locus Tool from the 3D Tools palette, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

2. Move the cursor to the place in your in your drawing when you want to add a locus and click--
MiniCAD will place the locus on your working plane if you don't snap it to an object. You can continue 
to add as many loci this way as you want.



 3D Mirror Tool
This tool on the 3D Tools palette has two options. You can use it to change a 3D object into its mirror 
image, or to add a mirror-image copy of an object to your drawing:

Changing an object into its mirror image

Adding a mirror-image copy to your drawing



Changing an object into its mirror image

1.  Select the object you want to change, and then select the 3D Mirror Tool from the 3D 
Tools palette.

2.  Click the Mirror mode button, and move the Selection Arrow into the Drawing Window--you'll 
see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

3. Create a pivot line for the object--press the left mouse button to select a vertex on the working 
plane; while continuing to hold down the mouse button, drag the mouse to draw a line from that point--
visually extending one side of the object--to create your pivot line. Then release the mouse button--
MiniCAD will flip your object, so that it is on the other side of your pivot line.



Adding a mirror-image copy to your drawing

1.  Select the object you want to change, and then select the 3D Mirror Tool on the 3D 
Tools palette.

2.  Click the Mirror and Duplicate mode button, and move the Selection Arrow into the Drawing 
Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

3. Create a pivot line for the object--press the left mouse button to select a vertex on the working 
plane; while continuing to hold down the mouse button, drag the mouse to draw a line from that point--
visually extending one side of the object--to create your pivot line. Then release the mouse button--
MiniCAD will create a duplicate of your object, placing it on the other side of your pivot line.



 3D Rotate Tool
This tool on the 3D Tools palette lets you rotate a 3D object in two modes--you can perform a Standard 
Rotation (rotating along the Working Plane) or an Alignment Rotation (rotating it along the working plane 
and using a defined vector). For both modes, you can rotate a single object, or create a duplicate object 
and rotate it. 

For additional information, see the following topics:

Standard Rotation

Standard Rotate and Duplicate

Alignment Rotation

Alignment Rotate and Duplicate



Standard Rotation

1.  Select the 3D object you want to rotate, and then select the 3D Rotate Tool from the 
3D Tools palette.

2.  

 Now select the Rotate Only mode button and the Standard Rotation mode button.
3. Press the left mouse button on the object you want to rotate; while continuing to hold down the 
mouse button, drag a fulcrum line (a temporary "handle" to rotate your object), and then release the 
button.
4. Use the mouse--without pressing either button--to rotate your object. When you have the rotation 
you want, click the mouse button.



3D Rotate and Duplicate

1.  Select the 3D object you want to duplicate and rotate, and then select the 3D Rotate 
Tool from the 3D Tools palette.

2.  

 Select the Duplicate and Rotate mode button and the Standard Rotation mode button.
3. Press the left mouse button on the object you want to duplicate; while continuing to hold down the
mouse button, drag a fulcrum line (a temporary "handle" to rotate your object) and then release the 
button.
4. Use the mouse--without pressing either button--to rotate the duplicate of your object. When the 
duplicate is where you want it, click the mouse button.



Alignment Rotation

1.  Select the 3D object you want to rotate, and then select the 3D Rotate Tool from the 
3D Tools palette.

2.  

 Now select the Rotate Only mode button and the Alignment Rotation mode button.
3. Press the left mouse button on the edge of the object you want to be the center of rotation; while 
continuing to hold down the mouse button, drag a fulcrum line (a temporary "handle" to rotate your object)
and then release the button.
4. Now drag the cursor to an object, creating the alignment--the imaginary "line" formed by drawing 
a line from your center of rotation to the point on the second object. Then release the mouse button.



Alignment Rotate and Duplicate

1.  Select the 3D object you want to duplicate and rotate, and then select the 3D Rotate 
Tool from the 3D Tools palette.

2.  

 Now select the Duplicate and Rotate mode button and the Alignment Rotation mode button.
3. Press the left mouse button on the edge of the object you want to be the center of rotation; while 
continuing to hold down the mouse button, drag a fulcrum line (a temporary "handle" to rotate your object)
and then release the button.
4. Now drag the cursor to an object, creating the alignment--the imaginary "line" formed by drawing 
a line from your center of rotation to the point on the second object. Then release the mouse button. Use 
the mouse--without pressing either button--to rotate the duplicate of your object. When the duplicate is 
where you want it, click the mouse button.



 Align Plane Tool
One easy way to align two or more objects precisely to each other in 3D space is to align both of them to 
your Working Plane. This lets you move and rotate them relative to each other, all the while maintaining 
their precise alignment. You can align either rendered objects or wireframe objects.

1. Set the Working Plane so that it is aligned to the correct plane on one of your objects. (For directions, 
see the Set Working Plane Tool.)

2. Select the object you want to align with the Working Plane and the first object.

3. Move the cursor to the snap point on the object that you want to align to the Working Plane. Press the
left mouse button; while continuing to hold down the button, drag the cursor to a second snap point on
the Working Pane and release the button. Now click on the third snap point on the Working Plane--
MiniCAD will move and align the object.

4. If you want to align another object, select it and then follow the directions in step 3.



Dimensioning Tool Palette

The Dimensioning Tools palette displays six different tool buttons. However, from these six buttons, you 
can access seven different tools, which will help you easily measure distances, angles, and 2D and 3D 
object dimensions in your drawing, and then add dimensioning lines with the measurements to your 
drawing. 

MiniCAD will use the default preference for dimension type when calculating all dimensions. You can 
choose any of the nine dimension types already listed in the MiniCAD Preferences dialog box, or you can 
create and select a custom type. MiniCAD 7 now offers dual dimensioning--inches and feet plus 
millimeters. In the MiniCAD Preferences dialog box, select either ASME Dual Side by Side or ASME Dual 
Stacked. For information on how to change the default setting for dimension type, see MiniCAD 
Preferences command. 

Important
MiniCAD uses the default preference setting for dimension type.

On the palette, you'll see that one of the tool buttons has an arrowhead in the lower-right corner. When 
you click and hold down the left mouse button on that tool button, a shortcut tool palette will appear. Drag 
the selection arrow to the tool you want to select, and then release the left mouse button. MiniCAD will 
display that tool button in the Dimensioning Tools palette. 

Tool Description

The Unconstrained Linear Dimension tool is used to 
measure and mark linear dimensions of any angle.

The Constrained Linear Dimension tool is used to 
measure and mark vertical and horizontal linear 
dimensions that are constrained to the horizontal and 
vertical axes.

The Circular Dimension tool is used to measure and 
mark the diameter or radius of an arc or circle. 

The Center Mark tool is used to place a center mark in 
a circle, ellipse, rectangle or rounded rectangle.

The Angular Dimension tool is used to measure and 
mark an angle. 

The Tape Measure tool is used to measure the 
distance between points on the drawing. 

The Protractor tool is used to measure the angle 
between points on the drawing.



 Unconstrained-Line Dimensioning Tool
This tool on the Dimensioning Tools palette has three modes, which lets you draw dimension lines at an 
angle. If you want to draw purely horizontal or vertical dimension lines--constrained lines--see the 
Constrained-Line Dimensioning Tool. Along with measuring and marking an object, you can use this tool 
to calculate the distance between two or more points in the Drawing Window. 

    Unconstrained Linear Dimension

    Unconstrained Chain Dimension

    Unconstrained Base-Line Dimension



 Unconstrained Linear Dimension

Use this mode with the Unconstrained-Line Dimensioning tool if you want to create a dimension line with
a single measurement.

1.  

 Select the Unconstrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then 
select the Unconstrained Linear Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor until it reaches the end of the distance you want to 
measure. Then release the mouse button.
3. Now tell MiniCAD where you want it to draw the dimension line and place the measurement--
without pressing the mouse button, drag the cursor away from the line and then click to place the 
dimension line. 



 Unconstrained Chain Dimension
Use this mode with the Unconstrained-Line Dimensioning tool if you want to create a series of connected 
dimension lines, where each line segment displays its specific measurement only.

 

1.  

 Select the Unconstrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then 
select the Unconstrained Chain Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor until it reaches the end of the first segment you want to 
measure. Then release the mouse button.
3. Click once; then drag the mouse--without pressing the button--to the end of the next segment you
want to measure, and click to mark that endpoint.
4. Now drag the mouse to the end of the next segment and click to mark its endpoint.
5. Continue marking segments, using the directions in step 4. 
6. When you reach the end of the entire chained dimension line that you want to create, double-
click.



 Unconstrained Base-Line Dimension
Use this mode with the Unconstrained-Line Dimensioning tool if you want to draw a series of connected 
line segments, where each line segment measures the distance from the initial starting point (the base 
point).

 

1.  

 Select the Unconstrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then 
select the Unconstrained Base-Line Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor until it reaches the end of the first segment you want to 
measure. Then release the mouse button.
3. Now tell MiniCAD where you want it to draw the dimension line and place the measurements--
without pressing the mouse button, drag the cursor away from the line to place the dimension line. 
4. Now drag the mouse to the end of the next segment and click to mark its endpoint.
5. Continue marking segments, using the directions in step 5. 
6. When you reach the end of the entire base-line dimension line that you want to create, double-
click.



 Constrained-Line Dimensioning Tool
This tool on the Dimensioning Tools palette lets you draw dimension lines that are constrained--purely 
horizontal or vertical. If you want to draw dimension lines that are at an angle, see Unconstrained-Line 
Dimensioning Tool. Along with measuring and marking an object, you can use this tool to calculate the 
distance between two or more points in the Drawing Window.

This tool has five modes:

    Constrained Linear Dimension

    Constrained Chain Dimension

    Constrained Base-Line Dimension

    Ordinate Dimension

    Selected Object(s) Dimensions



 Constrained Linear Dimension

Use this mode with the Constrained-Line Dimensioning tool if you want to create a dimension line with a 
single measurement.

1.  

 Select the Constrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then select 
the Constrained Linear Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor until it reaches the end of the distance you want to 
measure. Then release the mouse button.
3. Now tell MiniCAD where you want it to draw the dimension line and place the measurement--
without pressing the mouse button, drag the cursor away from the line and then click to place the 
dimension line. 



Constrained Chain Dimension

Use this mode with the Constrained-Line Dimensioning tool if you want to create a series of connected 
dimension lines, where each line segment displays its specific measurement only.

1.  

 Select the Constrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then select 
the Constrained Chain Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor until it reaches the end of the first segment you want to 
measure. Then release the mouse button.
3. Click once; then drag the mouse--without pressing the button--to the end of the next segment you
want to measure, and click to mark that endpoint.
4. Now drag the mouse to the end of the next segment and click to mark its endpoint.
5. Continue marking segments, using the directions in step 4. 
6. When you reach the end of the entire chained dimension line that you want to create, double-
click.



Constrained Base-Line Dimension

Use this mode with the Constrained-Line Dimensioning tool if you want to draw a series of connected 
line segments, where each line segment measures the distance from the initial starting point (the base 
point).

1.  

 Select the Constrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then select 
the Constrained Base-Line Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor until it reaches the end of the first segment you want to 
measure. Then release the mouse button.
3. Now tell MiniCAD where you want it to draw the dimension line and place the measurements--
without pressing the mouse button, drag the cursor away from the line and then click to place the 
dimension line. 
4. Now drag the mouse to the end of the next segment and click to mark its endpoint.
5. Continue marking segments, using the directions in step 4. 
6. When you reach the end of the entire base-line dimension line that you want to create, double-
click.



Ordinate Dimension

Use this mode with the Constrained-Line Dimensioning tool if you want to measure a series of distances
from one fixed point, where the measurements only--and no dimension lines--are added to your 
drawing. You can use the Ordinate Dimension mode to measure either horizontal or vertical distances.

1.  

 Select the Constrained-Line Dimensioning Tool from the Dimensioning Tools palette, and then select 
the Ordinate Dimension mode button.
2. Press the left mouse button to mark the point you want to start measuring from; while continuing 
to hold down the mouse button, drag the cursor to draw a short line and then release the button.

· To measure vertical ordinates, draw a horizontal line.

· To measure horizontal ordinates, draw a vertical line. 

3. Now drag the mouse--without pressing the left mouse button--in a straight line to the first distance you
want to measure and click. 

4. Continue marking distances by repeating step 3.

5. When you reach the last distance you want to measure, double-click.



Selected Object(s) Dimensions

This Constrained-Line mode lets you measure and mark the horizontal or vertical span of any 2D or 3D 
object--or the edge-to-edge span of a group of objects--in your drawing window. In all cases, the tool will
measure the greatest span.

1. Select the object or objects that you want to dimension.

2.  

 Select the Constrained-Line Dimensioning Tool from the Dimensioning Tools palette, and 
then select the Selected Object(s) Dimension mode button.
3. Click to measure the span you want to dimension:

· If you want to measure the horizontal span and draw the dimension line inside an object (or the 
invisible boundary of a group of objects), click inside the object at the exact point you want the 
dimension line to pass through.

· If you want to measure the horizontal span and draw the dimension line outside an object (or the 
invisible boundary of a group of objects), click above or below the object(s) at the exact point you 
want the dimension line to pass through.

· If you want to measure the vertical span and draw the dimension line inside an object (or the 
invisible boundary of a group of objects), while pressing the control key, click inside the object at 
the exact point you want the dimension line to pass through.

· If you want to measure the vertical span and draw the dimension line outside an object (or the 
invisible boundary of a group of objects), while pressing the control key, click to the left or the right
of the object(s) at the exact point you want the dimension line to pass through.



 Circular Dimensioning Tool
This tool on the Dimensioning Tools palette lets you measure and mark either radius or diameter 
dimensions for arcs and circles. It will not, however, work on ovals or objects with rounded corners--
anything that is not a true circle. For those objects, see either the Unconstrained-Line Dimensioning Tool 
or the Constrained-Line Dimensioning Tool.

In addition, the Circular Dimensioning Tool lets you place the dimension lines and measurements either 
inside or outside of the circle/arc. 

This tool has four modes:

    Diameter Dimensioning Inside Circle/Arc

    Diameter Dimensioning Outside Circle/Arc

    Radius Dimensioning Inside Circle/Arc

    Radius Dimensioning Outside Circle/Arc



 Diameter Dimensioning Inside Circle/Arc

1.  

 Select the Circular Dimensioning Tool from the Dimensioning Tools palette, and then select the 
Interior Diametrical Dimension mode button. 

 
2. Click the circle or arc you want to dimension:

· For filled circles and arcs, move the cursor to the inside of the object--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.

· For unfilled circles and arcs, move the cursor to the object's outline--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.



 Diameter Dimensioning Outside Circle/Arc

1.  

 Select the Circular Dimensioning Tool from the Dimensioning Tools palette, and then select the 
Exterior Diametrical Dimension mode button. 

 
2. Tell MiniCAD what side of the dimension line you want the measurements placed on:

If you want them placed to the right of the line, select this mode button.

If you want them placed to the left of the line, select this mode button.

3. Press the left mouse button on the circle or arc (in the area described below); while continuing to hold
down the mouse button, drag the mouse to draw the dimension line and then release the button.

· For filled circles and arcs, move the cursor to the inside of the object--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.

· For unfilled circles and arcs, move the cursor to the object's outline--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.



 Radius Dimensioning Inside Circle/Arc

1.  

 Select the Circular Dimensioning Tool from the Dimensioning Tools palette, and then select the 
Interior Radial Dimension mode button. 

 
2. Click the circle or arc you want to dimension:

· For filled circles and arcs, move the cursor to the inside of the object--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.

· For unfilled circles and arcs, move the cursor to the object's outline--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.



 Radius Dimensioning Outside Circle/Arc

1.  

 Select the Circular Dimensioning Tool from the Dimensioning Tools palette, and then select
the Exterior Radial Dimension mode button.

 
2. Tell MiniCAD what side of the dimension line you want the measurements placed on:

If you want them placed to the right of the line, select this mode button.

If you want them placed to the left of the line, select this mode button.

3. Press the left mouse button on the circle or arc (in the area described below); while continuing to hold
down the mouse button, drag the mouse to draw the dimension line and then release the button.

· For filled circles and arcs, move the cursor to the inside of the object--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.

· For unfilled circles and arcs, move the cursor to the object's outline--you'll know you are in the 
right area when the cursor looks like crossed "I"s--and click.



 Center Mark Tool
This tool on the Dimensioning Tools palette lets you easily divide a circle, ellipse, rectangle, or rounded 
rectangle into quarters, marking the exact center of the 2D object. In addition, you can use it to locate the 
center mark on any or all of the corners of a rounded rectangle.

This tool has the following modes:

Marking the center of circles, ellipses, rectangles, and rounded rectangles

Marking the center of a rounded rectangle's corner



Marking the center of circles, ellipses, rectangles, and rounded rectangles

1.  Select the Center Mark Tool from the Dimensioning Tools palette.

2. Move the Selection Arrow so that it is on top of the 2D object you want to mark--you'll know you have 
selected an object that the tool works with when the cursor looks like crossed "I"s.

3. Click--MiniCAD will divide the object into quarters, where its center is marked by the intersection of 
the two lines.



Marking the center of a rounded rectangle's corner

1.  Select the Center Mark Tool from the Dimensioning Tools palette.

2. While pressing the control key, move the Selection Arrow so that it is on top of the rounded rectangle 
corner you want to mark. When the cursor looks like crossed "I"s, click--MiniCAD will divide that 
corner into quarters, where its center is marked by the intersection of the two lines.



 Angular Dimension Tool
This tool on the Dimensioning Tools palette allows you to measure and mark angles. You can dimension 
the angle between two objects, between two sides of a single object, or between a single object and a 
reference line. 

This tool works with all 2D objects that have linear sides--rectangles (including rounded and rotated 
ones), lines, polylines, and polygons. It will not, however, work with circles, ellipses, or arcs. In addition, it 
will not work if you try to dimension between parallel lines.

This tool has two modes:

Angle Between Reference Line and Object

Angle Between Two Objects (or Object Sides)



 Angle Between Reference Line and Object

1.  

 Select the Angular Dimension Tool from the Dimensioning Tools palette, and then select the Angle 
Between Reference Line and Object mode button.
2. Press the left mouse button to mark the start of your reference line; while continuing to hold down the 

mouse button, drag the mouse to draw the reference line. When it is the size and direction you want, 
release the mouse button.

3. Your cursor will now be a hand with a pointing finger. Click the fingertip to the side of the object (and, 
therefore, angle) you want to dimension, and click.

4. You'll see that MiniCAD has drawn a temporary angular dimension.

· If it is measuring the angle you want, click to draw your reference line and to set and display the 
dimensioning information.

· If you want to select a different angle--for example one spanning the opposite direction--drag the 
mouse to display the angle you want. Then click to draw your reference line and to set and 
display the dimensioning information. 



 Angle Between Two Objects (or Object Sides)

1.  

 Select the Angular Dimension Tool from the Dimensioning Tools palette, and then select the Angle 
Between Two Objects mode button.
2. Move the Selection Arrow so that it is on top of the first      side of the angle you want to dimension--

when the cursor looks like crossed "I"s.

3. Press the left mouse button to select the side; while continuing to hold down the mouse button, drag 
the mouse to the other angle side and then release it.

4. You'll see that MiniCAD has drawn a temporary angular dimension.

· If it is measuring the angle you want, click to set and display the dimensioning information.

· If you want to select a different angle--for example one spanning the opposite direction--drag the 
mouse to display the angle you want. Then click to set and display the dimensioning information.



 Tape Measure Tool
This tool on the Dimensioning Tools palette lets you measure the distance between two or more points in 
your Drawing Window, temporarily displaying the length in the Data Display Bar. It is especially useful for 
measuring angular distances or for measuring a meandering distance.

1. Select the Tape Measure Tool from the Dimensioning Tools palette, and move the Selection Arrow into
the Drawing Window--you'll see that the standard arrow cursor changes into tiny cross hairs (two 
crossed lines).

2. Click at the point you want to begin measuring from.

3. Now drag the mouse--without pressing the left mouse button--along the distance you want to 
measure. In the Data Display Bar, you'll see two measurement listings, which for the moment will be 
the same:

· After L: MiniCAD lists the length (distance) from the point you just clicked.

· After TL: MiniCAD lists the total length from your starting point. 

4. When you want to continue measuring in a different direction, click to mark a second point--you'll see 
that the measurement after L: changes to "0" (zero).

Important
Be sure to note distances before clicking the mouse, which will clear measurement listings in the Data
Display Bar.

5. Now drag the mouse along the next distance you want to measure. In the Data Display Bar, you'll see
that the two measurement listings are now different. 

6. You can continue to measure a meandering distance by repeating the directions for steps 4 and 5.

7. When you are done measuring, note the total length and then double-click--once you double-click, 
MiniCAD will clear the measurements in the Data Display Bar.



 Protractor Tool
This tool on the Dimensioning Tools palette lets you measure angles in your drawing, temporarily 
displaying the degree measurement in the Data Display Bar. One mode lets you measure an angle 
between three points in your Drawing Window. 

The other mode lets you calculate the angle between two objects or object sides that are linear--
rectangles (including rounded and rotated ones), lines, polylines, and polygons. It will not, however, work 
with circles, ellipses, or arcs. In addition, it will not work if you try to dimension between parallel lines.

This tool has two modes:

Angles Between Objects or Object Sides

Angles Between Three Points



 Angles Between Objects or Object Sides

1.  

 Select the Protractor Tool from the Dimensioning Tools palette, and then select the Two Segments 
mode button.
2. Move the Selection Arrow so that it is on top of the first      side of the angle you want to measure--

you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).

3. Press the left mouse button to select the side; while continuing to hold down the mouse button, drag 
the mouse to the other angle side--you'll see the angle listed in the Data Display Bar above the mode 
button.

4. Note the angle and then release the mouse button--once you release it, MiniCAD will clear the 
measurement in the Data Display Bar.



 Angles Between Three Points

1.  

 Select the Protractor Tool from the Dimensioning Tools palette, and then select the Three Points 
mode button--you'll see that the standard arrow cursor changes into tiny cross hairs (two crossed lines).
2. Press the left mouse button to mark the first point; while continuing to hold down the mouse button, 

drag the mouse to the intersection point, and then release the mouse button.

3. Now drag the mouse--without pressing the left mouse button--to the third angle point.

4. Note the angle and then release the mouse button--once you release it, MiniCAD will clear the 
measurement in the Data Display Bar.



Attributes Palette

The Attributes palette helps you make changes to the graphic look of objects in your MiniCAD drawings, 
or to determine which graphic characteristics have already been applied. In MiniCAD 7, the Attributes 
palette has been redesigned so that it is even easier to use. 

On it, you'll find shortcut menus for these Fill options:

· color, and

· pattern (also including solids).

On it, you'll find shortcut menus for these Pen options:

· color,

· pattern (including solids),

· line thickness, 

· line style, and 

· line end markers (arrowheads, for example).

You can use the Attributes palette with all 2D and 3D MiniCAD objects with one exception--text. The only 
text characteristic you can change with the Attributes palette is color. All other text attributes are controlled
by individual menu commands, all of which are listed under the Text menu item. For more information, 
see Menu Commands.

If you need to change an attribute setting for an individual object, be sure to first select the object and 
then make the change in the Attributes palette. For more information, see How do I change an object's 
attributes?. 

For changing an object's fill and pen attributes using the Object Info palette, see the Fill Attribute and the 
Pen Attribute.



Fill Attribute

In MiniCAD, you can use the Attributes palette to set your default so that all new objects are filled with 
either a solid color, a hatch, or a combination of color and pattern. You also can set the object fill default to
"none" if you want to create transparent objects with no fill pattern.

Note
You can import color palettes from other programs or edit the palettes already in the program. See the 
Edit Attributes command.

Depending on the number of colors supported by your monitor, you can pick fill colors from a palette of up
to 256 colors. (MiniCAD's Color Palette will automatically display as many colors as your monitor can 
handle.) Currently, MiniCAD lets you pick from 64 available fill patterns. 

For additional information, see the following topics:

How do I make a solid color my default fill?

How do I make a pattern my default fill?

How do I make a hatch my default fill?

How do I set my default fill to create transparent objects?



How do I make a solid color my default fill?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select Solid from the Fill pop-up menu.

4. From the Color pop-up menu, select the new color--MiniCAD will now use that fill color for all new
objects you create. 



How do I make a pattern my default fill?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select Pattern from the Fill pop-up menu--you'll see that the attribute palette now has one pattern 
pop-up menu and two color pop-up menus.

4. Select the new fill pattern from the Pattern pop-up menu.
5. Select the new foreground fill color from the top color pop-up menu.
6. Select the new background fill color from the bottom color pop-up menu----MiniCAD will now use 
that fill pattern for all new objects you create. 



How do I make a hatch my default fill?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select Hatch from the Fill pop-up menu.

4. From the Hatch pop-up menu, select the new hatch----MiniCAD will now use that hatch for all new
objects you create. 



How do I set my default fill to create transparent objects?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select None from the Fill pop-up menu----all new objects you create will be transparent, with no fill 
pattern. 



Pen Attribute

Using the Pen pop-up menu on the Attribute palette, you can set your default so that all new objects are 
outlined in a solid, dashed, or pattern line of any thickness. And, depending on the number of colors 
supported by your monitor, you can pick pen colors from a palette of up to 256 colors. (MiniCAD 's Color 
Palette will automatically display as many colors as your monitor can handle.)

Note
In MiniCAD, you can import color palettes from other programs or edit the palettes already in the program.
See Edit Attributes command.

For additional information, see the following topics:

How do I make a solid line my default pen?

How do I make a dashed line my default pen?

How do I make a patterned line my default pen?

How do I change the default thickness for all types of lines?

How do I add line end markers (such as arrowheads) to my default lines?



How do I make a solid line my default pen?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select Solid from the Pen pop-up menu.

4. From the Color pop-up menu, select the new color--MiniCAD will now draw all new objects with a 
line that size and color line. 



How do I make a dashed line my default pen?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select Dashed from the Pen pop-up menu.

4. From the Line Style menu, select the new dash pattern.
5. From the Color pop-up menu, select the new color--MiniCAD will now draw all new objects with a 
dashed line in the color you selected. 



How do I make a patterned line my default pen?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  Select Pattern from the Pen pop-up menu--you'll see that the attribute palette now has one pattern 
pop-up menu and two color pop-up menus.

4. Select the new line pattern from the Pattern pop-up menu.
5. Select the new foreground pen color from the top color pop-up menu.
6. Select the new background pen color from the bottom color pop-up menu--MiniCAD will now draw
all new objects using that line pattern and color.



How do I change the default thickness for all types of lines?
1. Make sure no objects are selected in the Drawing Window.

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3. In the Line pop-up menu, either 

· Select one of the preset line weights.

· Or, if you want to specify a line weight, select Set Thickness… Then, in the dialog box that 
appears, select the measurement system you want to use--Points, Mils, or mm--type the 
thickness you want after Line Thickness: and click OK.

Note
You cannot select the "add measurements in the center of each line" (--xx--). setting as the 
default setting. For this setting, you must first draw a line, and then change its setting.



How do I add line end markers (such as arrowheads) to my default lines?
1. Make sure no objects are selected in the Drawing Window. 

2. If it isn't already displayed, open the Attributes palette--on the Window menu, choose Attributes.

3.  In the Line End Marker pop-up menu:

· Select one of the preset line end markers.

· Or, if you want to specify a different weight or size of end marker, select Edit… Then, in the dialog
box that appears, select the endmarker you want to use from the pop-up menu; and then type the
Angle: and Length: you want to use. Then click OK.

4. Now tell MiniCAD if you want the endmarkers to appear on one end, or both ends, of all new lines:

 If you want a line marker only at the start of all lines you draw, click the left-hand box
 If you want a line marker only at the end of all lines you draw, click the right-hand box

 If you want line markers at both ends, click both the left-hand and the right-hand box



Constraints Palette

The Constraints palette helps you precisely draw, move, or reshape objects. These buttons change the 
cues that the SmartCursor gives you while you draw and move objects (see SmartCursor Screen 
Messages). In addition, now MiniCAD has three different types of sound clues. Whenever your nears an 
object snap point or an intersection between objects/vectors, you will hear one of these snap sounds. (For
more information, see the SmartCursor.) 

To activate the tools on the Constraints palette, you can select a button before drawing, moving, or 
reshaping an object.

MiniCAD customizes the Constraints palette to display either 2D or 3D tools, matching the drawing mode 
you are using:
2D Constraints 3D Constraints



2D Constraints

You can select from eight different constraints settings on the Constraints palette when you are working 
with 2D Tools. Depending on your need, you can use more than one of these tools at a time.

Tool Description

The Snap to Grid (2D) tool causes the cursor to align 
on the snap grid.

The Snap to Object (2D) tool causes objects to align 
on an object's "snap points.".

The Constrain Angle (2D) tool constrains vectors to 
30°, 45° and 90°.

The Snap to Intersection tool causes the cursor to 
snap to the intersection of objects.

The Snap Points tool is used to specify the snap 
points that you want the SmartCursor to identify.

The Snap to Distance (2D) tool snaps the cursor at a
specified distance from a vector.

The Snap to Edge is used to specify edge snap 
points.

The Constrain Tangent tool constrains lines to be 
tangent to or from arcs, ovals, and circles.

 Snap To Grid (2D)
When you select the Snap to Grid button on your Constraints palette, you turn on your Snap Grid. For 
example, if the grid is set at 1", when you slowly drag your mouse, it will automatically "catch" every inch. 
And if you dragged an object, it would automatically move an inch at a time. 

Hint
If you double-click this button, the Set Grid dialog box will appear.



 Snap To Object (2D)
When you select this button on your Constraints palette, the SmartCursor gives you screen hints, showing
when and where the object you are drawing or moving touches another object. 



 Constrain Angle (2D)
When you select this button on your Constraints palette, the SmartCursor tells you when you are drawing 
30º, 60º, and 45º angles. In addition, MiniCAD allows you to specify one other angle. To set this other 
angle, double-click this button. In the dialog box that appears you can either type the new angle you want 
to use in the textbox after Enter Angle: or you can select Next Mouse Drag (and then use the mouse to 
specify the additional angle). In the Angle Snaps dialog box, you can also select the Extension Lines 
checkbox if you want to use these to see the angle your cursor is from other objects.



 Snap To Intersection (2D)
When you select this button on your Constraints palette, the SmartCursor tells you when the object you 
are creating intersects another object in your drawing.



 Snap Points (2D)
You can use this button on your Constraints palette to specify the snap points that you want the 
SmartCursor to identify. To set these points, double-click this button. In the dialog box that appears, select
the snap points you want to use. 

· Select the Horizontal/Vertical Extensions checkbox if you want extension lines that tell you when your 
object horizontally or vertically aligns with a nearby snap point. 

· Select the Extension Lines checkbox if you want extension lines that tell you when your object is 
aligned at a particular angle with a nearby snap point. 

· To activate the Floating Datum, select this checkbox.

· To use a Datum Offset, select this checkbox and type an offset value in the textbox.



 Snap To Distance (2D)
You can use this button on your Constraints palette to specify the snapping distance you want to use. To 
set a distance, double-click this button. In the dialog box that appears, you can set the distance using 
either a Fraction, Percent, or Distance. In addition, select the Multiple Divisions checkbox if you want the 
SmartCursor to repeat snap points on a line.



 Snap To Edge (2D)
You can use this button on your Constraints palette to specify edge snap points. To do so, double-click 
this button. In the dialog box that appears, you can select the following checkboxes: Use 2nd Vector, Use 
Floating Edge, Snap to Vector, and Snap to Extension Lines. In addition, you can select the Snap to 
Offset checkbox and type the offset distance you want to use.



 Constrain Tangent (2D)
When you select this button on your Constraints palette, MiniCAD automatically constrains lines you draw
so that they are tangent to or from arcs, ovals, and circles. In addition, MiniCAD also allows tangent-to-
tangent constrains between two circles. 



3D Constraints

You can select from eight different constraints settings on your Constraints palette when you are working 
with 3D Tools. Depending on your need, you can use more than one of these tools at a time.

Tool Description

The Snap to Grid (3D) tool constrains objects on the 
working plane.

The Snap to Object (3D) tool makes the snap points 
at 3D vertices active.

The Constrain Angle (3D) tool constrains angles to 
30°, 45° and 90° in current working plane space

The Snap to Intersection) tool causes the cursor to 
snap to the intersection of objects.

The Snap Points tool is used to specify the snap 
points that you want the SmartCursor to identify.

The Snap to Distance (3D) tool lets you to snap to a 
specified distance from either end of any 3D vector.

The Constrain to the Working Plane tool projects 
any point outside the working plane to the working 
plane.

The Constrain Perpendicular (3D) tool is used to 
snap objects perpendicular to the working plane. 

 Snap To Grid (3D)
When you select the Snap to Grid button on your Constraints palette, you turn on your Snap Grid. For 
example, if the grid is set at 1", when you slowly drag your mouse, it will automatically "catch" every inch. 
And if you dragged an object, it would automatically move an inch at a time. 

Hint
If you double-click this button, the Set Grid dialog box will appear. 



 Snap To Object (3D)
When you select this button on your Constraints palette, the SmartCursor gives you screen hints, showing
when and where the object you are drawing or moving touches another object. 



 Constrain Angle (3D)
When you select this button on your Constraints palette, the SmartCursor tells you when you are drawing 
30º, 60º, and 45º angles. In addition, MiniCAD allows you to specify one other angle. To set this other 
angle, double-click this button. In the dialog box that appears you can either type the new angle you want 
to use in the textbox after Enter Angle: or you can select Next Mouse Drag (and then use the mouse to 
specify the additional angle). In the Angle Snaps dialog box, you can also select the Extension Lines 
checkbox if you want to use these to see the angle your cursor is from other objects.



 Snap To Intersection (3D)
When you select this button on your Constraints palette, the SmartCursor tells you when the object you 
are creating intersects another object in your drawing.



 Snap Points (3D)
You can use this button on your Constraints palette to specify the snap points that you want the 
SmartCursor to identify. To set these points, double-click this button. In the dialog box that appears, select
the snap points you want to use. 

· Select the Horizontal/Vertical Extensions checkbox if you want extension lines that tell you when your 
object horizontally or vertically aligns with a nearby snap point. 

· Select the Extension Lines checkbox if you want extension lines that tell you when your object is 
aligned at a particular angle with a nearby snap point. 

· To activate the Floating Datum, select this checkbox.

· To use a Datum Offset, select this checkbox and type an offset value in the textbox.



 Snap To Distance (3D)
You can use this button on your Constraints palette to specify the snapping distance you want to use. To 
set a distance, double-click this button. In the dialog box that appears, you can set the distance using 
either a Fraction, Percent, or Distance. In addition, select the Multiple Divisions checkbox if you want the 
SmartCursor to repeat snap points on a line.



 Constrain Working Plane
When you select this button on your Constraints palette, MiniCAD automatically projects any point outside
the Working Plane to its shadow point on the plane. The point specified will then be the shadow point 
located on the Working Plane.



 Constrain Perpendicular
When you select this button on your Constraints palette, MiniCAD automatically draws all objects so that 
they are perpendicular to the Working Plane. 



SmartCursor Screen Messages

Depending on the constraints you have set, the type of objects you are working with, and the action you 
are performing, MiniCAD's SmartCursor will give you targeted screen messages to help you draw quickly 
and precisely. Here are the more than 50 screen messages that the SmartCursor uses.

· Surface

· Object

· Tangent

· Angle

· Top Center

· Bottom Center

· Center Right

· Center Left

· Top Right

· Bottom Right

· Bottom Left

· Top Left

· Center

· Point

· Arc End

· Along Line

· Locus

· Datum

· Tangent/Tangent

· Tangent/Angle

· Corner

· Bézier

· Fit

· Arc

· 3D Locus

· Horizontal

· Vertical

· I

· J

· 45º

· 30º

· Parallel

· Perpendicular



· D45º

· D30º

· Edge

· Edge 90º

· Alt

· Alt 90º

· Length

· Distance

· Offset

· Align H

· Align V

· Align

· Align I

· Align J

· Align K

· Align Alt

· Align Alt 90º

· Align Edge

· Align Edge 90º

· Bisector

· Light

· Aim

· Pan

· Tilt

· Intersection



Object Info Palette

The Object Info palette gives you a range of information about the 2D and 3D objects in your MiniCAD 
drawings. In addition, you can use the palette to make changes to those objects. Within the Object Info 
palette, there are two different panes you can select:

· The Shape Pane. When you select this pane, the Object Info palette will show you information about 
a selected object's physical size, class, and location.

· The Data Pane. When you select this pane, the Object Info palette will show you a listing of database
records, if any, that are attached to a selected object. 

Only one pane can display at a time. However, you can easily change which pane displays--click the 
name tab (at the bottom of the palette) for the pane you want to see. In addition to being able to move the
Object Info palette around your Drawing Window like all other MiniCAD palettes, you also can change its 
size and shape--select a corner of the palette, then while pressing the left mouse button, drag the mouse 
to reshape the palette.

There is one important thing you need to remember when working with the Object Info palette: No matter 
which pane you select, the palette can display information only about selected objects in your drawing.



Shape Pane

When you select this pane in the Object Info palette, MiniCAD will give you detailed information about a 
selected object, including its size, location, class, and layer. In addition, depending on the type of object 
you have selected, there are many other information settings that will display--such as area, perimeter, 
and Z height.

You can also use the Object Info palette to make changes to most of these information settings. The only 
time you can't change a setting is when it is printed directly on the palette. Any information that is 
displayed in a pop-up menu or a textbox can be changed. 

Following are step-by-step directions for using the Shape Pane of the Object Info palette to view and to 
change object details. 

How do I view object details with the Object Info palette?

How do I change objects with the Object Info palette?

For Arcs, what information displays and can be changed in the Shape Pane?

For Bitmaps, what information displays and can be changed in the Shape Pane?

For Dimension Lines, what information displays and can be changed in the Shape Pane?

For Groups, what information displays and can be changed in the Shape Pane?

For Lines, what information displays and can be changed in the Shape Pane?

For a Light, what information displays and can be changed in the Shape pane?

For a 2D Locus, what information displays and can be changed in the Shape Pane?

For a 3D Locus, what information displays and can be changed in the Shape Pane?

For a Mesh, what information displays and can be changed in the Shape Pane?

For Ovals, what information displays and can be changed in the Shape Pane?

For a 2D Polygon, what information displays and can be changed in the Shape Pane?

For a 3D Polygon, what information displays and can be changed in the Shape Pane?

For a Polyline, what information displays and can be changed in the Shape Pane?

For Rectangles, what information displays and can be changed in the Shape Pane?



For Rounded Rectangles, what information displays and can be changed in the Shape Pane?

For a Symbol, what information displays and can be changed in the Shape Pane?



How do I view object details with the Object Info palette?
1. If it isn't already displayed, open the Object Info Palette--on the Window menu, choose Object Info. 

Then click the Shape tab to select the Shape Pane.

Note
If a selection button is "grayed," you have reached the end of the selection of objects. For example, a 
grayed right selection button means that you have moved forward through all the selected objects and
now must move backward, using the left selection button.

2. Select the object or objects in your Drawing Window that you want to see information for.

· If you select a single object, the Object Info palette will automatically display details for that 
object.

· If you select more than one object, keep in mind that the Object Info palette can display details for
only one object at a time. Use the right selection button to move forward through your selected 
objects. You then can move backward one object at a time by using the left selection button.



How do I change objects with the Object Info palette?
1. If it isn't already displayed, open the Object Info Palette--on the Window menu, choose Object Info.

Note
If a selection button is "grayed," you have reached the end of the selection of objects. For example, a 
grayed right selection button means that you have moved forward through all the objects and now 
must move backward, using the left selection button.

2. Select the object or objects in your Drawing Window that you want to change.

· If you select a single object, the Object Info palette will automatically display details for that 
object.

· If you select more than one object, keep in mind that the Object Info palette can display details for
only one object at a time. Use the right selection button to move forward through your selected 
objects. You then can move backward one object at a time by using the left selection button.

3. To change object information that appears in a pop-up menu (such as Class: or Layer:), on the pop-
up menu, choose the new information. (You can only choose from existing classes or layers in the 
Object Info palette. To create new ones, see the Classes command.)

4. To change an object's location in the Drawing Window:

· First click the selection handle you want to use to move the object in the Alignment Matrix.

· Then delete the coordinate information in the textbox after X: and/or Y: 

· Now type the new coordinate information in the empty textbox. 

· You must either click the mouse in another textbox or press the ENTER key or the TAB key to tell 
MiniCAD to change the object using your new information.

5. To change other information that appears in a textbox:

· First delete the information in the textbox after the object information that you want to change.

· Now type the new information in that empty textbox. 

· You must either click the mouse in another textbox or press the ENTER key to tell MiniCAD to 
change the object using your new information.



For Arcs, what information displays and can be changed in the Shape Pane?

When you have an arc selected, you will see information about the arc's Area and Perimeter in the Shape
Pane. In addition to Class: and Layer:, you will see the following information, which you can also change: 

· X coordinate for the center, Ctr X: 

· Y coordinate for the center, Ctr Y:

· Radius:

· Diameter, Dia.:

· Start Angle, Start:

· Sweep Angle, Sweep:

· End Angle, End:



For Bitmaps, what information displays and can be changed in the Shape Pane?

When you have a bitmap selected, you will see the following information (in addition to Class: and Layer:) 
in the Shape Pane, which you can also change: 

· Width of bitmap, ±X 

· Length of bitmap, ±Y

· X coordinate for selection handle picked, X:

· Y coordinate for selection handle picked, Y:



For Dimension Lines, what information displays and can be changed in the Shape
Pane?

When you have a dimension line selected, you will see the following information (in addition to Class: and 
Layer:) in the Shape Pane, which you can also change.

Note
If you have more than one dimension line selected, any change you make in the Shape Pane will affect all
of them.

· Dimension Standard, Dim Std:

· Witness (starting, ending, or both)

· Arrows Inside (checkbox to select)

· Interior Arc or Leader to Left (checkbox to select)

· Text (includes rotation, offset above dimension line, and auto position)

· Prim/Sec (secondary only available with dual dimension)

· Prec: (precision)

· Show Dimension Value (checkbox to select)

· Leader: (for primary and secondary)

· Trailer: (for primary and secondary)

· Dimension Tolerance, Tol:



For Groups, what information displays and can be changed in the Shape Pane?

When you have a MiniCAD Group selected (created with the Group Command), you will see the following
information (in addition to Class: and Layer:) in the Shape Pane, which you can also change.

· Width of the group, ±X 

· Length of the group, ±Y

· X coordinate for selection handle picked, X:

· Y coordinate for selection handle picked, Y:

Note 
To change individual objects in a group, you must first select the Enter Group command or the Ungroup 
command.



For Lines, what information displays and can be changed in the Shape Pane?

When you have a line selected, you will see the following information (in addition to Class: and Layer:) in 
the Shape Pane, which you can also change: 

· X coordinate for selection handle picked, X:

· Y coordinate for selection handle picked, Y:

When the Cartesian Coordinates button is selected

· Width of line, ±X 

· Length of line, ±Y

When the Polar Coordinates button is selected

· Length of line, L:

· Angle of line, A:



For a Light, what information displays and can be changed in the Shape pane?

When you have a light selected, you will see the following information (in addition to Class: and Layer:) in 
the Shape Pane, which you can also change: 

· On or Off choices for the light; 

· Brightness: setting

· Color: setting

· Checkbox for Cast Shadows

· X, Y, Z or I, J, K coordinates for light

· Kind: of light

· DX, DY, DZ or Azim: and Elev:



For a 2D Locus, what information displays and can be changed in the Shape 
Pane?

When you have a 2D locus selected, you will see the following information (in addition to Class: and 
Layer:) in the Shape Pane, which you can also change: 

· X coordinate, X:
· Y coordinate, Y:



For a 3D Locus, what information displays and can be changed in the Shape 
Pane?

When you have a 3D locus selected, you will see the following information (in addition to Class: and 
Layer:) in the Shape Pane, which you can also change: 

 When the Ground Plane button is selected
· X coordinate, X:
· Y coordinate, Y:

· Z coordinate, Z:

 When the Working Plane button is selected
· I coordinate, I:
· J coordinate, J:
· K coordinate, K:



For a Mesh, what information displays and can be changed in the Shape Pane?

When you have a mesh selected, you will see the following information (in addition to Class: and Layer:) 
in the Shape Pane, which you can also change: 

· A single vertex or a group of selected vertices:

· In the Edit: pop-up menu, select either Vertex Only or Selected Vertices.

· Then, use the selection buttons after Vertex: to pick your vertex or vertices. 

When the Ground Plane button is selected

· The X coordinate for the selected vertex/vertices, X:
· The Y coordinate for the selected vertex/vertices, Y:
· The Z coordinate for the selected vertex/vertices, Z:
When the Working Plane button is selected

· The I coordinate for the selected vertex/vertices, I:
· The J coordinate for the selected vertex/vertices, J:
· The K coordinate for the selected vertex/vertices, K:



For Ovals, what information displays and can be changed in the Shape Pane?

When you have an oval selected, you will see information about the oval's Area and Perimeter in the 
Shape Pane. In addition to Class: and Layer:, you will see the following information, which you can also 
change: 

·  Width of oval, ±X 

· Length of oval, ±Y
· X coordinate for selection handle picked, X:
· Y coordinate for selection handle picked, Y:



For a 2D Polygon, what information displays and can be changed in the Shape 
Pane?

When you have a 2D polygon selected, you will see information about the polygon's Area and Perimeter 
in the Shape Pane. In addition to Class: and Layer:, you will see the following information, which you can 
also change: 

Note 
In single vertex mode, only that vertex will be changed. However, in entire object mode, all the vertices 
will be changed.

·  Width of polygon, ±X 

· Length of polygon, ±Y
· X coordinate for selection handle picked, X:
· Y coordinate for selection handle picked, Y:
· A single vertex or the entire object:

· In the Edit: pop-up menu, select either Vertex Only or Entire Object.

· If you selected Vertex Only, use the selection buttons after Vertex: to pick the vertex.

· The X coordinate for the object/vertex, X:
· The Y coordinate for the object/vertex, Y:

You can add a vertex each time you click this mode button.

You can delete a vertex each time you click this mode button.

You can hide the polygon's edge by clicking this mode button.

You can show the hidden edge by then clicking this mode button.



For a 3D Polygon, what information displays and can be changed in the Shape 
Pane?

When you have a 3D polygon selected, you will see the following information (in addition to Class: and 
Layer:) in the Shape Pane, which you can also change: 

· A single vertex or the entire object:

· In the Edit: pop-up menu, select either Vertex Only or Entire Object.

· If you selected Vertex Only, use the selection buttons after Vertex: to pick the vertex.

When the Ground Plane button is selected

· The X coordinate for the object/vertex, X:
· The Y coordinate for the object/vertex, Y:
· The Z coordinate for the object/vertex, Z:

When the Working Plane button is selected

· The I coordinate for the object/vertex, I:
· The J coordinate for the object/vertex, J:
· The K coordinate for the object/vertex, K:

You can add a vertex each time you click this mode button.

You can delete a vertex each time you click this mode button.

You can hide the polygon's edge by clicking this mode button.

You can show the hidden edge by then clicking this mode button.



For a Polyline, what information displays and can be changed in the Shape Pane?

When you have a polyline selected, you will see information about its Area and Perimeter in the Shape 
Pane. In addition to Class: and Layer:, you will see the following information, which you can also change: 

Note 
In single vertex mode, only that vertex will be changed. However, in entire object mode, all the vertices 
will be changed.

·  Width of polyline, ±X 

· Length of polyline, ±Y
· X coordinate for selection handle picked, X:
· Y coordinate for selection handle picked, Y:
· A single vertex or the entire object:

· In the Edit: pop-up menu, select either Vertex Only or Entire Object.

· If you selected Vertex Only, use the selection buttons after Vertex: to pick the vertex.

· The X coordinate for the object/vertex, X:
· The Y coordinate for the object/vertex, Y:

You can change the selected vertex (or the selected object's vertexes) into Corner vertex by clicking this 
mode button.

You can change the selected vertex (or the selected object's vertexes) into Bézier vertex by clicking this 
mode button.

You can change the selected vertex (or the selected object's vertexes) into Cubic vertex by clicking this 
mode button .

You can change the selected vertex (or the selected object's vertexes) into an Arc vertex by clicking this 
mode button.

You can add a vertex each time you click this mode button.

You can delete a vertex each time you click this mode button.

You can hide the polyline's edge by clicking this mode button.

You can show the hidden edge by then clicking this mode button.



For Rectangles, what information displays and can be changed in the Shape 
Pane?

When you have a rectangle selected, you will see information about the rectangle's Area and Perimeter in
the Shape Pane. In addition to Class: and Layer:, you will see the following information, which you can 
also change: 

·  Width of rectangle, ±X 
· Length of rectangle, ±Y
· X coordinate for selection handle picked, X:
· Y coordinate for selection handle picked, Y:



For Rounded Rectangles, what information displays and can be changed in the 
Shape Pane?

When you have a rounded rectangle selected, you will see information about its Area and Perimeter in the
Shape Pane. In addition to Class: and Layer:, you will see the following information, which you can also 
change: 

· Width of rounded rectangle, ±X 

· Length of rounded rectangle, ±Y
· X coordinate for selection handle picked, X:
· Y coordinate for selection handle picked, Y:
· Diameter for X, Diam X:
· Diameter for Y, Diam Y:



For a Symbol, what information displays and can be changed in the Shape Pane?

When you have a symbol selected, the symbol's name will display at the bottom of the Object Info Data 
Pane. You will see the following information (in addition to Class: and Layer:), which you can also change:

· X coordinate for the center of the symbol, X:
· Y coordinate for the center of the symbol, Y:
· Z coordinate for the base of the symbol, Z:
· The rotation angle of the symbol, Rot:



Data Pane

When you select this pane in the Object Info palette, MiniCAD will give you a listing of any records 
attached to the object or objects that you have selected along with detailed information about the 
information that is attached to that record. You can also use the Object Info palette to make changes to 
record settings. However, if the objects you have selected have different records attached to them, the 
Data Pane will list all the records attached to your selected objects, but you will not be able to tell exactly 
which records are attached to which objects.

For additional information, see the following topics:

How do I view record details with the Object Info palette?

How do I change record details with the Object Info palette?



How do I view record details with the Object Info palette?
1. If it isn't already displayed, open the Object Info Palette--on the Window menu, choose Object Info. 

Then click the Shape tab to select the Data Pane.

2. Select the object in your Drawing Window that you want to see information for.

Note 
You can resize the three list textboxes by selecting and dragging the bars between them.

3. The following information will display in the Data Pane of the Object Info palette:

· Object Name. This box shows the name, if any, you have given to an object. If no name is 
assigned to the object, a grayed "*DEFAULTS*" will display here.

· Record List. This box displays all the records that are active in your drawing. If any of these 
records are attached to your selected object, the box to the left of the record name will have an 
"X".

· Field List. If a record is attached to your selected object, you will see a listing of all the record 
fields in this box. If any field has a default value assigned, it will appear after the field name.      

Important 
If you have more than one object selected, only the records attached to all objects will have an X. 
All others will be "grayed."



How do I change record details with the Object Info palette?
1. If it isn't already displayed, open the Object Info Palette--on the Window menu, choose Object Info. 

Then click the Shape tab to select the Data Pane.

2. Select the object in your Drawing Window that you want to change.

3. The top textbox (the Object Name textbox) shows the name, if any, you have given to an object. 

· If no name is listed, you can name the object by typing the name you want to assign in the 
textbox. 

· If a name is listed and you want to change it, first delete the existing name. Then type the new 
name in the textbox.

4. The second textbox (the Record List textbox) displays all the records that are active in your drawing. 
If any of these records are attached to your selected object, the box to the left of the record name will 
have an "X".

· If you want to attach a record to the selected object, click the empty box to the left of the record 
name--it will fill with an "X," meaning that the record has been assigned to the selected object.

· If you want to detach a record to the selected object, click the box with the "X" to the left of the 
record name. In the dialog box that appears, click OK--this will only detach the record from the 
selected object; it will not delete the record from your drawing file or detach it from any other 
objects that are not selected.

Note 
If you want to delete a record from your drawing file, you need to do that in the Resources palette.

5. The third text box (the Field List textbox) lists the fields that are assigned to each record. If you have 
more than one record assigned to the selected object--or more than one record in your drawing file--
you can display the fields for any one record by selecting it in the Record List box.

6. The fourth box (the Edit Field text box) lists the individual or default values, if any, assigned to each 
field. To review or change the information, 

· First select the field in the Field List textbox.

· Any value assigned to that field for the selected object will display in the Edit Field box.

· To add or change field information:

· If no information is listed, type the information you want to assign in the textbox. 

· If information is listed and you want to change it, first delete the existing information. Then 
type the new information in the textbox.



Resources Palette

This palette makes it easy for you to find, import/open, and edit resources in other MiniCAD files and then
use them in your current drawing file--all without leaving your Drawing Window. Whenever you create any
of the following resources in a drawing file, MiniCAD automatically "catalogs" the resource so you can use
it whenever you need it in any MiniCAD file, including the one you created the resource in. These 
MiniCAD resources include:

· Symbols 
· Worksheets 

· Macro Commands
· Hatch Patterns
· Record Formats 

· Other MiniCAD Files
· Stationery Pads 

In addition to any of these resources that you create, you can also use the Resources palette to access 
the thousands of already created resources that come with MiniCAD's exclusive Design and Drafting 
Toolkit. For an unabridged listing of these toolkit resources, see the MiniCAD Toolkit Manual.

There is one other type of resource you can access with the Resources palette--MiniPascal macros. 
These separate text files can be created by using the built-in MiniPascal programming language that 
ships with MiniCAD. For information on creating and using these macros, see the MiniCAD MiniPascal 
Manual.

For additional information, see the following topics:

Working with the Resources Palette

Locating a Resource

Working with Symbol Resources

Working with Macro Command Resources



Working with Worksheet Resources

Working with Hatch Resources

Working with Record Format Resources



Working with the Resources Palette

The Resources palette appears the first time you launch MiniCAD. From that point forward, MiniCAD 
remembers the position and state of the palette the last time you closed the program, using it when you 
next launch the program. However, you can show or hide the palette at any time--on the Window menu, 
choose Resources. 

In addition to being able to move the Object Info palette around your Drawing Window like all other 
MiniCAD palettes, you also can change its size and shape--select a corner of the palette, then while 
pressing the left mouse button, drag the mouse to reshape the palette.

The one thing you need to keep in mind about the Resources palette is that the command buttons that 
run down its right side change according to the type of resource you are working with and its location. For 
example, if you are using the palette to add a symbol stored from a different file, the top button will say 
Import; but if the symbol is already part of the file you are working in, the top button will say Edit instead. 

Other than these interactive command buttons, though, the rest of the Resources palette will always have
the same items:

· Shortcut menu. When you click this menu, you will see a listing of file directories and/or files. There 
are two ways you can open them. You can either double-click on the directory/file name or click the 
Enter button. 

Note
If you have selected a file without any resources in the shortcut menu, the scroll box will be empty. 

· Scroll box. Inside this box, you'll see a listing of what is inside the directory or the file that you have 
selected in the shortcut menu. Depending on what's selected, that list may have file names and/or 
resources. 

To the right of all resource names in the scroll box, you will see an icon, identifying the resource type. 
Here is what each one means:

· Screen buttons. The five buttons that run along the bottom of the scroll box are designed to help you
limit the types of resources that display in the scroll box. When you click one of them, a large, red "X" 
will cover the button. This tells MiniCAD to screen out that resource type, not listing it in the scroll box.
The icons on each button match those used to identify resources in the scroll box.

    Symbols

    Worksheets

    Macro Commands Folder

    Hatch Patterns

    Record Formats



Locating a Resource

The command buttons, which run down the right side of the Resources palette, change according to the 
type of resource you have selected. In addition, many of the directions for creating or editing resources 
are also resource specific. 

The only command button that works the same for all resources is Find, which helps you locate where 
exactly a particular MiniCAD resource is stored.

1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click Find... and the Find Resource dialog box will appear.

3. Tell MiniCAD where you want to search for the file (what file directory). 

· Click .Browse...

· In the dialog box that appears, select the file directory that you want to search.

· Click OK.

4. In the Find Resource dialog box, type the name of the resource you want MiniCAD to search for in the
text box after Name: and then click OK.



Working with Symbol Resources

With the Resources palette, you can select symbols that you can insert using the Symbol Insertion Tool or
the 3D Symbol Insertion Tool. You also can edit a symbol, create a new folder to store symbols in, 
rename, delete, or move symbols within your drawing file, and attach records to them. 

2D symbols are listed like this in the Resource palette.

3D symbols are listed like this in the Resource palette.

Hybrid symbols are listed like this in the Resource palette.

For a general overview of MiniCAD symbols, see Symbols. 

For additional information, see the following topics:

How do I select a symbol?

How do I edit a symbol?

How do I create a new symbol directory?

How do I rename a symbol?

How do I delete a symbol?

How do I move a symbol to another directory?

How do I attach a database record to a symbol?



How do I select a symbol?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click on the symbol's name in the scroll box--you'll see a miniature picture of it to the right of the 
selection button.

3. Then click the select button--a matching, miniature picture of the symbol will now appear to the left of 
the selection button.



How do I edit a symbol?

You can edit any symbol that is part of your drawing file. For hybrid symbols (2D and 3D) you can use the 
Resources palette to select which version of the symbol you want to edit. You can also edit symbols using
the Edit Symbol command--however, with that command you can only edit the version of the symbol that 
matches the projection you are working in (2D or 3D).

1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Make sure you have your current file selected in the shortcut menu.

3. Click on the symbol's name in the scroll box--you'll see a miniature picture of it to the right of the 
selection button. Then click Edit. 

Note 
If you add a 2D component when you are editing the 3D portion of a hybrid symbol, MiniCAD will 
automatically add the 2D component to the 2D portion of the symbol. 

4. In the dialog box that appears, select the part of the symbol you want to edit--2D Component or 3D 
Component--and then click the Edit button in this dialog box.

5. Make the changes to your symbol, and then click the Exit Symbol button in the Drawing Window's 
mode bar--MiniCAD will automatically update all instances of the symbol in your drawing so that they 
match your edited symbol.



How do I create a new symbol directory?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click New… In the dialog box that appears, select Symbol Folder and then click Create.

3. In the textbox after Folder Name:, type the name you want to assign to your new symbol directory and
click OK--MiniCAD will automatically place the new folder in your current drawing file.



How do I rename a symbol?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Make sure you have your current file selected in the shortcut menu.

3. Click Rename… In the dialog box that appears, type the new name you want to use for your symbol 
in the textbox after New Name:

4. Click OK--MiniCAD will change the name of that symbol in your drawing file.



How do I delete a symbol?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Make sure you have your current file selected in the shortcut menu.

3. Click Delete. A dialog box will appear asking you if you really want to delete the resource. 

4. Click OK--MiniCAD will remove all instances of the symbol in your drawing file, replacing them with 
loci.



How do I move a symbol to another directory?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Make sure you have your current file selected in the shortcut menu, and then click Move… 

3. Locate the directory you want to move the symbol to in the scroll box and double-click on its name--
this will make it the active directory in your shortcut menu.

4. Click OK--MiniCAD will move the symbol to the directory in your drawing file.



How do I attach a database record to a symbol?

Use these directions if you want to attach the record to all future instances of the symbol in your drawing 
file. If you want to attach it to only one symbol instance, you need to use the Object Info palette. See the 
Data Pane.

Important 
A record must be part of your drawing file before you can attach it to a symbol. 

1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Make sure you have your current file selected in the shortcut menu, and then click Attach… 

3. Select the record you want to attach in the scroll box, and then select the Attached checkbox.

Note 
You can "unattach" a record in the same way--click the Attached checkbox to clear it, and then click 
OK.

4. Click OK--MiniCAD will attach the record to all future instances of that symbol in your drawing file.



Working with Macro Command Resources

With the Resources palette, you can create and edit internal macro commands, as well as create and 
import the command palettes they are stored on. Remember: These internal commands are different than
MiniPascal Macros, which are external (separate) text files created outside MiniCAD. 

No matter which type of macro you are creating--internal or external--you need to understand MiniPascal 
and how to use this built-in programming language before you can successfully create a macro. For 
detailed instructions on creating programming macros, see the MiniCAD MiniPascal Manual.

For additional information, see the following topics:

How do I create a command palette?

How do I import a command palette?

How do I create a macro command?

How do I edit a macro command?

How do I run a command from a macro command palette?

How do I run a MiniPascal macro from an file?



How do I create a command palette?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click New… In the dialog that appears, select Command Palette and then click Create.

3. In the textbox after Name this palette:, type the name you want to assign to your new command 
palette and click OK--MiniCAD will automatically place the new command palette in your current 
drawing file.



How do I import a command palette?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click on the name of the command palette you want to import in the scroll box--you'll see that 
MiniCAD adds an Import button at the bottom of the list of command buttons in the Resources palette.

3. Click that Import command button--MiniCAD will automatically add the selected command palette to 
your drawing file.



How do I create a macro command?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click New… In the dialog that appears, select MiniPascal Command and then click Create.

Important 
If you don't have any command palettes in your drawing file, MiniCAD will first prompt you to create 
one before you can create a macro command.

3. In the dialog box that appears, select the name of the command palette you want to add the new 
macro command to, and then click OK.

4. In the textbox after Name this command:, type the name you want to use to your new macro 
command and click OK. 

5. In the MiniCAD Command Editor dialog box, use the following command buttons to create a macro 
command:

· Procedures. If you click this button, a dialog box will appear that helps you quickly choose 
MiniPascal language that will execute highly selective procedures--for example, deselect all 
objects on active layers in your drawing.

· Criteria. If you click this button, you'll get a dialog box that helps you add the MiniPascal 
language needed to write a macro that selects objects based on a combination of highly specific 
criteria, such as all objects in the dimension class that are invisible.

· Tool/Attr. If you click this button, you'll get a dialog box that lets you quickly select the MiniPascal
language needed to apply custom attributes to objects, such as pen and fill colors and patterns.

· Functions. If you click this button, you'll get a dialog box that lets you add MiniPascal functions to
your command macro, such as one that will convert degrees to radians.

· Get Text. If you click this button, you'll get a shortcut menu and a scroll box; you can use these to
locate any MiniCAD file and automatically add any macro codes used in that file to your new 
command macro.

· View Errors. If you click this button, MiniCAD gives you a list of potential logic errors in the last 
macro you executed.

4. Click OK when you are finished creating the macro.



How do I edit a macro command?

Use these directions if you want to edit the programming directions for an existing macro command or if 
you want to create the directions for a new macro command that you just created.

1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click on the name of the macro command you want to edit in the scroll box, and then click Edit… 

3. The MiniCAD Command Editor dialog box will appear, which has command buttons that run down its 
right side. These buttons give you quick access to pieces of MiniPascal that you can use to create a 
macro command:

· Procedures. If you click this button, a dialog box will appear that helps you quickly choose 
MiniPascal language that will execute highly selective procedures--for example, deselect all 
objects on active layers in your drawing.

· Criteria. If you click this button, you'll get a dialog box that helps you add the MiniPascal 
language needed to write a macro that selects objects based on a combination of highly specific 
criteria, such as all objects in the dimension class that are invisible.

· Tool/Attr. If you click this button, you'll get a dialog box that lets you quickly select the MiniPascal
language needed to apply custom attributes to objects, such as pen and fill colors and patterns.

· Functions. If you click this button, you'll get a dialog box that lets you add MiniPascal functions to
your command macro, such as one that will convert degrees to radians.

· Get Text. If you click this button, you'll get a shortcut menu and a scroll box; you can use these to
locate any MiniCAD file and automatically add any macro codes used in that file to your new 
command macro.

· View Errors. If you click this button, MiniCAD gives you a list of potential logic errors in the last 
macro you executed.

4. Click OK when you are finished editing the macro or viewing errors.



How do I run a command from a macro command palette?

Macro command palettes created with the Resources palette have this icon in front of them when they are
listed in the Resources palette. To run a macro from a macro command palette, take these steps:

1. If it isn't already displayed, open the Command palette that your macro command is stored on--on the
Window menu, first choose Commands and then the palette name. 

2. On the Command palette, double-click the macro command's name.



How do I run a MiniPascal macro from an file?

MiniPascal macro files have this icon in front of them when they are listed in the Resources palette. To 
run a MiniPascal macro file, take these steps:

1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click on the name of the MiniPascal macro you want to run in the scroll box, and then click Run.

3. MiniCAD will begin to run the macro, prompting you with dialog boxes if you need to supply 
information.



Working with Worksheet Resources

With the Resources palette, you can create independent worksheets. For more information about the 
many valuable ways you can use MiniCAD worksheets, and their spreadsheet and database rows, see 
Using Worksheets.

1. If it isn't already displayed, open the Resources palette--on the Window menu, click Resources.

2. Click New…    In the dialog box that appears, select worksheet, and then click Create.

3. In the Create Worksheet dialog box that appears:

· Type the name you want to give your worksheet in the textbox after Name:

· Type the number of horizontal rows you want your new worksheet to have in the textbox after 
Rows:

· Type the number of vertical columns (cells) you want your new worksheet to have in the textbox 
after Columns:

· Click OK.

4. Your new worksheet will appear. You can now assign names and functions to your columns, as well 
as select whether you want individuals rows to be spreadsheet or database rows.



Working with Hatch Resources

You can use the Resources palette to import hatches into your drawing file (so that you can place them 
with the Hatch command). You can also use the palette to create and edit hatches.

Remember that hatches are not the same as fill patterns. Because hatches are really patterns of lines, 
when you export a hatched object as a DXF file, the hatch will be part of the file. Fill patterns, on the other
hand, disappear when exported as DXF files.

For additional information, see the following topics:

How do I import a hatch?

How do I create a hatch?

How do I edit a hatch?



How do I import a hatch?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click the name of the hatch you want to import in the scroll box, and then click Import--the hatch is 
now part of your drawing file.



How do I create a hatch?
1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Click New… In the Create Resource dialog box that appears, select Hatch and then click Create.

3. In the Edit Hatch dialog box that appears, create your new hatch. (For directions about how the 
settings in this dialog box work, see the Hatch command.)

4. When you are done creating your hatch, click OK--the new hatch is now part of your drawing file.



How do I edit a hatch?

Before you can edit a hatch with the Resources palette, you must import the hatch into your drawing file 
(see How do I import a hatch?).

1. If it isn't already displayed, open the Resources palette--on the Window menu, choose Resources. 

2. Make sure you have your current drawing file selected in the shortcut menu, and then select the hatch
you want to edit in the scroll box.

3. Click Edit… In the dialog box that appears, make your changes to the hatch. (For directions about 
how the settings in this dialog box work, see the Hatch command.) 

4. When you are done editing the hatch, click OK--the revised hatch will now be part of your drawing file,
taking the place of the original hatch.



Working with Record Format Resources
 Creating record formats in your drawing file is the first step to creating database rows in you 

worksheets. You can attach record formats, which store a wide range of data, to any object (including 
symbols) in your drawing. 
You can use the Resources palette to import, create, and edit record formats, as well as to attach them to 
objects in your drawing file. For an overview of records and step-by-step directions, see How do record 
formats work?. 



Working Planes Palette

The Working Planes palette lets you easily save and change working planes, as needed, within a drawing
file. When you combine this feature with the Set Working Plane Tool and the Align Plane Tool, it's easy to 
see how MiniCAD can help you draw more accurately by controlling the placement and alignment of 
objects in 3D space. 

Every MiniCAD drawing has a Ground Plane. And, unless you otherwise create another plane, the 
Ground Plane will be the Working Plane in your drawing. That's why from the second you create a 
MiniCAD file, your Working Planes palette will show a "Ground Plane" listing. 

Then, even if you do not have the Working Planes palette displayed in your Drawing Window, MiniCAD 
tracks every working plane you create in a drawing file, automatically saving the 10 most recent planes. In
addition, you can permanently store a plane in your drawing by naming it in the Working Planes palette. 

1. If it isn't already displayed, open the Working Planes palette--on the Window menu, choose Working 
Planes. 

2. To view the most recent working planes you've created in your drawing, click the left scroll button to 
move backwards one plane at a time. (You can then move forward one plane at a time by clicking the 
right scroll button.)

3. If you want to permanently save a plane:

· Use the scroll buttons to display the plane you want to save in your Drawing Window.

· Click Add. (The Assign Name dialog box will appear.)

· If you want to assign a name other than Working Plane to the selected plane, type a unique name
in the dialog box after Name working plane:

· Click OK.

Note 
MiniCAD automatically saves and displays working planes in the order that you "Add" them.

4. Once you save a plane, you can no longer access it using the scroll buttons. Instead, double-click the 
plane in the list of available working planes.

5. If you want to delete a working plane from your saved list:

· Select the plane you want to remove by clicking it in the list of working planes.

· Then click Delete.

6. If you want to rename a working plane from your saved list:

· Select the plane you want to rename by clicking it in the list of working planes.



· Then click Rename.

· In the dialog box that appears, type a unique name after Name working plane:

· Click OK. (Because planes are listed in the order that they are originally created, the renamed 
plane will still be listed in the same spot.)

7. You also can change the way a selected plane displays in your Drawing Window with the following 
mode buttons:

Click this button if you want to change your view so that it's perpendicular (flat on) to the Working 
Plane.

Click this button if you want to make the Working Plane act like the Ground Plane when changing 
views.

Click this button if you want the Ground Plane to be your reference point when working with a 
perspective view and its viewing tools--for example, the Walkthrough Tool.

Important 
Use these buttons with the "rotation center" mode bar buttons--found on the view Rotation Tool's 
mode bar.



Add Solid command

This new command, included as part of MiniCAD 7's new Solids Modeling feature, allows you to join two 
or more 3D objects into a single model. You can use extrudes, multiple extrudes, and sweeps with this 
command and the two other solids modeling commands (Intersect Solid and Subtract Solid): extrudes, 
multiple extrudes, and sweeps. This command does not currently work with walls.

1. Select the two or more 3D objects that you want to combine.

2. On the Model menu, choose Add Solid--MiniCAD creates a single solid model from the objects, which
you can render.



Add Surface command

This command lets you create a single polygon from two or more 2D objects, as long as all of the 
following are true:

· The 2D objects are not symbols. It will work with rectangles (regular, rounded, and rotated), ellipses 
(including circles), arcs (quarter arcs or full), and polygons (regular, freehand, and polylines). 

· The objects are filled with a solid, pattern, or hatch. 

· The objects touch or overlap each other.

· The objects are not locked or grouped. 

When you use this command, the objects become one object, with a single surface area and perimeter. 
There are two important things to keep in mind:

· The object or objects are added to the bottom object--meaning that the new polygon will have the 
same attributes as the bottom object.

· Any open polygons will be converted to closed polygons.

Here's how to use the command:

1. Select the two or more objects that you want to combine.

2. On the Tool menu, choose Add Surface.

Objects before and after Add Surface is applied.



Align Layer Views command

This command gives you a one-step way to change all the layers in your drawing file so that they have 
identical Standard View and Projection modes. MiniCAD will make them match the Standard View and 
Projection modes in your active layer--the one displayed on your screen. 

1. Make sure your active layer is set to the Standard View and Projection modes you want to use for all 
layers in your drawing.

2. On the Organize menu, choose Align Layer Views--MiniCAD will change the Standard Views and 
Projections modes for the other layers in your drawing file.



Align to Grid command

This command lets you realign 2D and 3D objects to your Snap Grid, placing the upper-left corner of each
object at its closest grid point. The Align to Grid command lets you realign objects to your Snap Grid when
you change the grid's setting. And it allows you to align objects to this grid that were either created with 
the Snap to Grid Constraint Tool turned off or that were moved off the grid after they were created. (For 
more information, see Constraints Palette.) 

1. Select the object or objects that you want to realign.

2. On the Tool menu, choose Align. In the shortcut menu that appears, choose Align to Grid--MiniCAD 
will realign the object(s), placing the upper-left corner of each object at its closest grid point.



Align Objects command

This command lets align two or more objects to each other. For 2D objects you select the on the X and Y 
axes you want aligned on the Reference Grid. For 3D objects--or a combination of 2D and 3D objects--
you select the X, Y, and Z axes you want aligned on the Reference Grid. 

1. Select the objects you want to realign.

2. On the Tool menu, choose Align. In the shortcut menu that appears, choose Align Objects.

3. In the dialog box that appears, select the object alignment you want to use.

· For the X setting, select whether you want the Left Sides, the L/R Centers, or the Right Sides of 
the objects to be aligned.

· For the Y setting, select whether you want the Tops, the T/B Centers, or the Bottoms of the 
objects to be aligned.

· And, if you have any 3D objects selected, select whether you want the Backs, the F/B Centers, or
the Fronts to be aligned.

4. Click OK--MiniCAD will realign the selected objects.



Attributes command

You can use this command to display or hide the Attributes palette in your Drawing Window. 

On the Window menu, click Attributes.

· If the palette was hidden, it will now appear in your Drawing Window.

· If the palette was open, MiniCAD will close it.



Cam Construction command

This command, which is available when you have the Mechanical Engineering Overlay selected, lets you 
easily create a flat plate cam. 

1. On the Tool menu, choose Cam Construction... The Cam Construction dialog box will appear.

2. Create your initial point by clicking anywhere in the top diagram. Then select the follower motion for 
that portion of the diagram in the shortcut menu after Curve: (You can choose Uniform, Harmonic, 
Parabolic, Cycloidal, Trapezoidal, or Modified Sine. Selection is made with the drop down menu.) 

Important 
If the portion of the diagram you select is a dwell, your Curve: setting will have no effect

3. Click New. Then select either Flat or Roller in the shortcut menu that appears, and for that portion of 
your cam, type:

· The radius of the prime circle you want to use in the textbox after P.C.R.

· The maximum follower displacement in the text box after Max:

· The size of the cam follower in the textbox after Size:

4. Click New again, and then for that portion of your cam, type:

· The angular displacement of the selected center line you in the textbox after Angle: 

· The radial displacement of the selecter center line (measured from the prime circle radius) in the 
textbox after Disp:

· Wait a few seconds, or click anywhere in the diagram, and the displacement curve for the 
selected area will be drawn in the top diagram. 

5. Continue setting the remaining points of the displacement curve for your cam by following steps 2 
through 4 for each portion.

6. Make the changes, if any, you want to the displacement curve:

· To change an individual point, click its vertical line and type your designed angle or displacement 
changes. (MiniCAD will automatically change the rest of the curve to reflect your changes.) 

· To delete a point, click its vertical line to select the point, and then click Delete.

· To change the type of follower motion, click anywhere in that portion of the diagram, and then 
select the new motion in the shortcut menu 

7. To draw the cam, click OK or press the RETURN key.



Classes command

Classes are one of two methods MiniCAD gives you to organize elements across your drawing. (The 
other is Layers.) For a detailed overview of how both work and the differences between them, see Layers 
and Classes.

Every drawing you create in MiniCAD automatically has two classes--Dimension and None. The 
Dimension class stores information for any dimension you create in the drawing, while the None class, 
which is the drawing's default class, automatically stores information for all objects and symbols. You can 
rename these two classes in your drawing, but you cannot delete them.

MiniCAD also lets you create additional classes. In total, you can have up to 256 classes in any one 
drawing--Dimension, None, and up to 254 new classes. At any time, you have the flexibility to rename or 
delete these new classes.

For additional information, see the following topics:

Creating Classes

Renaming Classes

Deleting Classes



Creating Classes
1. On the Organize menu, choose Classes... 

2. In the dialog box that appears, click New...

3. Type the name of the new class you want to create in the text box after Give a name to this class: and
then click OK. (This will bring you back to the Classes dialog box.)

4. Select whether you want the class to be Normal or Invisible, and then click OK to return to your 
drawing. 



Renaming Classes
1. On the Organize menu, choose Classes... 

2. In the dialog box that appears, select the name of the class you want to rename in the list after Class: 
and then click Rename...

3. Type the name of the new name you want to use in the text box after Rename this class: and then 
click OK. (This will bring you back to the Classes dialog box.)

4. If you want, you can change the classes visibility--select Normal or Invisible.

5. Click OK to return to your drawing. 



Deleting Classes
Important
You cannot remove the Dimension class or the default class (None or the new name you assigned to this 
default class).

1. On the Organize menu, choose Classes... 

2. In the dialog box that appears, select the name of the class you want to delete in the list after Class: 
and then click Remove...

3. A dialog box will appear to confirm that you really want to remove this class from your drawing. Click 
OK. (This will bring you back to the Classes dialog box.)

4. Click OK to return to your drawing--you'll see that MiniCAD automatically moved all objects in that 
class to your None (default) class. 



Clear command

This command deletes any object or objects that you have selected in your drawing. It works the same as
pressing the Delete key, meaning that the object(s) are not stored on the Clipboard. They only way to 
retrieve a "cleared" object is to immediately click Undo. This command gives you an additional way to 
remove an object from your drawing without deleting the current contents of your Clipboard.

1. Select the object or objects that you want to remove from your drawing.

2. On the Edit menu, choose Clear. 



Clip Surface command

This command lets you trim the bottom object in a group of two objects so that any overlapping edges are
cut away from it. For example, if you selected the two overlapping objects and then clipped their surface, 
the bottom object would be reshaped as shown below.

With the exception of symbols, you can use this command to clip filled or unfilled objects that have not 
been "grouped" with the Group command. There are two important things to remember about this 
command. First, if the object you clip is an open polygon, it will automatically be converted to a closed 
polygon before it is clipped. Second, depending on what objects you have selected, the command may 
change the bottom object's type--for example if you clip a hole into a rectangle, the "clipped" rectangle will
automatically be changed into a polyline. 
1. Make sure that the object you want to clip is the bottom object. (You can change the objects' order by 

using the Send command--see the Send command.) 

2. Select the two objects that you want to clip.

3. On the Tool menu, choose Clip Surface--to see the clipped object, drag the top object away from it. 



Close command

This command closes your active drawing file--the drawing file that is displayed on your screen. It will not,
however, close MiniCAD. While it works exactly like the Close button in the title bar of your Drawing 
Window, it is always available. (In some cases, if you have selected the Use Full Screen command, for 
example--the title bar and Close button will not display.)

1. On the File menu, choose Close.

2. If you have made changes to the document since you last saved it, a dialog box will appear asking if 
MiniCAD should first save the drawing file.

· Click Don't Save if you want MiniCAD to simply close the drawing file--MiniCAD will close the 
document without saving any changes.

· Click Cancel if you change your mind and don't want to close the drawing file--this will close only 
the dialog box, taking you back to your drawing file. 

· Click Save if you want to save your drawing file first, and then close it.



Column command

This command lets you convert any closed 2D shape--rectangle, ellipse, polygon--into a column. In 
addition, you can use it on open 2D shapes, such as lines and polylines, to create a flat screen-like 
object. In order to create a column, you must be in the 2D Top/Plan view.

1. Make sure you are in Top/Plan view, and then select the 2D object that you want to convert.

2. On the Model menu, choose Column… 

3. In the dialog box that appears, type the Height: you want the new column to be in the textbox, and 
then click OK--to view your new column, you will need to change views.



Combine into Surface

This command lets you create a new polygon that is formed using a group of objects. You can use this 
command with all object types--as long as the elements currently intersect and in the end will form a 
closed polygon. Depending on the types of objects you have selected and where you click, you can 
create several different polygons from the same selection of objects. For example, with this set of three 
objects, you can create the following polygons:

          

1. Select the two or more closed objects that you want to use to create a new polygon.

2. On the Tool menu, choose Combine into Surface--you'll see that the cursor changes into a paint 
bucket.

3. Place the paint bucket inside the area you want to combine and click--MiniCAD creates a single 
polygon from the selected objects. The new polygon will use the current fill pattern.

Note 
If this command doesn't work, make sure that you have not selected an open polyline object.



Constraints command

You can use this command to display or hide the Constraints palette in your drawing. On the Window 
menu, choose Constraints.

· If the palette was hidden, it will now appear in your Drawing Window.

· If the palette was open, MiniCAD will close it.



Convert to Lines command

This command allows you to change a single object into the series of lines needed to create it. For 
example, if you use this command on a 2D rectangle, MiniCAD will convert it into four lines. You can 
convert 2D and 3D objects into lines. 

You can even convert circles into numerous line segments. However, when converting circles especially, 
the accuracy of the line segments depends on the 2D Conversion Res (Resolution) setting you have 
chosen in the MiniCAD Preferences dialog box. (For more information, see the MiniCAD Preferences 
command.)

For additional information, see the following topics:

Converting 2D Objects

Converting 3D Objects



Converting 2D Objects
1. Select the 2D object you want to convert.

2. On the Tool menu, choose Convert to Lines.



Converting 3D Objects
1. Select the 3D object you want to convert.

2. On the Tool menu, choose Convert to Lines.

3. In the dialog box that appears, tell MiniCAD how you want the polygons converted to lines. Select one
of the following: 

· Wireframe Rendering

· Hidden Line Rendering

· Dashed Hidden Line Rendering

4. Click OK.



Convert Copy to Lines command

This command works like the Convert to Lines command--except that it first makes a copy of the object, 
and then converts the copy into line segments. The original object remains untouched. 

For additional information, see the following topics:

Converting 2D Objects

Converting 3D Objects



Converting 2D Objects
1. Select the 2D object you want to convert.

2. Press the control key; while continuing to hold it down, on the Tool menu, choose Convert Copy to 
Lines.



Converting 3D Objects
1. Select the 3D object you want to convert.

2. Press the control key; while continuing to hold it down, on the Tool menu, choose Convert Copy to 
Lines.

3. In the dialog box that appears, tell MiniCAD how you want the polygons converted to lines. Select one
of the following: 

· Wireframe Rendering

· Hidden Line Rendering

· Dashed Hidden Line Rendering

4. Click OK--MiniCAD will place the copy directly on top of the original.



Convert to Mesh command

You can use this command to convert any 3D polygon or extrude wireframe into a mesh object, which 
gives you the flexibility to edit each individual vertex on the object, using any of MiniCAD's 2D tools or its 
Object Info palette. You also can select several vertices and edit them at the same time. 

Hint 
At anytime, you can convert a 3D mesh back to a wireframe object by selecting all the object's vertices 
and grouping them with the Group command.

1. Select the 3D object that you want to convert.

2. On the Model menu, choose Convert to Mesh.



Convert to Polygon command

This command allows you to change any object with a surface into the polygon or series of polygons 
needed to create it. You can even convert circles. However, when converting circles especially, the 
accuracy of the polygons depends on the 2D Conversion Res (Resolution) setting you have chosen in the
MiniCAD Preferences dialog box. (For more information, see the MiniCAD Preferences command.)

For additional information, see the following topics:

Converting 2D Objects

Converting 3D Objects



Converting 2D Objects
1. Select the 2D object you want to convert.

2. On the Tool menu, choose Convert to Polygon--the object is now a polygon and will display as such in
the Object Info palette.



Converting 3D Objects
1. Select the 3D object you want to convert.

2. On the Tool menu, choose Convert to Polygon.

3. In the dialog box that appears, tell MiniCAD how you want the polygons converted to lines. Select one
of the following: 

· Wireframe Rendering

· Hidden Line Rendering

4. Click OK--the object now becomes a group of polygons. (To select an individual polygon, you first 
need to use the Ungroup command.)



Convert Copy to Polygons command

This command works like the Convert to Polygons command--except that it first makes a copy of the 
object, and then converts the copy into polygons. The original object remains untouched. 

For additional information, see the following topics:

Converting 2D Objects

Converting 3D Objects



Converting 2D Objects
1. Select the 2D object you want to convert.

2. Press the control key; while continuing to hold it down, on the Tool menu, choose Convert Copy to 
Polygon--the object is now a polygon and will display as such in the Object Info palette.



Converting 3D Objects
1. Select the 3D object you want to convert.

2. Press the control key; while continuing to hold it down, on the Tool menu, choose Convert Copy to 
Polygon.

3. In the dialog box that appears, tell MiniCAD how you want the polygons converted to lines. Select one
of the following: 

· Wireframe Rendering

· Hidden Line Rendering

4. Click OK--the object now becomes a group of polygons. (To select an individual polygon, you first 
need to use the Ungroup command.)



Convert to 3D Polys command

This command lets you convert any 2D line or surface object--including polylines, polygons, ellipses, and 
rectangles, into a 3D polygon. Once converted, the new polygon will have a Z dimension, assigning it a 
place in 3D space. This allows you to rotate and manipulate it with 3D tools. The new polygon will not, 
however, have a thickness. 

You can select one or more objects to convert. However, if you select two or more objects and convert 
them simultaneously, MiniCAD will turn the objects into a formal Group when converting them to 
polygons.

1. Select the 2D object or objects that you want to convert.

2. On the Model menu, choose Convert to 3D Polys.



Copy command

Like many other software programs, MiniCAD allows you to "copy" an object to the Windows Clipboard, 
where it is temporarily stored. You then can "paste" the clipboard object into that same drawing file, into 
another MiniCAD file, or into another software program's file if that program also has copy and paste 
commands.

1. Select the 2D/3D object or objects you want to copy.

2. On the Edit menu, choose Copy--although you can't see it, MiniCAD has placed a copy of the object 
on your Windows Clipboard. (If you want, you could open your Clipboard to see the object you just 
copied.)



Create Database Worksheet command

This command is used when you use objects in your drawing that have record formats attached to them 
to create a MiniCAD worksheet. Because this command is one step used within a sequence of steps, you 
need to understand the process before you can understand the function of this command. To learn how 
and when the Create Database Worksheet command is used, see Using Worksheets.



Create Layer Link command

By default, the layers you create in MiniCAD are independent--each has its own Z and DZ height, as well 
as its own scale, projection, and render status. For an overview on Layers, see Layers and Classes. For 
step-by-step directions for creating layers, see the Layers command.

If you want to rotate two or more layers together, ensuring that their alignment remains precise, you must 
first link them. In addition, once you link two or more layers, any changes you make to the original layers 
are automatically updated on the linked layer when a screen redraw occurs. However, this updating 
occurs only in one direction--any objects or details you add to the linked layer will not appear in any other 
layers. 

1. Make sure that the layer you want to use as the linked layer--the one that will show all other layers 
and any changes made to them--is the active layer (the one displayed in your Drawing Window).

2. On the View menu, choose Create Layer Link… 

3. In the dialog box that appears, you will see a list of all other layers in your drawing file. In the dialog 
box:

· Select the layer or layers that you want to link to your active layer.

· If you want any 2D objects in these linked layers to appear in the active layer, select the checkbox
before Project 2D Objects.

4. Click Link.



Create Symbol command

This command lets you take 2D and 3D objects, including text, in your MiniCAD drawing files and create 
symbols from them. There are many advantages to using symbols in your drawing files--for example, they
require less disk space and you can easily reuse symbols in other drawings. For an overview of how 
symbols work in MiniCAD, see Working with Symbol Resources.

For additional information, see the following topics:

Creating 2D Symbols

Creating 3D Symbols



Creating 2D Symbols
1. Select the object(s) you want to change into a symbol.

2. On the Organize menu, choose Create Symbol… 

3. In the dialog box that appears, type the name you want to give the symbol in the textbox after Name:

4. Tell MiniCAD what point on the object you want to use as the symbol's insertion point:

· Click Plan Projection Center if you want the center of the 2D object, as determined by its 
bounding box, to be the symbol's insertion point. 

· Click Next Mouse Click if you want to hand-place the symbol's insertion point.

5. Click OK. If you selected "Next Mouse Click," the Bull's-eye cursor will appear. Move the cursor to the 
point you want to use as the symbol-insertion point and click.

6. MiniCAD will remove the original object(s) from your drawing file. Your new symbol will now be listed 
in the Resources palette.



Creating 3D Symbols
1. Select the object(s) you want to change into a symbol.

2. On the Organize menu, choose Create Symbol… 

3. In the dialog box that appears, type the name you want to give the symbol in the textbox after Name:

4. Tell MiniCAD what point on the object you want to use as the symbol's insertion point:

· Click 3D Object Center if you want that point to be used as the symbol's insertion point. 

· Click Next Mouse Click if you want to hand-place the symbol's insertion point.

5. Click OK. If you selected "Next Mouse Click," the Bull's-eye cursor will appear. Move the cursor to the 
point you want to use as the symbol-insertion point and click.

6. MiniCAD will remove the original object(s) from your drawing file. Your new symbol will now be listed 
in the Resources palette.



Custom Selection command

With MiniCAD's built-in programming language, you can create a several types of selection macros. With 
the Custom Selection command, you can create macros that select all objects that meet a highly specific 
set of criteria--for example, all the solid walls in your drawing. Or you could create a macro that deselects 
all objects with the same criteria. 

See Creating a Custom Selection Macro for an example showing how to create a custom selection macro
that will select all objects drawn with a solid black line in your drawing. To learn more about how MiniCAD 
uses its built-in programming language (MiniPascal) to create macros, as well as to learn about the 
various criteria and command options, see the MiniCAD MiniPascal Manual.

1. On the Organize menu, choose Custom Selection… 

2. In the dialog box that appears: 

· Decide what type of Command you want to create--one that Selects, Deselects or Selects Only 
objects that meet your criteria.

· Pick the type of command Option you want to create:

· If you want to create a one-time-only command, click Execute Command.

· If you want to permanently store the command macro so that you can use it again, click 
Create Command Macro.

3. Click Criteria…    In the dialog box that appears, tell MiniCAD the criteria you want it to use in your 
macro from the available options, and then click OK.

4. MiniCAD will place your new command in a Commands palette. To use a command, double-click its 
name in the palette.



Custom Tool/Attribute command

If you typically use a standard set of attribute combinations in your drawings, this command can greatly 
streamline your work. The Custom Tool/Attribute command lets you create your own commands, telling 
MiniCAD what pen and fill attributes, what layers, and what constraints to use, for example. With these, 
you can easily switch back and forth between a variety of basic drawing settings.

Important 
Before you begin creating specialized commands, it's a good idea to create a Defaults command. That 
way, you can easily return to your original settings at any time.

1. In your active Drawing Window--the one that displays--specify the attributes and other settings you 
want to use in your command. For example, say you want to create a True Blue command that draws 
all objects in a blue hairline. You would need to set the pen color to blue and the line weight to hairline
in your Attributes palette.

2. On the Organize menu, choose Custom Tool/Attribute… 

3. In the dialog box that appears, select the attributes and settings you want to include in the command--
select the checkbox to include a setting. 

4. Click OK. In the Assign Name dialog box that appears, type the name you want to give the command 
in the textbox after Name this command: and then click OK.

5. MiniCAD will place your new command in a Commands palette. To use a command, double-click its 
name in the palette, and begin drawing. 



Custom Visibility command

With MiniCAD's built-in programming language, you can create several types of selection macros. With 
the Custom Visibility command, you can create macros that hide all objects meeting a highly specific set 
of criteria--for example, all the solid walls in your drawing. Or you could create macros that show all 
objects with the same criteria. 

To learn more about how MiniCAD uses its built-in programming language (MiniPascal) to create macros, 
as well as to learn about the various criteria and command options, see the MiniCAD MiniPascal Manual.

1. On the Organize menu, choose Custom Visibility… 

2. In the dialog box that appears: 

· Decide what type of Command you want to create--one that will Show, Show Only or Hide objects
that meet your criteria.

· Pick the type of command Option you want to create:

· If you want to create a one-time-only command, click Execute Command.

· If you want to permanently store the command macro so that you can use it again, click 
Create Command Macro.

3. Click Criteria…    In the dialog box that appears, tell MiniCAD the criteria you want it to use in your 
macro from the available options, and then click OK.

4. MiniCAD will place your new command in a Commands palette. To use a command, double-click its 
name in the palette.



Cut command

Like many other software programs, MiniCAD allows you to "cut" (remove) an object from your drawing, 
temporarily storing the object(s) on the Windows Clipboard. You then can "paste" the clipboard object into
that same drawing file, into another MiniCAD file, or into another software program's file if that program 
also has cut and paste commands.

1. Select the 2D/3D object or objects you want to remove.

2. On the Edit menu, choose Cut--although you can't see it, MiniCAD has moved the object to your 
Windows Clipboard. (If you want, you could open your Clipboard to see the object you just cut.)



Cut 2D Section command

This command lets you cut a 2D section--a flat slice--from a 3D model. You can use this command in 
either standard or linked layers. 

1. Make sure that the 3D model--and the layer you want to use--are displayed in your Drawing Window. 

2. On the Model menu, choose Cut 2D section--you'll see that the cursor changes to a tiny cross-hairs 
(two crossed lines).

3. Press the left mouse button to mark the start of the section you want to cut; while continuing to hold 
down the button, drag the mouse to draw a line. When the line indicates the exact section you want to
cut, release the mouse button.

4. Now click on one side of the line to indicate the section's orientation.

Tip 
You can use the 2D Mirror Tool to change the section's orientation.

5. MiniCAD automatically creates a new layer and places the cut section in it. (The original layer 
remains unchanged, and the new and original layers are not linked.) The new 2D section will behave 
like any other 2D MiniCAD object. 



Cut 3D Section command

This command lets you cut a 3D section out of a 3D model or symbol. You can use this command in 
either standard or linked layers. 

1. Make sure that the 3D model plus the layer and plane you want to use are displayed in your Drawing 
Window. 

2. On the Model menu, choose Cut 3D section--you'll see that the cursor changes to a tiny cross-hairs 
(two crossed lines).

3. Press the left mouse button to mark the start of the section you want to cut; while continuing to hold 
down the button, drag the mouse to draw a line. When the line indicates the exact section you want to
cut, release the mouse button.

4. Now click on one side of the line to indicate the section's orientation.

5. MiniCAD automatically creates a new layer and places the cut 3D section in it. (The original layer 
remains unchanged, and the new and original layers are not linked.) The new 3D section will behave 
like any other MiniCAD 3D object. 

Remember 
Dimensions and text are 2D objects. For that reason, they will not rotate with your cut 3D section.



Document Preferences command

Within MiniCAD, there are now two different places that you can set preferences. 

· If you make a change in the Document Preferences dialog box, that change affects only the drawing 
file that you are working in. 

· If you make a change in the MiniCAD Preferences dialog box, though, all MiniCAD files that you 
open, work with, or save will use the changed setting. (For more information about these settings, see
the MiniCAD Preferences command.)

Here's how you change the preference settings in your document.

1. On the File menu, choose Document Preferences… In the dialog box that appears, you'll see that 
there are three groups of preferences (Display, Render, and QD3D) that you can set, which are 
grouped by tabs.

2. Click Display to show the setting options on that tab.

· Click the Black and White Only checkbox if you want the Drawing Window to use only these two 
colors. 

· Click the Use Layer Colors checkbox if you want to display the layer-specific pen and fill colors 
you have set. (For more information on setting layer colors, see Layers command.)

3. Click Render to show the setting options on that tab.

· Select the line style you want to use for Hidden-Line Rendering in the shortcut menu after Dash 
Style:

· Select how dark or light you want the Hidden-Lines to display--drag the selection lever to the left 
to make lines darker, or to the right to make them lighter.

4. Click QD3D to show the setting options on that tab.

· Select the Rendering Engine you want to use in the shortcut menu.

· Select the Object Reflectivity setting you want to use--Dull or Shiny.

· Select the Screen Resolution you want to use in the shortcut menu after Subpixels Per Pixel:

· Type the printing resolution you want to use in the textbox before dpi.

5. When you are finished setting your Document Preferences, click OK to return to your drawing. These 
settings will now be used in your current drawing until you change them.



Drawing Size command

The Drawing Size is the actual size of your drawing--not the size of paper your printer uses. MiniCAD 
considers the settings you've chosen in Printer Setup along with the Drawing Size you've specified to 
automatically figure out how many sheets of paper your drawing needs to be printed on in order for the 
whole drawing to come out of your selected printer. (For more information on how these commands work 
together, see How do I set up a drawing?.)

1. On the Page menu, click Drawing Size… 

2. In the dialog box that appears, either

· Type the Width: and Height: of your total drawing and select either inches (inch) or millimeters 
(mm). 

· Or, if your final drawing size matches an existing paper type, select that type from the Size: 
shortcut menu.

3. Decide if you want to see the individual page breaks.

· If you want to see gray lines marking what portion of the drawing will print on each piece of paper,
select the Show page breaks checkbox.

· If you prefer to see a single gray border box around the entire drawing, do not select the Show 
page breaks checkbox.

4. Click OK.



Duplicate command

This command lets you copy and paste an object or group of objects. Depending on the default setting 
that's selected in your MiniCAD Preferences, the duplicated object or objects will either be "offset"--placed
on top but off-center of the original--or placed directly on top of the original. (See the MiniCAD 
Preferences command.)

1. Select the 2D/3D object or objects you want to copy.

2. On the Edit menu, choose Duplicate--MiniCAD will place a copy of the selected object or objects on 
top of the original.



Duplicate Array command

This command allows you to control how many copies of selected objects are made and how these 
copies are arrayed--placed--in your drawing. 

1. Select the 2D/3D object or objects you want to copy.

2. On the Edit menu, choose Duplicate Array…

3. In the dialog box that appears, type the number of copies you want in the text box after Copies:

4. Decide whether you want multiple copies to be arrayed in either a rectangle or a circle.

·      If you select Rectangular Array, type the number of columns you want the copies placed 
in after Columns:.

·      If you select Circular Array, type the rotation angle you want 
MiniCAD to use when placing the copies after Angle:.

5. Decide if you want to use set coordinates or "hand place" the starting point of the copied images:

· If you want to use set coordinates, tell MiniCAD how far from the original you want the copies to 
be placed by typing in X: and Y: coordinates. 

· If you want to hand-place the copies, select Next Mouse Click.

6. Decide if you want the copies to be a different size than the original. 

· If you do, select the Resize Duplicate checkbox and type in the X scale: and Y scale:

· If you don't, make sure the Resize Duplicate checkbox is not selected.

7. Decide if you want the copies to be rotated. 

· If you do, select the Rotate Duplicate checkbox and type the rotation you want to use for the 
copies after Angle: 

· If you don't, make sure the Rotate Duplicate checkbox is not selected.

8. Click OK. 

· If you used set coordinates, MiniCAD will automatically place the duplicate copies.

· If you selected Next Mouse Click, move the mouse to the point where you want the copies 
placed, and click the left mouse button.



Edit Attributes command

At anytime, you can use this command to change the following default attributes:

· Arrow Heads

· Color Palette

· Dash Style

· Line Thickness

· Patterns

Important 
If you only want to change an attribute in your active drawing, use the Attributes Palette.

Once you make a change using the Edit Attributes command, from that point forward the new attribute 
style will be available in all MiniCAD drawings--and the original attribute that you edited (replaced) will no 
longer be available. 

Each of these attribute types has its own subcommand and dialog box. 

For additional information, see the following topics:

Changing Your Default Arrow Heads

Changing Your Default Color Palette

Changing Your Default Dash Style

Changing Your Default Line Thickness

Changing Your Default Patterns



Changing Your Default Arrow Heads
1. On the Edit menu, choose Edit Attributes and then Arrow Heads…

2. In the dialog box that appears:

· Pick the placement for your new arrow head (position in the list of seven arrow heads) from the 
shortcut menu after Arrow #

· Select the arrow head style you want to edit from the shortcut menu after Style:

· Type the new arrow head angle in the textbox after Angle:

· Type the new arrow head length in the textbox after Length:

3. Click OK. (Clicking Cancel with close the dialog box without making any changes. Clicking Revert will 
delete your changes, displaying the original attribute settings before you edited them.)



Changing Your Default Color Palette
1. On the Edit menu, choose Edit Attributes and then Color Palette…

2. In the dialog box that appears:

· Click Pick Color… if you want to create a new color by choosing Hue, Saturation, and Brightness 
(HSV) or Red, Green, Blue (RGB) values.

· Click Import… if you want to use a color palette from another drawing or program.

· Select the color or colors you want to use:

· Select a color square and then click Lighten (once or several times) to lighten the selected 
color.

· Select a color square and then click Darken (once or several times) to darken the selected 
color.

· Click and drag to select a range of colors. Then, click the RGB Blend or the HSV Blend 
buttons to create a range of colors that smoothly transition upper-left to bottom-right.

3 Click OK. 



Changing Your Default Dash Style
1. On the Edit menu, choose Edit Attributes and then Dash Styles…

2. In the dialog box that appears:

· If you want to edit an existing dash, select it from the shortcut menu after Dash Style #

· Select where you want the dash to be measured in Inches or millimeters (mm)

· Drag the selection lever--drag to the right to space the dashes further apart; drag to the left to 
space the dashes closer together.

· If you want the dashes to always stay proportional to your line thickness, select the Scale with 
line thickness checkbox.

· If you want to add the dash style you just created as a new dash--not an edited version of an 
existing dash--click Add.

· If you want to remove an existing dash style, click Delete… In the dialog box that appears, select 
the dash style (using the shortcut menu) you want to be applied to any objects that use the dash 
style you are deleting. Then click OK.

3. Click OK.



Changing Your Default Line Thickness
1. On the Edit menu, choose Edit Attributes and then Line Thickness…

2. In the dialog box that appears:

· Select the Units: you want to use to measure the thickness of your edited line--Points, Mils, or 
mm.

· Type the new thickness you want to use in the textbox under New--the new thickness will replace 
the current thickness listed to its left.

3. Click OK. 



Changing Your Default Patterns
1. On the Edit menu, choose Edit Attributes and then Patterns…

2. In the dialog box that appears:

· Select one of the 36 patterns that you want to edit from the shortcut menu after Pattern #

· In the right-hand pattern box, click to add/delete pixels--you'll see how your edits change the 
overall pattern in the left-hand box.

3. Click OK. (Clicking Cancel will close the dialog box without making any changes. Clicking Revert will 
delete your changes, displaying the original attribute settings before you edited them.)



Edit Group command

This command gives you a way to edit several objects that you have grouped into a single option. It even 
works on a group of objects that is nested inside another group--in fact, each time you select the Edit 
Group command, MiniCAD will move one level deeper in the nested groups. 

Note 
For information on creating a group of objects, see the Group command.

In addition, this is the command you need to use to make changes to hybrid objects, such as roofs, floors,
and walls. Even though these objects are created without using the Group command, MiniCAD views 
them as a group because of their interdependence in a drawing.

Important 
Do not ungroup hybrid objects--once a hybrid object is changed into its component parts, it cannot be 
"regrouped."

When you are editing a group, the default is to hide all other objects in your drawing. However, if you 
want, you can have MiniCAD show all objects in your drawing--although you can only work with the 
grouped objects. To do this, select the Show Other Objects While in Group checkbox in your MiniCAD 
Preferences. (See the MiniCAD Preferences command.)

1. Select the group of objects that you want to edit.

2. On the Organize menu, choose Edit Group.

3. MiniCAD will automatically open a new Drawing Window that contains only the group you want to 
edit. Make your changes to the group of objects in this window.

4. Then click the Exit Group button, which is located in the top-right corner of your Mode Bar. This will 
take you back to your main Drawing Window--or, if you are editing a group that is nested in other 
groups, the button will take you back one group.



Edit Sheet command

This command works with MiniCAD 7's new Views Bar and the Save Sheets command. You use the Edit 
Sheets command to change the settings you assigned when originally creating a sheet (view). 

1. On the Views Bar, click the Sheets shortcut menu and then Edit Sheet… 

2. In the dialog box that appears, select the name of the sheet you want to change and then click Edit…

3. In the Edit Saved Sheet dialog box that appears:

· If you want to restore the basic view factors--which include pen, zoom, 3D orientation, and 
projection--select the Restore View checkbox. 

· If you want to, select the Restore Class Visibility checkbox.

· If you want the to restore the layer options, active layer, and layer visibility, select the Restore 
Layer Visibility checkbox. 

4. Click OK--the new view you just created is now stored on the Views Bar at the bottom of your 
Drawing Window.



Edit Symbol command

When you select a symbol in your drawing, this command replaces the Edit Group command on your Edit
menu. 

Important 
If you use this command with a hybrid symbol, you can only edit one version of the symbol at a time. For 
example, if you are in 2D Plan Projection when you select the command, you will be able to edit the 2D 
version of the hybrid symbol. When you are done, you can edit the 3D version separately--change to a 3D
projection, and then select the Edit Symbol command.

1. Select the symbol that you want to edit.

2. On the Organize menu, choose Edit Symbol.

3. MiniCAD will automatically open a new Drawing Window that contains only the symbol you want to 
edit. Make your changes to the symbol in this window.

4. Then click the Exit Symbol button, which is located in the top-right corner of your Mode Bar. This will 
take you back to your main Drawing Window--or, if you are editing a group that is nested in other 
groups, the button will take you back one group.



Engineering Properties command

This command will automatically calculate a 2D object's perimeter, centroid, moments of inertia about 
both the centroid and any point you specify, and the radii of gyration. With this command, you can:

1. Select a single object, or select a single object and a locus point.

2. On the Tool menu, choose Engineering Properties…

· If you selected a single object, this information will display:

· If you selected a single locus, this information will display:

3. If you wish, select the Place locus at centroid checkbox.

4. Click OK to return to your drawing.



Exit Group command

This command gives you another way to exit the new drawing window that opens when you are editing a 
group of objects. See the Edit Group command for more information. 

When you select the Exit Group command, which is also located on the Organize menu, you will return to 
your main Drawing Window--or, if you are editing a group that is nested in other groups, the command will
take you back one group.



Exit Symbol command

This command gives you another way to exit the new drawing window that opens when you are editing a 
symbol. See the Edit Symbol command for more information.

Instead of clicking the Exit Symbol button, which is located in the top-right corner of your Mode Bar, you 
can choose this the Exit Symbol command on the File menu. Both methods will take you back to your 
main Drawing Window.



Export command

This command lets you export your MiniCAD files in several different file formats. Then you can import 
(open) the new file in another software program, where you can easily manipulate the objects and data in 
your drawing. When you export a MiniCAD drawing file, the program creates a new file--it does not 
change your original drawing file. 

1. On the File menu, choose Export and then the export option you want to use--for example, Export 
DXF/DWG.

2. Select the export options you want to use in the format-specific dialog box that appears.

In MiniCAD 7, you can select the following export options:

Export DXF/DWG

Export EPSF

Export PICT

Export QuickDraw 3D

Export RenderMan

Export Database

Export Worksheet

Export Text Format

Export MiniCAD 6



Export DXF/DWG

DWG and DXF files can be read by other CAD programs (such as AutoCAD™). In addition, they can be 
printed by service bureaus and opened in rendering programs. The MiniCAD 7 translator exports 
DWG/DXF files in version 13 format. MiniCAD will export all visible objects in visible layers--using the 
current projection mode for each layer. 



Export EPSF

EPSF (Encapsulated PostScript Format) files can be read by many graphics and desktop-publishing 
programs. The MiniCAD 7 translator exports EPSF files in Illustrator '88 format. EPSFs carry all drawing 
elements except color bitmaps. MiniCAD exports these files with high resolution and full accuracy. 



Export PICT

PICT files can be read by other graphics programs. Files exported as PICTs carry object oriented 
attributes such as thin lines, fill patterns, and object colors. However, the resolution value of these files 
may be reduced.



Export QuickDraw 3D

In MiniCAD, you can export 3D files in a QuickDraw 3D format. Files exported in this format carry 
information about 3D objects, including there geometry, lighting, and shading. This cross-platform format 
(Macintosh, Windows, Unix) offers consistent files. 



Export RenderMan

Files exported in this format can be read by RenderMan™, as well as by other rendering programs that 
support the RenderMan Interface Bytestream IRIB) format, such as ShowPlace™. MiniCAD will export all 
visible objects in visible layers--using the current projection mode for each layer. In addition, you have the 
option of including MiniCAD shading groups in your export, or of exporting the active layer in your drawing
as a single object.



Export Database

This export format allows you to save an individual record format as a file that can be used in a database 
program, such as FileMaker™. MiniCAD gives you a selection of formats to choose from when you export
records as a database--including, comma delimited, tab delimited, merge, DIF, and SYLK.



Export Worksheet

Worksheet files can be read by spreadsheet programs, such as Excel™, as well as by some 
wordprocessing programs. Because many of these programs have different format requirements, 
MiniCAD gives you a selection of formats to choose from when you export files as a worksheet--including,
comma delimited, tab delimited, merge, DIF, and SYLK. Using the tab delimited format, for example, 
creates a file that can be opened as a table in Word™. In addition, MiniCAD allows you to export all rows 
or just selected rows of a worksheet.



Export Text Format
Important 
This export option is included in case you need to create a file that can be used with an older version of 
MiniCAD (Version 5 or older). Do not use it otherwise with new files.

The Export as Text Format is an old technology, originally designed as an easy way to copy object and 
attribute defaults from one MiniCAD drawing file to another. It has since been replaced by the much more 
powerful stationery pad technology. For more information, see How do I work with template files?.



Export MiniCAD 6

Like most other software programs, in MiniCAD 7 it is possible to open an old file in a new version of the 
program, but impossible to use files in the other direction. For that reason, MiniCAD 7 includes this 
format, which allows you to save a copy of your new file that cane be opened and manipulated in the 
older MiniCAD 6 version of the program.



Extrude command

This command gives you a way to turn 2D objects into 3D objects. You can either choose to have 
MiniCAD automatically extrude the object to match active layer's DZ height, or you can choose to assign a
different measurement. 

Depending on the view you are in, the Z measurement will determine either the object's height or its 
depth. That's because the default Z for extruded objects is the layer's DZ. For example, if you extrude an 
object in Top/Plan view, the Z measurement will be read as the object's height; but if you extrude the 
same object in Front view, the measurement will be read as the object's depth. 

In addition, the type of object and its attributes will determine the type of extrude that is produced. Lines 
are extruded as flat planes, while all other objects are extruded as wireframe solids.

If you extrude an object with a fill, it will display as a wireframe solid until your render the object--at that 
point, the fill will be visible again. While you can select and extrude more than one object at a time, you 
cannot extrude objects that have been grouped with MiniCAD's group command. 

Note 
If you extrude a selection of objects, MiniCAD will turn the objects into a single 3D Group of objects. To 
edit an individual object, you must first ungroup the set (see the Ungroup command).

For additional information, see the following topics:

Using the Layer's DZ height

Assigning a Different Z Measurement



Using the Layer's DZ height
1. Make sure you are in the projection mode you want to use, and then select the 2D object or objects 

you want to extrude.

2. On the Model menu, choose Extrude.

3. MiniCAD will automatically extrude the object to be the same the Z measurement as the layer's 
height.



Assigning a Different Z Measurement
1. Make sure you are in the projection mode you want to use, and then select the 2D object or objects 

you want to extrude.

2. While pressing the control key, on the Model menu, choose Extrude…

3. In the dialog box that appears, type the measurement you want to use in the textbox after DZ: 

4. Click OK--if you are in Top/Plan view, you will need to change the projection mode to see the extrude.



Fit to Objects command

This command gives you an easy way to zoom in or out of your drawing. You have your choice of two 
zoom options:

· You can have MiniCAD zoom in or zoom out so that all of the objects in your drawing are visible.

· You can have MiniCAD zoom in on a particular object or set of objects.

For additional information, see the following topics:

For All Objects in your drawing

For a Particular Object of Set of Objects



For All Objects in your drawing
1. Make sure you are in the layer that has the object or objects you want to view and that no objects are 

selected.

2. On the Page menu, choose Fit to Objects--MiniCAD will zoom in or zoom out so that all the objects in 
your drawing display in the Drawing Window.



For a Particular Object of Set of Objects
1. Make sure you are in the layer that has the object or objects you want to view.

2. Select the object or objects that you want to view.

3. On the Page menu, choose Fit to Objects--MiniCAD will zoom in so that only the selected object(s) 
display in the Drawing Window.



Fit to Window command

This command gives you an easy way to quickly displays your whole document in the Drawing Window. If
you are using a single page, this command will display all of that page in the Drawing Window. If, 
however, your drawing has two or more pages, all of the pages will display at the same time in the 
Drawing Window when you select this command.

On the Page menu, choose Fit to Window--MiniCAD will zoom in or out so that all pages in your drawing 
display in the Drawing Window.



Floor command

In spite of its name, this command can be used to create more than just floors. The command takes any 
2D object in your drawing and turns it into a hybrid (2D/3D) object. You can use it to create a floor (or 
hybrid object) of any shape and thickness. However, the object you create must be flat and must also be 
parallel to your Ground Plane. 

1. Make sure you are in the Top/Plan view--while you can use this command on a 2D object in a 3D 
projection mode, the precise X and Y placement is much harder to determine. 

2. Select the 2D object(s) that you want to turn into a floor (or flat hybrid object).

3. On the Model menu, choose Floor…

4. In the dialog box that appears, 

· Type the measurement above the Ground Plane that you want the floor to start in the textbox 
after Bottom Z: In most cases, you will want to use the default of 0 (starting the floor on the 
Ground Plane)

· The DZ height you want to use for the floor in the textbox after Thickness:

5. Click OK--if you are in Top/Plan view, you will need to change to a 3D projection mode to see the 
floor.



Grid Creator command

This command allows you to create a grid that is part of your MiniCAD drawing--a grid that behaves and 
prints like all other 2D objects in the drawing file. Don't confuse it with the Reference and Snap grids, 
which are used for drawing precision only and do not automatically print (see Snap and Reference Grids.)

1. On the Page menu, choose Grid Creator. 

2. In the dialog box that appears:

· Type the number of Columns: and Rows: you want to use.

· Type the line weight--in mils--that you want to use for the Thin: and the Thick: lines in your grid.

Hint 
If you want to create a grid with four boxes to every inch and each inch marked off visually, you 
would specify 1/4" for your thin horizontal and vertical grid lines and 4 for the number of squares 
between thick horizontal and vertical grid lines.

· Type the Intervals: you want to use you want between thick and thin column and row lines.

· The measurement you type in the textboxes after Thin Horiz: and Thin Vert: will determine the
size of all squares in your grid.

· The number of squares you type in the textboxes after Thick Horiz: and Thick Vert: will 
determine how often a thick line appears that separates portions of the grid.

3. Click OK.



Group command

This command lets you select two or more individual objects (including text and symbols) and "group" 
them--tell MiniCAD to view the group of objects as a single object. For example, you could move a group 
of objects to a different page in your drawing without changing the spacing between them.

In addition, you can use this command to selects two or more groups of objects that you have created 
and turn them into a single group. (For information on how to edit individual objects within a group, see 
the Edit Group command.)

1. Select the objects (or groups) that your want to turn into a single group.

2. On the Organize menu, choose Group. 



Guides command

This command gives you a way to draw guidelines in a file, which you can use to visually align objects in 
your drawing. Unlike other graphics programs, MiniCAD lets you create guides of any shape and size. In 
addition to providing visual clues, guides work with MiniCAD's SmartCursor and the settings on the 
Constraints palette to make sure your alignments are precise. (For more information on available settings,
see the Constraints Palette.)

For additional information, see the following topics:

Creating Guides

Other Guides Command Options



Creating Guides
1. In your drawing, create the object that you want to change into a guide, and then select it.

2. On the Page menu, choose Guides and then Make Guide--MiniCAD will change the object into a 
guide that is the same color as your Reference Grid.



Other Guides Command Options

On the Guides command shortcut menu, you will also find the following options.

· Select Guides-- choose this if you if you want to select all the guides in your drawing. For example, 
you could use it to select all guides in your drawing and then change their color, using the Attributes 
palette.

· Show Guides-- choose this if you have hidden the guides and now want to display them.

· Hide Guides-- choose this if you want to temporarily hide the guides in your drawing. 

· Delete all Guides-- choose this if you want to permanently remove all guides and the objects used to 
create them from your drawing file.



Hatch command
Important 
The hatch lines created with this command are added to your drawing like all other new lines--using the 
default pen size and color.

This command lets you add a group of lines to objects and the spaces between them in your drawing. 
Before you can add a hatch, you must first make it active in your drawing. You can do this by creating a 
hatch from scratch or by editing your default hatch. In addition, you can import hatch patterns from other 
MiniCAD files using the Resources palette. (For directions, see Working with Hatch Resources.)

Unlike fill patterns, hatches are created as patterns of lines. This means that they remain with an object 
when you export the drawing file to another program or for a service bureau. (Fills disappear when 
exported.) In addition, MiniCAD's new associative hatching feature makes it possible to apply realistic 
hatches to a variety of object shapes.

For additional information, see the following topics:

Applying Hatches

Other Hatch Options

Creating and Editing Hatches



Applying Hatches
Important 
Hatches are independent objects in MiniCAD. If you want a hatch to always stay with the object you have 
attached it to, use the Group command to combine them into a single object.

1. Select the object or objects that you want to apply the hatch to.

2. On the Tool menu, choose Hatch… 

3. In the dialog box that appears, select the hatch you want to apply from the list after Hatch:--in the 
right-hand box you'll see a preview of the hatch pattern

4. Click OK.



Other Hatch Options

In addition to applying hatches, this command also lets you

· create new hatches, 

· edit existing ones, and 

· duplicate hatches (make an exact copy of the selected hatch, saved under a different name). 



Creating and Editing Hatches

If you select either New… or Edit… in the Select Hatch dialog box, the Edit Hatch dialog box will appear. 
In it are all the options you need to create a new hatch from scratch or by editing an existing hatch 
pattern. The dialog box includes everything from background color and pen size shortcut menus to 
textboxes that allow you to specify very precise offset values.



Import command

This command lets you import files in a number of different file formats. Using this command, you can 
easily open drawings produced in other software programs in your MiniCAD drawings, where you can 
easily manipulate their objects and data. 

1. To avoid unexpected formatting problems, make sure you are in a blank document--one that does not 
contain any drawings or files. 

2. On the File menu, choose Import and then the import option you want to use--for example, Import 
DXF/DWG.

3. In the dialog box that appears, select the name of the file you want to open, and then click OK.

In MiniCAD 7, you can import files in the following formats:

Import DXF/DWG

Import EPSF

Import PICT

Import PICT as Picture

Import Text Format

Import Worksheet



Import DXF/DWG

DWG and DXF files are produced by other CAD programs (such as AutoCAD™). MiniCAD 7 reads 
DWG/DXF files using version 13 format or lower. If the file you are importing includes 3D objects, 
MiniCAD will ask you to select where you want to convert them to 2D objects, or if you want to convert 
them to MiniCAD 3D objects. 



Import EPSF

Encapsulated PostScript Files (EPSF) are produced by many graphics and desktop-publishing programs. 
EPSFs typically are high-resolution files. 



Import PICT

PICT files were first produced by MacDraw™ and other object-oriented drawing programs. It is also the 
native format of the Macintosh Clipboard. When you import PICT files into MiniCAD, they usually come in 
at a lower resolution.



Import PICT as Picture

Because PICT as Picture files are really a single graphic object, the only editing you can do in MiniCAD is
to resize them. Both grayscale and color images (including 24-bit images) retain their high resolution 
when imported into MiniCAD



Import Text Format
Important 
This option does not bring in text from other programs or the Clipboard. Use the Copy and Paste 
commands if that is what you want to do.

This format is designed for importing MiniCAD files produced in older versions of the program that have 
been exported as text. (See Export Text Format for more information on using this format.) In addition, it 
can be used to import MiniPascal macro files, bringing them in as text in your MiniCAD drawing.



Import Worksheet

In order to import a MiniCAD worksheet into your current drawing, the worksheet and its original file must 
be open. In addition, you must have created a blank worksheet in your active drawing so that you can 
place the worksheet you are importing. MiniCAD can import a variety of worksheet formats--including, 
comma delimited, tab delimited, merge, DIF, and SYLK. 



Intersect Solid command

This new command, included as part of MiniCAD 7's new Solids Modeling feature, allows you to create a 
single model from the area that two or more 3D objects intersect. You can use extrudes, multiple 
extrudes, and sweeps with this command and the two other solids modeling commands (Add Solid and 
Subtract Solid). This command does not currently work with walls.

1. Select the two or more 3D objects that you want to combine.

2. On the Model menu, choose Intersect Solid--MiniCAD turns the selected objects into a single solid 
model, which you can render, that is the size and shape of the overlapping area of the selected 
objects 



Intersect Surface command

This command gives you an easy way to create a new object that is the exact size and shape of the 
overlapping area of two objects. You can use this command with any closed objects that can be filled and 
that are not grouped--rectangles (including rounded and rotated), ellipses/circles, quarter and full arcs, 
and all types of polygons (regular, freehand, and polylines). 

1. Select the two overlapping objects that you want to use to create a third object--if necessary, use the 
Send command to arrange the objects in the overlapping order you desire.

2. On the Tool menu, choose Intersect Surface--MiniCAD places the new object directly on top of the 
two intersecting objects; to see the new object, select it and drag it to the side.

If you used the Intersect Surface command on these two objects…

…MiniCAD would create this new object:



Join command

This command lets you create a single object from two non-parallel lines. The Join command can be used
with either two single lines or two double lines. It cannot, however, be used with a mixture of the two line 
types. The Join Command works like the Wall Tool; in fact, if you are working with walls or parallel lines, 
you could choose either this command or the Wall Tool to get the same effect.

For additional information, see the following topics:

With Single Lines

With Double Lines



With Single Lines
1. Select the two single lines that you want to join--remember they cannot be exactly parallel to one 

another.

2. On the Tool menu, choose Join--MiniCAD will automatically join the two lines together into a single 
bent line, trimming away any excess. 

Two Nonparallel Lines... After Joining



With Double Lines
1. Select the walls and/or double lines that you want to join--remember they cannot be exactly parallel to

one another.

2. On the Tool menu, choose Join--MiniCAD will automatically join the selected walls/lines together into 
a single object, creating a sharp angle and trimming away any excess. 
Two Sets of Parallel Lines... After Joining



Join and Fillet command

This command, which becomes available when you hold down the control key, gives you additional 
options not available with the Join command. 

· With single lines, you can join two lines without having MiniCAD automatically trim them.

· With double lines, you can specify a fillet measurement, giving you a rounded corner between the 
two double lines (rather than having the two double lines meet and a sharp angle).



With Single Lines
1. Select the two single lines that you want to join--remember they cannot be exactly parallel to one 

another.

2. Press the control key; while continuing to hold down the key, on the Tool menu, choose Join (no 
trim)--MiniCAD will automatically connect the two lines, without trimming away any excess. 



With Double Lines
1. Select the two double lines (lines drawn with the Double Line Tool) that you want to join--remember 

they cannot be exactly parallel to one another.

2. Press the control key; while continuing to hold down the key, on the Tool menu, choose Join and 
Fillet…

· If you have already specified a fillet measurement in your drawing, MiniCAD will automatically 
connect the two double lines, creating a fillet with the default value.

· If you have not specified a fillet measurement in your drawing, a dialog box will appear. Type the 
fillet measurement you want to use, and then click OK--MiniCAD will automatically connect the 
two double lines, creating a fillet with the measurement you specified.



Layers command

This command lets you create layers in your drawing. For an overview of how layers can help you 
organize the objects in your MiniCAD drawings, see Layers and Classes. In addition, you can find more 
information about working with layers in the section How do I set up a drawing?.

1. On the Organize menu, click Layers…

2. In the dialog box that appears, click New. (You'll see that MiniCAD automatically creates a new layer--
for example, Layer-2--and lists it in the box after Layer:) If you want to, you can type over the name 
MiniCAD assigns, renaming the layer. 

3. Decide if you want this new layer to be your active (working) layer.

· If you do, make sure to select the Active Layer checkbox.

· If you don't, make sure that the Active Layer checkbox is not selected.

4. Decide how you want MiniCAD to display and print this new layer when you are working in other 
layers:

· Select the Normal checkbox if you want to see all objects in your new layer even if it is not the 
active layer. (Normal layers are marked with a solid diamond in the list.)

· Select the Grayed checkbox if you want all 2D objects in your new layer to display as grayed 
(ghosted) when it is not the active layer. Note 3D objects, text, and fills are not displayed in 
grayed layers. (Grayed layers are marked with an open diamond in the list.)

· Select the Invisible checkbox if you want all objects in your new layer to be invisible (hidden) 
when it is not the active layer. 

5. Decide if you want to change the Transfer Mode: setting--in most cases, these settings are useful only
if you are working with 24-bit color and are not using a Postscript printer or a plotter.

· Select Paint if you want to make objects in your new layer solid, obscuring any objects that are in 
layers stacked below it.

· Select Overlay if you if you want to make objects in your new layer transparent so they do not 
obscure any objects that are in layers stacked below it.

· Select Invert if you want a photo negative (reverse) image to appear any time an object in your 
new layer overlaps an object in any other layer.

· Select Erase if you want objects in your new layer to display all foreground patterns as white and 
all background patterns as transparent.

· Select Not Paint if you want to make objects in your new layer solid and, rather than obscuring 
any objects in layers stacked below, to invert the overlapping areas--display as photo negatives.

· Select Not Overlay if you want to give objects in your new layer a transparent effect and to invert 
layer colors.

· Select Not Invert if you want to give objects in your new layer a transparent effect and to make 
overlapping black pixels from other layers white and overlapping white pixels transparent.

· Select Not Erase if you to give objects in your new layer a transparent effect and to make 
overlapping white pixels from other layers black and overlapping black pixels transparent. 

6. Decide if you want to set a separate scale for your new layer. If you do, click Scale…, set the new 
scale in the dialog box that appears, and click OK. (For directions, see How do I change the scale of 
an individual layer?.

7. Decide if you want to change the foreground and background pen and fill colors. If you do, click 
Colors… and in the dialog box that appears, select the new Fill foreground: and background: and Pen



foreground: and background: colors. Click OK.

8. If you want your new layer to have a Z and DZ height, type these values. (For information on how 
MiniCAD uses them to create 3D models, see How do I link 3D layers to create a 3D model?.

9. Click Done.



Layer Options command

This command lets you control how all of the layers in your drawing work together. Using it, you can tell 
MiniCAD to display only the active layer in your drawing, temporarily hiding all other layers and their 
objects, for example.

1. If you wish, go to a particular layer in your drawing--however, you can use this command at any time 
and in any layer.

2. On the Organize menu, choose Layer Options and then the layer option you want to use--for 
example, Active Only.

Active Only

Gray Others

Show Others

Show/Snap Others

Show/Snap/Modify Others



Active Only
Important 
With this layer option, only your active layer will print. 

If you select this option, MiniCAD will display only the active layer and its objects. All other layers and their
objects will be temporarily hidden.



Gray Others

If you select this option, your active layer will be displayed normally. All other layers--with the exception of 
3D layers--and their objects will be grayed, displaying in the background. Even though all objects appear 
are visible, you only can edit objects in your active layer. 



Show Others

If you select this option, all layers will display normally. However, you can only edit objects that are in your
active layers. 



Show/Snap Others
Important 
You cannot snap between 3D layers.

If you select this option and your active layer is 2D, it will snap to objects in any other 2D layers in your 
drawing that use the same scale and projection mode. In addition, all layers will display normally, but you 
can only edit objects in the active layer. 



Show/Snap/Modify Others
Important 
Any locked objects will have gray selection handles.

If you select this option and your active layer is 2D, it will snap to objects in any other 2D layers in your 
drawing that use the same scale and projection mode. In addition, you can edit objects in all visible layers
that use the same scale and projection mode. All layers will display normally. However, when you select 
objects, only those in the active layers will have black selection handles. Objects in other layers will have 
hollow selection handles. 



Lighting command

This command has two lighting elements that change how your design is rendered. One lets you control 
the color and brightness of ambient light in each layer of your drawing. The other gives you an easy way 
to set a precise sun position for your entire drawing.

Setting Ambient Light

Setting Sun Position



Setting Ambient Light
1. Make sure you are in the layer that you want to create/change the ambient light setting for.

2. On the View menu, click Lighting and then Set Layer Ambient…

3. In the dialog box that appears

· Decide whether you want ambient lighting On or Off in the active layer. 

· If you want to set a Color for the ambient light, click the color wheel. In the dialog box that 
appears, click the color you want to use. Then click OK.

· Select the Brightness: setting you want to use--you can either type a number in the textbox or use
the slider bar to pick a percentage.

4. Click OK--your drawing must be rendered for you to see new ambient light settings.



Setting Sun Position
1. On the View menu, click Lighting and then Set Sun Position… The Set Sun Position dialog box will 

appear.

2. Tell MiniCAD the site of your drawing.

· Type the Latitude: and specify whether it is N or S of the equator.

· Type the Longitude: and specify whether it is E or W of the prime meridian.

· Select the Time Zone Meridian: from the shortcut menu.

3. MiniCAD assumes that the top of your page is due North. To change this setting, type the difference 
in degrees in the textbox inside the Page North section.

4. Set the Month: and Day: you want to use in their respective shortcut menus.

5. Set the time. You can specify AM and PM hours to the minute, as well as select the Daylight Savings 
checkbox, if needed.

6. MiniCAD displays the Results of your settings (showing Azimuth, Elevation, and True Solar Time).

7. When you have the sun position setting you want, click OK.



Link Text to Record command

This command gives you a way to link symbols in your drawings with text that is part of a record format. It 
is particularly useful if you want to label symbols in a drawing with unique information. In order to use this 
command, you must have symbols and record formats already created in your drawing file.

1. Create a line or block of dummy text in the font and style you want to use--what you type is 
unimportant.

2. Select the dummy text you just created, and move it next to an unrotated symbol, placing it exactly 
where you want the record format information to appear.

3. Select both the symbol and the dummy text.

4. On the Organize menu, choose Link Text to Record

5. In the dialog box that appears, select the name of the record you want to link in the top scroll box and 
the particular record field you want to attach to the symbol in the bottom scroll box. Then click OK.

6. MiniCAD will attach the record field information you selected to your symbol, placing it as you 
designated with your dummy text.



Lock command

This command allows you to protect objects in your drawing so that they cannot be accidentally moved, 
deleted, or edited. You must unlock the object before you are able to make any changes to it. The one 
exception is if you lock a worksheet in your Drawing Window--if you update the underlying worksheet, the 
locked worksheet will be updated to match it. The locked worksheet cannot be moved, deleted, or 
otherwise edited, though. 

1. Select the object or objects that you want to lock.

2. On the Edit menu, choose Lock--the selection handles for the locked object(s) will now display as 
gray rather than black boxes. 



MiniCAD Preferences command

Within MiniCAD 7, there are two different places that you can set preferences. 

· If you make a change in the MiniCAD Preferences dialog box, all MiniCAD files that you open, work 
with, or save will use the changed setting.

· If you make a change in the Document Preferences dialog box, however, that change affects only the 
drawing file that you are working in. (For more information about these settings, see the Document 
Preferences command.)

To change your MiniCAD preference settings.
1. On the File menu, choose MiniCAD Preferences…    In the dialog box that appears, you'll see that are

four groups of preferences (Edit, Display, Session, and 3D) that you can set, which are grouped by 
tabs.

2. Click Edit to show the setting options on that tab.

· Click the following checkboxes to turn on and off the following options. Where relevant, the option
that MiniCAD will use if the checkbox is empty are shown in parentheses ( ).

· Click Drag Drawing (Click Click)

· Screen Hints (dots only with SmartCursor)

· Use Floating Datum

· Eight Selection Handles (four handles)

· Offset Duplications

· Snap to Loci

· Full Screen Cursor 

· In the textbox after Constrain Angle:, type an alternate angle that you want to use with the 
SmartCursor.

· In the textbox after Snap Radius:, type the number of pixels away from a snap that you want the 
SmartCursor activated.

· In the shortcut menu after 2D Conversion Res: select the resolution you want to use for exporting 
2D objects.

·  Under Dimension Standard, select the measurement system you want to MiniCAD to use when 
you use the Dimensioning Tools palette from the shortcut menu. MiniCAD now offers dual 
dimensioning (feet/inches and millimeters)--you can select either ASME Dual Side by Side or 
ASME Dual Stacked. In addition, you can select Custom… and create a customized dimension 
standard.

3. Click Display to show the setting options on that tab.

· Click the following checkboxes to turn on and off the following options. 

· Rulers 

· Scroll Bars 

· Black Background

· Zoom Line Thickness 

· Adjust Flipped Text

· No Fill Behind Text



· Show Other Objects While in Groups

· Select when you want to Display Light Objects--Always, Only in Wireframe, or Never.

4. Click Session to show the setting options on that tab.

· Click the following checkboxes to turn on and off the following options. 

· Use Sound 

· Log Time In Program--if using, type the number of minutes you want between reminders

· Save Reminder

· Automatic Document Positioning 

5. Click 3D to show the setting options on that tab

· Click the Show 3D Axis Labels checkbox to turn on and off that option. 

· In the shortcut menu after 3D Conversion Res: select the resolution you want to use for exporting 
3D objects.

· Select if you want 3D Rotation in your drawing to be Detailed (slow), Responsive (quick but less 
details), or somewhere in between.

6. When you are finished setting your MiniCAD Preferences, click OK to return to your drawing. These 
settings will now be used in all MiniCAD files until you change them.



Move command

Use this command if you want to specify a distance to move 2D objects.

1. Select the object or objects that you want to move.

2. On the Tool menu, choose Move and then Move…

3. In the dialog box that appears, 

· Select the coordinate system you want to use Cartesian or Polar.

· Specify the distance you want to move the object:

· If you are using Cartesian coordinates, type the X Offset: and the Y Offset: distances in their 
respective textboxes. 

· If you are using Polar coordinates, type the Distance: and the Angle: in their respective 
textboxes. 

4. Click OK.



Move 3D command

Use this command if you want to specify a distance to move 3D objects.

1. Select the object or objects that you want to move.

2. On the Tool menu, choose Move and then Move 3D…

3. In the dialog box that appears, 

· Select the coordinate system you want to use X,Y,Z (Cartesian) or I,J,K (Polar)

· Specify the distance you want to move the object:

· If you are using Cartesian coordinates, type the X Offset:, Y Offset:, and Z Offset: distances in
their respective textboxes. 

· If you are using Polar coordinates, type the I Offset:, J Offset:, and K Offset: distances in their
respective textboxes. 

4. Click OK.



Move Working Plane command

This command lets you easily move your Working Plane a precise distance. You can only use this 
command when you are in a 3D projection mode.

1. On the View menu, choose Move Working Plane

2. In the dialog box that appears, 

· Select the coordinate system you are using X,Y,Z (Cartesian) or I,J,K (Polar)

· Specify the distance you want to move the Working Plane:

· If you are using Cartesian coordinates, type the X Offset:, Y Offset:, and Z Offset: distances in
their respective textboxes. 

· If you are using Polar coordinates, type the I Offset:, J Offset:, and K Offset: distances in their
respective textboxes. 

3. Click OK.



Multiple Extrude command

This command gives you an easy way to create pyramids, spheres, and other 3D objects from a series of 
2D objects. In addition, you can use a combination of 2D objects and locus points with this command.

1. Draw the series of two or more objects that you want to extrude into a single object--or a locus point 
and at least one object.

2. Select the series of objects/locus points.

3. On the Model menu, choose Multiple Extrudes.

4. If you haven't set a DZ height for the active layer--or if you haven't created any extruded objects--a 
dialog box will appear. In the textbox after DZ:, type the distance you want to use for the extrude 
(distance from top to bottom object/locus point), and then click OK.

5. MiniCAD will extrude the set of objects/locus points, turning the extruded objects into a single, 
grouped object.



New command

Just as in many software programs, this command will create a new document. (At any time, you can 
have up to eight MiniCAD drawing files open.) 

1. On the File menu, choose New… 

2. A new MiniCAD drawing files will appear in your Drawing Window--one that is configured with your 
default settings (attributes, scale, units, etc.). If you have other MiniCAD documents open, the new file
will be placed on top of them. 



Normal Scale command

This command automatically shows you your drawing file in its real-world scale. For example, if your 
drawing's scale is set at 1:1, every inch on the monitor will show what would print as an inch on paper.

1. On the Page menu, choose Normal Scale

2. MiniCAD resizes your drawing so that the objects on the screen are the same size as they will print. If
your drawing size is larger than your monitor's measurements, you will need to scroll or pan around 
the drawing to see all elements.



Nudge

Use this command if you want to move 2D and 3D objects a pixel at a time.

1. Select the object or objects that you want to move.

2. On the Tool menu, choose Move and then Nudge

3. Use the arrow keys to move the object up, down, left, or right a pixel at a time.

4. When you are done moving the object, click anywhere in the Drawing Window to "deselect" the 
object.

Note 
The Nudge command will remain in effect as long as the object is selected. To nudge another object, 
repeat the process.



Object Info command

You can use this command to display or hide the Object Info palette in your Drawing Window. On the 
Window menu, click Object Info.

· If the palette was hidden, it will now appear in your Drawing Window.

· If the palette was open, MiniCAD will close it



Open command

Just as in many software programs, this command will open a document that has already been created. 
(At any time, you can have up to eight MiniCAD drawing files open.) 

1. On the File menu, choose Open… 

Important 
Files need to have a ".mcd" extension to open them in MiniCAD.

2. In the dialog box that appears, select the name of the file you want to open in the scroll box, and then 
click Open.

3. MiniCAD will open the last saved version of that drawing files. If you have other MiniCAD documents 
open, the file will be placed on top of them. 



Overlays command

Because MiniCAD is a versatile CAD package, it contains hundreds of specialized tools and commands. 
Yet, if all of these were displayed at one time, your drawing window would be very cluttered. For that 
reason, MiniCAD comes with different overlays to help streamline your working environment. For a 
general overview of this feature, see Overlays.

To switch overlays, follow these directions.

1. On the File menu, choose Overlays and then the specific overlay you want to use--for example, AEC 
Overlay. 

2. MiniCAD will switch overlays. Depending on which overlay you selected, you may see a different 
combination of tool palettes and menu commands in your Drawing Window.

For more information on using overlays, see Using Overlays. 



Paste command

Like many other software programs, MiniCAD allows you to "copy" an object to the Windows Clipboard, 
where it is temporarily stored. You then can "paste" the clipboard object into that same drawing file, into 
another MiniCAD file, or into another software program's file if that program also has copy and paste 
commands.

Hint 
If you hold down the control key while pasting a clipboard object, MiniCAD will place the object in the 
same place in the new drawing window as it was in the old window.

When you paste a clipboard object into a MiniCAD file, MiniCAD will automatically center the object in the 
drawing window. And, as long as you do not exit MiniCAD before pasting the clipboard object, it will retain 
MiniCAD's high resolution.

1. Go to the drawing file and the layer that you want to add the object to.

2. On the Edit menu, choose Paste--you'll see that MiniCAD has pasted the object in the center of your 
drawing window.



Paste as Picture command

Like the Paste command, this command places a copy of your system's Clipboard contents in your active 
MiniCAD drawing file. However, when you use the Paste as Picture command, MiniCAD will place all the 
contents as a single object/picture. Because the contents are now one item, you cannot edit any 
individual objects (including symbols and text) in your drawing file.

There are two advantages to using the Paste as Picture command. First, as a single item, the Clipboard 
objects will be placed into your drawing file much quicker. Second, the pasted objects will retain their 24-
bit color information and PostScript comments.

1. Go to the drawing file and the layer that you want to add the object to.

2. On the Edit menu, choose Paste as Picture.



Paste in Place command

This command works exactly like the Paste command with one exception: The Clipboard contents will be 
pasted into your active drawing in perfect registration (alignment) with their original placement.

1. Go to the drawing file and the layer that you want to add the object to.

2. On the Edit menu, choose Paste in Place.



Perspective command

This command lets you change the amount of distortion used in displaying your drawing file, giving it the 
sensation of 3D perspective. You can select the following perspectives: Normal, Narrow, or Wide. In 
addition, you can create a custom perspective.

1. On the View menu, choose Perspective and then the specific perspective you want to use--for 
example, Narrow Perspective. 

2. If you select Set Perspective… a dialog box will appear. Type the custom perspective value you want 
to use in the textbox after Perspective and then click OK.



Print command

Just as in many software programs, this command prints your active document. In addition, it is used to 
send a copy of your drawing file to a plotter.

Important 
To print a MiniCAD worksheet, you must use the Print command that is provided in the worksheet window.

1. On the File menu, choose Print… 

2. In the dialog box that appears, which will vary depending on the type of printer you are using, select 
the number of copies you want to print and specify if you want to print the whole document or only 
certain pages.

3. Click Print--MiniCAD will print all visible objects, layers, and classes in your drawing.



Printer Setup command

This is the place where you tell MiniCAD the type of printer you want your drawing set up for, as well as 
the paper size, scale, and orientation of your drawing. All of these elements help determine the "print 
boundary" of your drawing, which is marked by a gray box on the screen. To change your Printer Setup 
settings: 

1. On the File menu, click Print Setup

2. In the dialog box that appears, select the:

· printer/device you are printing to, 

Important 
Selecting a printer in Printer Setup will only change your drawing's settings; you need to change 
the printer in your Print Manager in order to change the printer that your drawing is sent to.

· size or type of paper you are using, and

· orientation of your drawing--whether you want your drawing to be "portrait" (vertical) or 
"landscape" (horizontal). 

3. Click OK.



Projection command

This command lets you change the mathematical view of your drawings. In addition to the standard 2D 
Top/Plan projection, MiniCAD has six other 3D projection modes. After the directions for switching a 
drawing's perspective, you'll find a brief overview of each projection plan.

1. Make sure the portion of your drawing that you want to view is visible in the Drawing Window. 

2. On the View menu, choose Projection and then the specific projection you want to use--for example, 
Orthogonal. 

Top/Plan

Orthogonal

Perspective

Oblique Cavalier (30  º   or 45  º  )  

Oblique Cabinet (30  º   or 45  º  )  



Top/Plan

This projection mode matches what is used for normal 2D drafting. Use this view when you are drawing 
2D objects for the best precision.



Orthogonal

This 3D mode is the traditional isometric projection used by architects and engineers. It is probably the 
most commonly used projection for 3D CAD. This projection displays the drawing as an undistorted 
projection--where objects display as their exact size regardless of their distance from the plane. 



Perspective

This 3D projection modes adds distortion to the drawing so that objects that are farther away from your 
viewpoint appear smaller than objects that are close to it. The Perspective mode closely approximates 
how your 3D model will appear in the real world. 



Oblique Cavalier (30º or 45º)

In this projection mode, a vector perpendicular to the projection plane has same length on the page as 
those parallel to the projection plane. What this means is that if the if you use this mode with front, back, 
top, bottom, left, or right standard views, the actual page dimensions are used for rectangular objects--
you can take precise measurements from a printout of the drawing. 



Oblique Cabinet (30º or 45º)

This projection mode is similar to Oblique Cavalier. However, the one important difference is that in this 
mode, objects are foreshortened by 50% so that they appear more natural. You can still use this mode to 
take measurements of vectors perpendicular to the projection plan from a printed drawing--but you must 
multiply them by 2 to get the actual dimension. 



Purge Unused Objects command

This command gives you a one-step method to remove any combination of unused layers, classes, 
symbols, and record formats in your drawing.

1. On the Edit menu, choose Purge Unused Objects…

2. In the dialog box that appears, select the elements you want to remove from your drawing file:

· Select the Layers checkbox if you want to permanently delete any layers that do not contain 
objects.

· Select the Classes checkbox if you want to permanently delete any unused classes from your 
drawing.

· Select the Symbol Definitions checkbox if you want to permanently delete any unused 
symbols from your drawing.

· Select the Record Formats checkbox if you want to permanently delete any record format that is
not attached to a symbol or object in your drawing.

3. Click OK--MiniCAD will prompt you with another dialog box, making sure that you want to complete 
this unreversible action. If you do, click Yes.



Recover command

This command tries to salvage as much of a damaged MiniCAD file as it can. When you use the Recover 
command to open a damaged file, MiniCAD will automatically attempt to make as many repairs as 
possible to the file. If a file is too damaged to be recovered, you can try to export the original file in Text 
Format and then try to import it in a blank MiniCAD file. (To learn more about using these commands, see 
Export Text Format.)

1 Press the control key; while continuing to hold down the key, on the File menu, choose Recover…

2 In the dialog box that appears, select the name of the file you want to recover in the scroll box. Then 
click OK.



Rendering command

This command lets you apply and view a solid surface to 3D wireframe objects in your drawing, as long 
as you are in a 3D projection mode. You can select the color and/or fill you want applied to an object's 
surface. In addition, you can determine light source or sources.

In MiniCAD 7, two additional rendering options have been added: Dashed Hidden-Line and QuickDraw 
3D rendering. You must install QuickDraw 3D before it will be listed as an option in the Rendering menu. If
you don't already have this program, it's included on your MiniCAD CD-ROM. To install it, see the 
program's read-me directions.

1. Make sure you are in a 3D projection mode. 

2. On the View menu, choose Rendering and then the rendering mode you want to use--for example, 
Dashed Hidden Line.

The further down the rendering list that you move, the more accurate the rendering of your object will be. 
To help you determine which rendering mode you want to use, here is the same object rendered in each 
of the nine available modes.

Wireframe

Quick

Solid

Shaded Solid

Shaded--No Lines

Final Shaded Solid



Final Hidden Line

Dashed Hidden Line

QuickDraw 3D



Resources command

You can use this command to display or hide the Resources palette in your Drawing Window. On the 
Window menu, click Resources.

· If the palette was hidden, it will now appear in your Drawing Window.

· If the palette was open, MiniCAD will close it.



Revert to Saved command

This command is a one-step way to close your drawing open the last saved version of it. Because 
MiniCAD does not save the active drawing before closing it, you should use this command only when you 
want to trash all unsaved work that you've done to your drawing--for example, in a case where it is easier 
to work from the previous version of the drawing than to repair any undesirable changes that you made.

Important 
If you have selected the AutoSave in the MiniCAD Preferences dialog box, the last auto-saved version of 
your drawing is the one that MiniCAD will revert to.

1. On the File menu, choose Revert to Saved

2. Because you cannot "undo" this action, a dialog box will appear, confirming that you want to close 
your drawing without saving it. Click OK.

3. MiniCAD closes your active drawing and automatically opens the last saved version of the file.



Roof command

This command lets you easily create complex hybrid (2D/3D) roof structures from simple 2D objects. In a 
single layer, you can draw a roof on top of a wall structure. Or, if you prefer, you can create the roof in its 
own layer and then use the Create Layer Link command to view the walls and roof together. You can find 
additional information about making roofs in the A/E/C chapter of the MiniCAD Toolkit Manual.

1. Draw and select the 2D object that you want to turn into a roof--for example, a rectangle.

2. On the Model menu, choose Roof

3. In the dialog box that appears, select the type of Roof Slope: you want to use.

· If you select Angle:

· Type the Axis Z: measurement you want to use.

· Type the Angle: you want to use.

· Select the Thickness and Miter: you want to use--Vertical Miter, Horizontal Miter, or Double 
Miter.

· Type the miter Thickness: you want to use. If you are using a double miter, you also need to 
type Vertical: and Horizontal: measurements.

· If you select Rise over Run:

· Type the Axis Z: measurement you want to use.

· Type the Rise: measurement you want to use.

· Type the Run: measurement you want to use.

· Select the Thickness and Miter: you want to use--Vertical Miter, Horizontal Miter, or Double 
Miter.

· Type the miter Thickness: you want to use. If you are using a double miter, you also need to 
type Vertical: and Horizontal: measurements.

· If you select Peak Height above Axis:

· Type the Axis Z: measurement you want to use.

· Type the peak Height: you want to use.

· Select the Thickness and Miter: you want to use--Vertical Miter, Horizontal Miter, or Double 
Miter.

· Type the miter Thickness: you want to use. If you are using a double miter, you also need to 
type Vertical: and Horizontal: measurements.

4. Click OK.



Rotate command

This command gives you a number of ways to rotate 2D and 3D objects in your drawing without changing 
their base location in the drawing. You can select one of the preset rotation angles--Rotate Left 90º, 
Rotate Right 90º, Flip Horizontal, Flip Vertical. Or, if you prefer, you can designate a custom rotation 
angle. 

For additional information, see the following topics:

Preset Rotation Angles--2D/3D Objects

2D Custom Rotation

3D Custom Rotation



Preset Rotation Angles--2D/3D Objects
1. Select the 2D or 3D object(s) that you want to rotate.

2. On the Tool menu, choose Rotate and then the set rotation that you want to use--for example, Rotate 
Left 90º.

Note 
With custom rotations, the precision of the values you can enter (degrees, minutes, and/or seconds) 
depends on your Units setting. See the Units command.



2D Custom Rotation
1. Select the 2D object or objects that you want to rotate.

2. On the Tool menu, choose Rotate and then Rotate…

3. In the dialog box that appears, type the rotation angle you want to use in the textbox after Angle: and 
then click OK.



3D Custom Rotation
1. Select the 3D object or objects that you want to rotate.

2. On the Tool menu, choose Rotate and then Rotate 3D…

3. In the dialog box that appears:

· Select the Rotation Center: that you want MiniCAD to use (Working Plane Center, Object Center, 
or Next Mouse Click).

· Type the angle you want to use in the textbox after Rotation Angle:

· Select the Rotation Axis: you want to use.

· If you want to use an axis on your Ground Plane Axis, select X, Y, or Z.

· If you want to use an axis on your Working Plane, select I, J, or K. 

4. Click OK.



Rotate 3D View command

This command gives you an easy, precise way to rotate a 3D object, changing your view of it. You can 
either type rotation values ("Rotate by Value"), or you can move a object in increments ("Interactive 
Rotate"). Either way, you will see a preview of each rotation before the object is actually rotated in your 
drawing.

1. On the View menu, choose Rotate 3D View… 

2. In the dialog box that appears, decide which view you want to use.

· If you want to use the current view, do not select the Parameters Are Absolute checkbox.

· If you want to view and rotate the object from a top (absolute) view, select the Parameters Are 
Absolute checkbox.

3. Decide which rotation method you want to use. (You can switch at any time.)

· For Rotate by Value, type the angle value or values you want to use for the object's X, Y, and/or Z
axis--you can specify these values in degrees, minutes, and seconds.

· For Interactive Rotate, first decide the angle increment you want to use for each click, and type 
that value in the text box after Increment:    Then use the plus (+) and minus (--) buttons for each 
axis to rotate the object.

4. When you have rotated the object so that you are viewing it from the angle you desire, click OK.



Rotate to Zero command

This command allows you to return any 3D object that has its own coordinate system to its upright 
position. You can use the command to rotate symbols, extrudes, multiple extrudes, and sweeps so that 
they align with world coordinate system. It is especially helpful if you disoriented while rotating an object.

1. Select the 3D object or objects that you want to rotate.

2. On the Model menu, choose Rotate to Zero.



Rotate Working Plane command

This command gives you the most precise way to rotate a Working Plane. Using degrees, minutes, and 
seconds, you can rotate the plane with absolute precision.

Note 
The values you can enter (degrees, minutes, and/or seconds) depend on your Units setting. See the Units
command for more information.

1. On the View menu, choose Rotate Working Plane…

2. In the dialog box that appears, 

· Select the Rotation Axis: you want to use.

· If you want to use an axis on your Ground Plane Axis, select X, Y, or Z.

· If you want to use an axis on your Working Plane, select I, J, or K. 

· Type the angle you want to use in the textbox after Rotation Angle:

3. Click OK.



Save command

This command saves your open drawing file, replacing any earlier version of the file that uses the same 
name. The one exception is when you use it to save a brand new file for the first name. When you do this,
is will act as if you have select the Save As command, which is described next.

Important 
Files need to have a ".mcd" to open them with MiniCAD.

1. On the File menu, choose Save

2. MiniCAD saves the file--the time it takes depends on a number of factors, such as the file size of your 
drawing.



Save As command

This command saves your open drawing file using a different name, in a different directory, and/or on a 
different directory. The Save As command is a good way to maker a backup copy of your drawing.

1. On the File menu, choose Save As…

2. In the dialog box that appears, select the drive and directory that you want to save the file in. Then, if 
you wish, type the name you want to assign to the copied file in the text box after New file name: 

MiniCAD saves the copy of your file--the time it takes depends on a number of factors, such as the 
file size of your drawing.



Save As Stationery command

This command lets you create a template file that you can use for creating new drawings. In MiniCAD, 
template files are called "stationery pads." You can create a stationery pad that contains all of the initial 
settings you typically set in your drawing files--scale, units, snap and reference grids, page setup, drawing
size, layers, classes. That way, if you typically create drawing files with the same initial settings, the 
stationery pad will significantly decrease the time and tasks required before you can begin drawing. For 
more information, see How do I work with template files?.

1. Make sure you have added or set all the elements you want to be part of your stationery pad--along 
with initial settings, you can also add symbols, worksheets, and other MiniCAD objects to your 
stationery pads.

Important 
You must save all MiniCAD stationery pads in the same directory as your MiniCAD program files.

2. On the File menu, click Save As Stationery… 

3. In the dialog box that appears, select the directory that you want the stationery pad saved in--you can 
place stationery pads in any directory as long as it is part of the main directory where your MiniCAD 
program files are stored. 

4. Type the name you want to give to your stationery pad in the box after New file name:

5. Click Save.



Save Sheets command

This command, which was called Save View in earlier versions of MiniCAD, has been renamed to work 
with the new Views Bar feature.

This command gives you a way to save individual views of your drawing. For example, you could save 
two 2D Top/Plan views of your design--a sheet showing the entire drawing and another sheet that shows 
a close-up of one individual section of the 2D plan. Then, using the new Views Bar, you could flip back 
and forth between the two views and any others you have created during a design presentation. 

In addition, you can use this command to save views with different class and layers settings--helping you 
to manage and draw in a design with complicated layer and class setups.

1. Make sure you have added or set all the elements you want to be part of your view.

2. On the Page menu, click View Bar and then Save Sheets… 

Important 
You can also access the Save Sheets… command from the Views Bar at the bottom of your Drawing 
Window. 

3. In the dialog box that appears:

· Type the name you want to give to this view in the textbox after Sheet Name:

· If you want to save the basic view factors--which include pen, zoom, 3D orientation, and 
projection, select the Save View checkbox. 

· If you want to the Sheet to include classes, select the Save Class Visibility checkbox, and set the 
following options:

· Select the Sheet's Active Class: 

· Set the visibility for each classes.

· If you want the Sheet to include layers, select the Save Layer Visibility checkbox. Then set the 
following options:

· Select the Sheet's Active Layer:

· Set the Sheet's Layer Options:

· Set the visibility for each layer.

4. Click OK--the new view you just created is now stored on the Views Bar at the bottom of your 
Drawing Window.



Scale command

Scale works the same way in MiniCAD that it does on a map--it's the ratio of the actual size of an object 
to its size in your drawing. For example, if you use MiniCAD's default scale of 1:1, every inch in your 
drawing will represent an inch in the "real world." The best scale to use will obviously depend on what you
are designing--and whether it makes sense to work with a life-sized, reduced, or enlarged drawing. 

In MiniCAD, you have the flexibility of setting one scale for all layers in your drawing, or setting a different 
scale for individual layers. 

For additional information, see the following topics:

How do I change a whole drawing's scale?

How do I change the scale of an individual layer?



How do I change a whole drawing's scale?
1. On the Page menu, click Scale… 

2. In the dialog box that appears, you will see several different scale options. You can either select an 
existing scale or create your own (by typing in a number after Paper Scale: 1:). 

3. To change the scale for the entire drawing--all layers-- select the All Layers checkbox. 

4. Decide if you want the text to be scaled in your whole drawing.

Tip 
To ensure that the text in your drawing always appears in an appropriate size, make sure to select the
Scale Text checkbox.

· If you want scaled text, select the Scale Text checkbox. 

· If you don't want scaled text, make sure that the Scale Text checkbox is not selected.

5. Click OK.



How do I change the scale of an individual layer?

There are two ways you can do this. You can go to the layer you want to change in your drawing and 
follow the steps listed in How do I change a whole drawing's scale?, making sure that the All Layers 
checkbox is not selected. Or you can follow these steps:

1. On the Organize menu, click Layers… 

2. In the dialog box that appears, select the layer you want to change. (The easiest way is to double-
click the layer name in the scroll box under Layer:).

3. Click Scale… In the dialog box that appears, select the new scale you want to use for this layer--you 
can either select an existing scale or create your own (by typing in a number after Paper Scale: 1:). 

4. Make sure that the All Layers checkbox is not selected.

5. Decide if you want the text to also be scaled in this particular layer.

· If you want scaled text, select the Scale Text checkbox. 

· If you don't want scaled text, make sure that the Scale Text checkbox is not selected.

6. Click OK.

7. Decide if you want to change the scale for any other layers in your drawing.

· If you don't want to change the scale for other layers, click Done. 

· If you want to change the scale in other layers, Click Scale… and follow the directions starting 
with Step 3 above. When you are finished changing individual layer scales, click Done.



Scale Objects command

This command allows you to rescale the X and/or the Y dimension of any selected object or group. 
MiniCAD rescales the object/group using its center point, In addition, you can use this command to scale 
text and to rescale all visible objects in your drawing.

1. Select the object or objects that you want to scale.

2. On the Tool menu, click Scale Objects… 

3. In the dialog box that appears:

· Type the X Scaling Factor: that you want to use.

· Type the Y Scaling Factor: that you want to use.

· If you want text to scaled to match your new scaling factor, select the Scale text checkbox.

· If you want to scale all visible objects in the in your active layer, select the Entire drawing 
checkbox.

Note 
You can use different X and Y scaling factors, if you wish.

4. Click OK.



Select All command

This command gives you a one-step way to select all visible objects in your active layer. In addition, if you
have set your Layer Options command to Show/Snap/Modify (see the Layer Options command). MiniCAD
will select visible objects in all of your drawing's normal layers. 

1. On the Edit menu, choose Select All

2. MiniCAD will select all visible objects using the layer options you have set--each of these selected 
objects will display with selection handles.



Send command

This command lets you change the stacking order of objects within a layer. As you draw overlapping 
objects in MiniCAD, they are automatically stacked in the order that you create them--the first object 
created is at the bottom of the stack and the most recent object created is at the top of the stack. For 
more information, see How do I stack objects, including text?.

1. Select the 2D or 3D object you want to restack.

2. On the Tool menu, choose Send A

3. In the pop-up menu that appears, choose either Send Forward, Send Backward, Send to Front, or 
Send to Back--MiniCAD will change the object's stacking order.



Set Grid command

This command lets you set both your Snap Grid and your Reference Grid. For more information on how 
you can use them together to help you draw precisely, see Snap and Reference Grids.

· The Snap Grid is an invisible grid that MiniCAD uses to help you draw and place objects precisely. As 
you drag your mouse across the screen, it will automatically "catch" at each increment on the Snap 
Grid.

· The Reference Grid, however, is the grid that actually displays on your screen. The most useful way 
to set the Reference Grid is so that it is an extension of the scale you have set. 

1. On the Page menu, click Set Grid…

2. In the dialog box that appears, type the setting you want MiniCAD to use for your Snap Grid in the 
text box after Current Snap Grid:--for example, type 1/16" 

3. Then, type the setting you want MiniCAD to use for your Reference Grid in the text box after 
Reference Grid:--for example, type 1"

4. Determine if you want your Reference Grid lines to display on your screen.

· If you want the grid lines to display, select the Show Grid Lines checkbox.

· If you don't want the grid lines to print, make sure the Show Grid Lines checkbox is not selected.

5. Determine if you want your Reference Grid lines to print.

· If you want the grid lines to print, select the Print Grid Lines checkbox.

· If you don't want the grid lines to print, make sure the Print Grid Lines checkbox is not selected.

6. Click OK.



Set Origin command

This command lets you change the placement of the origin in your Ground Plane. Its default placement is 
at the exact center of your drawing page--this point, of course, changes to correspond the paper size you 
have selected.

Note 
The origin in your Ground Plane in the point where your X and Y axis meet (0,0).

1. On the Page menu, choose Set Grid…

2. In the dialog box that appears:

Hint 
You can also change your origin by pressing the left mouse button in the upper-left corner of your 
Drawing Window and dragging the Bull's-eye cursor that appears to the place you want to reset your 
origin.

· If you wish, set your Snap Grid: 

· If you want the origin to be in the exact center of the paper, select the Symmetrical checkbox.

· If you want to set an asymmetrical X origin, type the X: and Y: values in their respective 
checkboxes.

· If you wish, set your Reference Grid: 

· If you want the origin to be in the exact center of the paper, select the Symmetrical checkbox.

· If you want to set an asymmetrical X origin, type the X: and Y: values in their respective 
checkboxes.

· Set your Grid Options--you can choose to Show Grid Lines or to Print Grid Lines by selecting 
their respective checkboxes.

· Set your Grid Angle--either select Next Mouse Drag or select Enter Angle and type the angle you 
want to use in its textbox.

3.  Click OK.



Set 3D View command

When you have a 3D model that is attached to a 2D drafting plan, you can use this command to 
designate a precise 3D view (snapshot) of your model--one created with the exact viewing angle and 
perspective you specify. To allow greater control, you designate the view in your 2D Top/Plan mode. 

If you prefer, you can also use the command to set a 3D View in any of MiniCAD's 3D projection modes.

1. Make sure you are in 2D Top/Plan mode (or the 3D projection mode you want to use). 

2. On the View menu, click Set 3D View

3. Use the cursor to draw a line on the drawing to indicate the view you want to see--where the starting 
point of the line indicates "your" position and the line's endpoint indicates the point you want to view.

4. In the dialog box that appears:

· Type the Viewer Height you want to use.

· Type the Look Toward Height you want to use.

· Select the Perspective you want to use.

5. Click OK.



Shallow Symbol to Group command

As explained under the Edit Symbol command, if you edit one symbol instance in your drawing, the 
changes you make will automatically be made globally, changing all instances of that particular symbol in 
your drawing. The same principle holds true when you combine several individual symbols to create a 
new symbol.

The Shallow Symbol to Group command lets you edit a single instance of this new, combined symbol in 
your drawing, leaving all other instances of that combined symbol--as well as all other instances of the 
individual symbols nested within it--untouched in your drawing. 

You then have the choice of leaving the edited combined symbol as a group in your drawing, or of turning 
it into a new symbol.

Important 
Before you can use this command to edit a symbol instance that has been inserted into a wall or any 
hybrid object, you must first drag the symbol outside of the wall/object.

1. Select the individual combined symbol instance that you want to edit.

2. While pressing the control key, on the Organize menu, click Shallow Symbol to Group.

3. Then, on the Organize menu, click Edit Group.

4. Make your changes to any or all of the nested symbols that are part of the combined symbol. 

5. When you are finished making changes, click the Exit Group button in the upper-right corner of your 
Mode Bar. 



Shift Drawing command

Like the Move Page Tool, this command gives you a one-step way to move all the objects in your 
drawing, changing their position on the drawing page. However, while you move the page around the 
Drawing Window with the Move Page Tool, with the Shift Drawing command you move the drawing's 
objects instead. Not only does this command select and move all visible objects together, but it also 
selects and moves invisible objects at the same time. 

1. While pressing the control key, on the Page menu, click Shift Drawing.

2. You'll see that the standard arrow cursor changes into a symbol that is four arrows all pointing inward.

3. Press the left mouse button; while continuing to hold it down, drag the outline box representing the 
outer edges of you objects around the screen.

4. When the objects are positioned where you want them on the drawing page, release the mouse 
button.



Smoothing command

This command gives you a one-step way to automatically smooth all vertices in polygons and polylines in 
your drawings. It has three smoothing options--Bézier Spline, Cubic Spline, or Arc. In addition, you can 
use the command to change smoothed vertices back into unsmoothed corners. 

1. Select the object or objects that you want to smooth.

2. On the Edit menu, click Smoothing and then the particular option you want to use--for example, 
Bézier Spline Smoothing.



Standard Views command

This command allows you change the representation and orientation your design in the Drawing Window. 
MiniCAD, has 15 view options, which can be divided into four basic categories. 

· 2D View--Top/Plan

· 3D Elevations--Top, Front, Right, Bottom, Back, Left 

· 3D Representations Above the Ground Plane--Right Isometric, Left Isometric, Right Rear Isometric, 
Left Rear Isometric

· 3D Representations Below the Ground Plane--Lower Right Isometric, Lower Left Isometric, Lower 
Right Rear Isometric, Lower Left Rear Isometric 

Note 
In addition to these Standard Views, you can create custom views with the Save Sheets command.

1. On the View menu, click Standard Views and then the particular option you want to use--for example, 
Top/Plan.

2. MiniCAD will automatically change your view--placing a checkmark in front of the active view in the 
Standard Views list.



Structural Shapes command
This command lets you easily create profiles of structural beams (Wide Flange, Channel, I Beam, Angle, 
Tee) in a variety of nominal sizes. No matter what units setting you have chosen, the Structural Shapes 
command makes all beam calculations in feet and inches (U.S. industry standards).

Note 
This command uses editable data files to produce structural shapes. These data files, which are located 
in the Externals folder, can be edited. For more information, see the MiniCAD Toolkit manual.

1. On the Tool menu, click Structural Shapes…

2. In the dialog box that appears:

· Select the Shape: you want to create from the shortcut menu.

· Select the Nominal Size: you want to use from the shortcut menu.

3. Click OK--MiniCAD automatically places the shape in the center of your drawing. You can then move 
it like any other MiniCAD object.



Subtract Solid command

This new command, included as part of MiniCAD 7's new Solids Modeling feature, allows you to cut 
(subtract) a 3D object(s) out of another 3D object, creating a new model. You can use extrudes, multiple 
extrudes, and sweeps with this command and the two other solids modeling commands (Add Solid and 
Intersect Solid): extrudes, multiple extrudes, and sweeps. This command does not currently work with 
walls.

1. Select both the object(s) that you want to subtract and the object that you want to subtract them from 
(the base object). 

2. On the Model menu, choose Subtract Solid

3. In the dialog box that appears, use the forward and back arrows to select the base object--the 
selected object is the one with the thick outline.

4. Click OK--MiniCAD creates a single solid model with holes cut in it from the selected objects. You now
can render this new model.



Sweep command

This command gives you an easy way to convert 2D objects into 3D cylindrical objects. You can use it to 
convert a single object at a time, or to convert several selected objects. However, the Sweep command 
cannot be used on grouped objects.

A sweep has four basic elements: a centroid, an arc angle, a segment angle, and the pitch. If you want, 
you can select an object's centroid--enter of rotation--before creating the sweep. If you don't select a 
centroid, MiniCAD will automatically sweep the object around itself. The other three elements (arc angle, 
segment angle, pitch) can be edited after the sweep has been created.

1. If you want to set a center of rotation for the sweep, place a locus on or near the object(s), marking 
the centroid you want to use for the sweep.

Note 
If you select more than one object when creating a sweep, the objects will automatically be "grouped."
To edit them together, use the Edit Group command. To edit an individual object only, use the 
Ungroup command and then make your changes to the single object.

2. Select the 2D object(s) that you want to sweep--and, if you created one, the centroid locus.

3. On the Model menu, click Sweep--MiniCAD automatically creates the sweep, placing it the same spot
as the original object.

4. If you wish, you can use the Object Info palette to edit the sweep's arc angle, segment angle, and 
pitch. Make sure the palette is displayed in your Drawing Window. Then select the object you want to 
edit, and make your changes in the palette's Shape pane.

· Arc Angle--This is the degree of the sweep. By default, objects are swept a full 360º. You can 
change this measurement by changing the measurement in the textbox after Sweep:

Note 
If you want to edit individual vertices, convert the sweep to a mesh object.

· Segment Angle--This is the number of segments that make up the sweep. The default is 36 
segments, each one 10º from the next on the arc. You can edit the number of segments by 
changing the angle in the text box after Seg:

· Pitch--This is the degree to which the sweep spirals. A sweep's pitch is represented in the plus- 
or minus-height per revolution. For example, if the pitch is 1", every revolution raises the object a 
single inch. The default is 0. You can edit the sweep's pitch by changing the measurement in the 
text box after Pitch: 



Symbol Edit command
Important 
Do not confuse this command with the Edit Symbol command. 

This command gives you a one-step way to replace symbols in your drawing. You can simultaneously 
replace any number of selected symbols with another symbol in your drawing's symbol library. If the 
insertion points for the two symbols are consistent, the new symbol with use the same rotation as the 
original symbol. In addition, you can use this command to precisely move existing symbols in your 
drawing.

The Symbol Edit command works differently when you use it to replace symbols that are located in walls. 
(This is because MiniCAD walls are hybrid objects.) First, you can only select one symbol at a time. 
Second, you must be in the Top/Plan projection if you are using the Symbol Edit command on a hybrid 
object. With all other objects in walls, you can use this command in a 3D projection mode.

For additional information, see the following topics:

Replacing Symbols

Moving or Rotating Existing Symbols



Replacing Symbols
1. Select the symbol(s) that you want to replace with another. 

2. On the Organize menu, click Symbol Edit…

3. In the Symbol Edit dialog box that appears, click the Choose Symbol button.

4. In the Choose New Symbol dialog box, select the name of the new symbol and click OK. 

5. This takes you back to the Symbol Edit dialog box. Select the Replace checkbox and then click OK--
you'll see that all the symbols you selected have been replaced with the new symbol.



Moving or Rotating Existing Symbols
1. Select the symbol(s) that you want to edit. 

2. On the Organize menu, click Symbol Edit…

3. In the dialog box that appears:

· If you want to move the symbol(s) to a new Position:, type the new X, Y, or Z coordinates in their 
respective textboxes.

· If you want to change the Rotation: of the symbol(s), type the angle you want to use in the textbox
after A:

4. Click OK.



Symbol to Group command

As explained under the Edit Symbol command, if you edit one symbol instance in your drawing, the 
changes you make will automatically be made globally, changing all instances of that particular symbol in 
your drawing. The Symbol to Group command lets you edit only the symbol instance that you have 
selected, leaving all other instances of the symbol in your drawing untouched. You then have the choice 
of leaving the edited symbol as a group in your drawing, or of turning it into a new symbol.

Important 
Before you can use this command to edit a symbol instance that has been inserted into a wall or any 
hybrid object, you must first drag the symbol outside of the wall/object.

1. Select the individual symbol instance that you want to edit.

2. On the Organize menu, click Symbol to Group.

3. Make your changes to the selected symbol. Because you are working directly in your drawing file, you
don't need to do anything else to continue working on other elements in your file. 



Tablet command

MiniCAD can be used with digitizing tablets, giving you an additional way to create your drawings. The 
program is compatible with digitizing tablets that support the WinTab standard.

Important 
You must own a digitizing tablet in order to use this command.

In order to use a digitizing tablet with MiniCAD, you need to have the special driver that comes with a 
tablet. When you choose Tablet for the Page menu, MiniCAD searches for this driver--which tells 
MiniCAD the size and resolution of your tablet. (If MiniCAD can't find the driver, a dialog box will appear 
telling you so.)

1. On the Page menu, click Tablet.

2. MiniCAD will display the tablet as a larger gray rectangle in your Drawing Window.

3. Follow the directions that came with your tablet for using it to trace or draw objects.



Terrain Modeler command

This command give you access to MiniCAD Digital Terrain Modeling feature. Because there are many 
ways that you can create terrain models in your drawings, we've devoted an entire supplement to 
explaining this feature and providing step-by-step directions for using all of its subcommands. To learn 
more about how you can use this powerful MiniCAD feature, see the Using the Digital Terrain Modeler 
supplement that accompanies your MiniCAD User's Guide.



Text menu and commands

This command lets you select pieces or blocks of text in your MiniCAD drawings and change any or all of 
their attributes:

Important 
For step-by-step directions on working with text, see How do I create text? and How do I format text?.

Font

Size

Type Style

Justification

Spacing

Case Style



Font

This command displays a list of all fonts that are installed and available on your computer. You can select 
any font from the list.



Size

Here you can pick from a number of standard text sizes, or you can create your own. When you click Set 
Size…, a dialog box will appear that lets you type a custom text size. You can create text that is measured
in points, millimeters, or inches.



Type Style

This is where you select whether you want Plain text or text that is Bold, Italic, Underlined, Outlined, or to 
be created with a Shadow.



Justification

This is how lines of text are aligned in your drawing. You can choose Right, which aligns the right 
margins; Left, which aligns the left margins; or Center, which centers each line of text. 



Spacing

Here you can select whether you want lines of text inside a paragraph to be Single Spaced, 1-1/2 
Spaced, Double Spaced, or to use a custom spacing (leading). When you click Other…, a dialog box will 
appear that lets you specify a custom line spacing (leading). You can specify line spacing that is 
measured in points, millimeters, or inches.



Case Style

This command let you tell MiniCAD to automatically change the selected text so that all letters display in 
lower case, UPPER CASE, or with only the first letter of each word capitalized (Title Case). 



Tools command

This command lets you display and hide MiniCAD's three Tool palettes in your Drawing Window.

1. On the Window menu, click Tools and then the particular tool palette you want to display--2D Tools, 
3D Tools, or Dimensioning.

2. If the palette was hidden, it will now appear in your Drawing Window. If the palette was open, 
MiniCAD will close it.



Top Level command

This command is designed to be used when you are editing groups of objects that are nested. It allows 
you to exited all of the groups you are editing and return to the main Drawing Window in a single step. 

1. On the Organize menu, click Top Level.

2. MiniCAD automatically closes all your edit group windows and takes you back to the main Drawing 
Window. 



Trace Bitmap command

This command lets you convert bitmap images that are stored as PICT images into vector objects. In 
converting images, you have the flexibility to choose the Thin Line Threshold (the maximum width in 
pixels) and the accuracy of the trace (collinearity sensitivity).

1. Select the PICT image that you want to convert.

2. On the Tool menu, click Trace Bitmap…

3. In the dialog box that appears:

· Select the Line Threshold you want--0, 2, 4, 6, or 8.

· Select the Collinearity Sensitivity you want--Low, Med., or High. 

3. Click OK. The time it takes MiniCAD to convert the image into vector object can vary from seconds to 
hours--the conversion time is determined by the size of the image you are tracing, as well as the line 
threshold and collinearity setting you selected.

Hint 
The progress bar will help you determine how long the conversion will take.



Trim command

This command lets you use an object to cut lines in your drawing. You can use it to cut multiple lines, but 
not to cut lines that form a closed object. 

1. Position the cutting object over the line(s) where you want to make the trim.

2. Select the line(s) you want to trim.

3. On the Tool menu, click Trim

4. MiniCAD trims the line(s) where it intersects the cutting object, turning the trimmed portions of the line
into independent line segments that you can move or cut.



TrueType to Polyline command

This command lets you convert text created with any TrueType font into a Polyline. After it is converted, 
the text is no longer font and can be edited just like any other polyline. By nature, TrueType fonts are 
defined by Bézier curves and arc points--the same definitions MiniCAD uses when converting them. 

Note 
The text conversion is not affected by the Conversion Resolution setting in the MiniCAD Preferences 
dialog box. However, if you extrude the converted polyline that is created, the 3D resolution setting in the 
same dialog box with affect how MiniCAD extrudes the polyline.

1. Select the text--lines or blocks--that you want to convert.

2. On the Tool menu, click TrueType to Polyline



Undo command

This command deletes the most recent action you took in your drawing--if that action was a mouse click, 
that is what will be undone. For that reason, if you want to reverse an action, do not click the mouse 
anywhere in your Drawing Window. This will prevent you from "undoing" the real action you want to 
reverse.

1. On the Edit menu, click Undo.

2. MiniCAD deletes you most recent action, returning you to the drawing that existed before that action.

Important 
You cannot undo an action taken that does not actually change a drawing--for example, changing a 
dialog box setting, selecting a tool, resizing a window, or changing views or zooms.



Ungroup command

This command lets you ungroup objects or groups that you previously combined with the Group 
command. For more information, see the Group command. Just like that command, you can only ungroup
objects/groups one at a time.

1. Select the group of objects/groups that you want to ungroup (split apart).

2. On the Organize menu, click Ungroup.



Units command

This command lets you select the measurement system used in your drawing. In addition to providing a 
list of standard measurement systems that you can choose from--including inches, feet, millimeters, 
centimeters, meters, or some combination of these units--the program gives you the flexibility to create 
your own customized measurement system. 

Whatever system of units you select, MiniCAD is smart enough to apply the measurement system 
globally throughout your drawing--from the measurements that display on the ruler to those used in 
dimensions and worksheets. In addition, MiniCAD coordinates your measurement system with the scale 
you have selected, automatically adjusting the level of precision in your drawing. 

For additional information, see the following topics:

How do I select an existing measurement system?

How do I create a customized measurement system?



How do I select an existing measurement system?
1. On the Page menu, click Units…

2. In the dialog box that appears, select the measurement system you want to use in the Unit Name: 
shortcut menu. 

3. Decide whether you want unit marks to display alongside the measurements in your drawing. (Note If 
you select Feet & Inches, you'll see that MiniCAD automatically displays unit marks and, therefore, 
the Show Unit Mark checkbox will be checked and unavailable.)

Caution 
Select "Old-Style Feet & Inches" only if you are working with a drawing that was created in an older 
version of MiniCAD. Do not select this unit for new drawings because it will disable the program's 
automatic precision feature.

· If you want unit marks displayed, select the Show Unit Mark checkbox. 

· If you don't want unit marks displayed, make sure that the Show Unit Mark checkbox is not 
selected.

4. Decide if you want parts of whole units to display as fractions or as decimals.

· For fractions, select the Display as Fractions checkbox.

· For decimals, make sure that the Display as Fractions checkbox is not selected. 

5. Select what dimension you want units rounded to and what angular accuracy you want to use in the 
Round Dimensions To: and the Angular Accuracy: shortcut menus. If you are working with decimals, 
you also need to select what Decimal Format: you want MiniCAD to use.

6. Click OK.



How do I create a customized measurement system?
1. On the Page menu, click Units…

2. In the dialog box that appears, select Custom from the Unit Name: shortcut menu. Or, if you have 
already created a custom measurement system, select that unit from the Unit Name: shortcut menu 
and then click Edit Custom…

3. In the dialog box that appears, type information in these four text boxes. 

· Unit Name: In this box, type the name you want to give to your custom measurement system--for
example, "MiniCAD."

· Units in an inch: In this box, type how many units in your custom measurement system equal (fit
inside) a standard inch--for example, typing in "5" would mean that there are 5 MiniCADs in one 
inch, just as there are 2.54 centimeters in one inch.

· Unit Mark: In this box, type what mark (abbreviation) you want to use to represent a unit in your 
custom measurement system--for example, "mc" to stand for "MiniCAD."

· Square Unit Mark: In this box, type what mark (abbreviation) you want to use to represent a 
square unit in your custom measurement system--for example, "sq mc" for a "square MiniCAD."

4. Click OK. The Custom Units dialog box will close, taking you back to the Set Units dialog box.

5. Decide whether you want unit marks to display alongside the measurements in your drawing. 

· If you want unit marks displayed, select the Show Unit Mark checkbox. 

· If you don't want unit marks displayed, make sure that the Show Unit Mark checkbox is not 
selected.

6. Decide if you want parts of whole units to display as fractions or as decimals.

· For fractions, select the Display as Fractions checkbox.

· For decimals, make sure that the Display as Fractions checkbox is not selected. 

7. Select what dimension you want units rounded to and what angular accuracy you want to use in the 
Round Dimensions To: and the Angular Accuracy: shortcut menus. If you are working with decimals, 
you also need to select what Decimal Format: you want MiniCAD to use.

8. Click OK.



Unlock command

This command lets you unlock an object or group of objects that you previously locked with the Lock 
command. (For more information, see the Lock command.) Unlocked objects act like any other object you
create in MiniCAD--you can move, delete, or edit them. 

1. Select the object or objects that you want to unlock.

2. On the Edit menu, click Unlock.



Use Full Screen command

This command is a one-step way to expand your active Drawing Window to the limits of you monitor 
screen. In doing so, MiniCAD removes the Title Bar. (Which means that if you want to close your drawing,
you need to use the Close command, rather than the Close Button.)

Note 
When the Full Screen command is active, a checkmark will display next to it on the Window menu.

1. On the Window menu, click Full Screen.

2. If you want to return to the Drawing Window to its original size, you need only repeat step 1 (on the 
Window menu, click Full Screen.)



Wall Framer command

This command activates MiniCAD 7's new Wall Framer tool. When you use it, MiniCAD creates a highly 
accurate estimate of the placement and number of studs needed to frame walls in your design. In addition
to showing stud placement in a framing diagram, the Wall Framer can also automatically generate frame 
elevation drawings and two different worksheets (Frame TakeOff and Frame Wall Info).

1. Select the walls that you want to frame.

2. On the Model menu, click Wall Framer.

3. In the dialog box that appears, establish these preliminary settings.

· Name your framing model. Either:

· Select the name you want to give to your Framing Model from the shortcut menu.

· Or assign a new name: Click New… and then in the dialog box that appears, type the name 
you want to assign in the textbox and click Create.

· Select the output options you want MiniCAD to automatically create--3D Model, 2D Diagram, and 
Worksheets.

· Select the layer(s) you want to frame by selecting the checkbox in front of the layer's name. 

4. Click Options…    In the dialog box that appears, select your framing settings.

· Select the Wall Class. Either select the class name from the shortcut menu, or click New…, select
the class in the dialog box that appears, and click OK.

· Type the measurement you want to use for your Stud Spacing:

· Type the measurement you want to use for your Max Plate Length:

· Type the measurement you want to use for your Sheet Stock Width:

· Type the measurement you want to use for your Sheet Stock Height:

· Select the Lumber type (dimensions) you want to use. Either:

· Select the type from the shortcut menu after Nominal:

· Or click New… and then in the dialog box that appears, type the name you want to assign in 
the textbox and click Create.

· Select the Output Options you want included with your wall studs--Fire Blocking, Double End 
Studs, Double Top Plane, and Double Bottom Plate.

5. Click OK--MiniCAD will create the estimated framing for your walls and any other output information 
you asked for.



Working Planes command

You can use this command to display or hide the Working Planes palette in your Drawing Window. On the
Window menu, click Working Planes.

· If the palette was hidden, it will now appear in your Drawing Window.

· If the palette was open, MiniCAD will close it.



General Keyboard Shortcuts

To use any of these shortcuts, simultaneously press the listed keys. 

Function                                                            Shortcut                                                                     
Zoom-in by a factor of 2 control-1

Zoom-out by a factor of 2 shift-control-1

Zoom-in by a factor of 4 control-2

Zoom-out by a factor of 4 shift-control-2

Normal Scale control-3

Fit To Window control-4

Snap To Locus control-7

Set Grid control-8

Set Origin control-9

Shift Drawing shift-control-9

Select All control-A

Send to Back control-B

Copy control-C

Duplicate control-D 

Duplicate Array shift-control-D

Extrude control-E

Extrude by dialog shift-control-E

Send to Front control-F

Group control-G

Intersect control-I

Join control-J

Join & Fillet shift-control-J 

Rotate Left 90º control-L

Move control-M

Move 3D shift-control-M

New control-N

Open control-O

Recover shift-control-O

Print control-P

Quit control-Q

Save control-S

Trim control-T

Ungroup control-U



Paste control-V

Paste in Place shift-control-V

Close control-W

Cut control-X

Undo control-Z



Layer Setup Keyboard Shortcuts

When you are in the Layer Setup dialog box, the following keyboard shortcuts are available. To use any of
these shortcuts, simultaneously press the listed keys. 

Function                                                              Shortcut                                                       
Activate layer control-A

Send to bottom of layer list control-B

Colors dialog box control-C

Send layer down one level control-D

Make layer invisible control-I

Color dialog box- control-K

Create new layer- control-N

Make layer normal (visible) control-M

Remove layer control-R

Scale dialog box control-S

Send layer to top in layer list control-T

Make layer normal (visible) control-U



Tool Palette Keyboard Shortcuts

You can use shortcut keys to select a tool from the following palettes.

Constraints palette

Mode Bar

2D Tools palette

Dimensioning Tools palette



Constraints Palette Shortcut Keys
Tool Shortcut Key

Snap to grid A
Snap to distance D
Constrain parallel E 
Constrain perpendicular F
Constrain symmetrical G
Snap to objects Q
Constrain angle R
Snap to surface S
Constrain tangent T
Snap to intersection W
Screen hints Y

Mode Bar Shortcut Keys
Tool Shortcut Key

1st group of modifiers/buttons U
2nd group of modifiers/buttons I
3rd group of modifiers/buttons O
4th modifier P
5th modifier [
6th modifier ]

2D Tools palette Shortcut Keys
Tool Shortcut Key

Zoom-In C
Zoom-Out V
Selection Arrow X
Pan Z
Text 1
Lines--Constrained/Unconstrained 2
Arcs/Quarter Arcs 3
Rectangles/Rounded Rectangles 4
Polyline/Freehand 5
Circle / Oval 6
Fillet/Chamfer 7
Polygon 8
Wall 9
Insert Symbol/Locus 0

Dimensioning Tools palette Shortcut Keys
Tool Shortcut Key



Dimensioning N
Diagonal dimensioning M
Radial dimensioning , 
Angular dimensioning .
Reshape / Clip - 
Rotate / Mirror = 

MiniCAD Cursors
Cursor Name Description

 
Pick cursor Used for picking objects when

some operation requires the 
user to choose an object on 
screen. Examples: Set 
Working Plane tool (picking 
the center of a rendered 
object), Trim menu command 
(picking the object to use to 
trim), 2D Constraint palette 
(parallel, perpendicular, 
surface snap constraints, 
double-clicking to choose a 
particular object to snap to), 
Angular dimension (for the 
second tool, picking the 
object to refer to when placing
the dimension relative to the 
reference line).

 Selection Used by the selection tool 
while a marquee is being 
dragged.

 Selection cursor Used by the selection tools to 
indicate that the cursor is over
an object, but not over any 
particular handle or snap drag
region

 
Shift-Selection cursor Used in the same situation as

above when the Shift key is 
pressed. Pressing the Shift 
key enables you to select 
multiple objects.

 
Hand Used by the pan tools to 

indicate that the user is 
panning the screen around as
though they were grabbing it 
with their hand and sliding it.

 
Selection arrow Used as a basic Macintosh 

default to indicate that nothing
special at all is going on in 
MiniCAD (while pulling down 
a menu for example, or while 
the cursor is over the blank 
Finder desktop)



Remove vertex Used by the 2D and 3D 
reshape tools to remove 
vertices from polygons, 
polylines, or 3D polygons.

 
Add vertex Used to indicate that a vertex 

may be added at either a 
vertex or a midpoint of a 
polygon/polyline. 

 
Move vertex Used by the reshape tools to 

indicate that the 
vertex/midpoint handle picked
by the cursor can be dragged 
to adjust the object's shape.

 
Change Vertex type Used by the 2D Reshape tool 

when the cursor is over a 
vertex (NOT a midpoint) of a 
polygon/polyline, to indicate 
that the vertex may be 
changed to a different type 
(Bézier, corner, etc.).

 

Bézier point Used by the polyline tool to 
indicate that the next vertex 
placed will be a Bézier point.

 
Cubic spline point Used by the polyline tool to 

indicate that the next vertex 
placed will be a cubic point.

 
Arc point Used by the polyline tool to 

indicate that the next vertex 
placed will be an arc point.

 
Edit text Used to show that the cursor 

is currently in a block of text 
that's being edited.

 
Create text block Used to show that the user 

can click in the drawing to 
start a new text block.

 Drawing This is the basic MiniCAD 
drawing cursor. It is generally 
used by any drawing tool as a
default cursor.

 
Symbol insertion This cursor is used by the 

symbol tool and also the 
zoom tools (both in and out). 

 
2D Reshape This is used by the 2D 

Reshape tool when the cursor
is not over a particular object 
in the drawing to indicate that 
the user can drag a multiple 
reshape marquee. 

 
Resize Used with the Selection tool 

when the cursor is over an 
object handle to indicate that 
the object may be resized. 
Also used by the 2D Reshape
tool to indicate that the cursor
is over a vertex or midpoint of
a polygon/polyline, and that 
the object may be resized by 
dragging that handle.



 
Paint bucket Used for selecting an object 

for Hatching, and Combine 
into Surface.

 
Rotate Used by various 3D rotation 

tools to indicate rotation 
around an axis perpendicular 
to the screen. 

 
Shift drawing This cursor is only used for 

Shift Drawing (Option--
Command-9) to indicate that 
the selected objects are being
shifted around.

 
Bull's-eye Used by many tools. 

Examples: circle by 3 points 
tool when clicking each of the 
3 points, setting a symbol's 
insertion point (next click), or 
setting the drawing center 
(Command-9).

 
Watch cursors Used to indicate that a time 

consuming operation is in 
progress.

 Reverse pitch Used when the cursor is over 
the up-slope arrow of a roof 
(in plan view) to indicate that 
clicking this arrow will reverse
the pitch angle of the roof (or 
the direction, however you 
look at it).

 
3D Rotation Used by various 3D rotation 

tools to indicate the rotation 
direction affected by the 
movement of the mouse. 

 
Snap drag Used in the selection tool to 

indicate that the cursor is in 
the snap drag region of an 
object, which is near a handle
but not exactly on the handle. 
When this cursor is shown, 
and the user begins to drag 
that object, the object will 
automatically shift slightly so 
that the nearby handle is 
precisely underneath the 
cursor. Also used by the radial
dimension tools to indicate 
that an objects can be 
dimensioned by that tool.

 
Worksheet resize Used to indicate that dragging

the lower right cell of an open 
worksheet will add additional 
rows/columns.

 
Column resize When the cursor is on the 

border between two rows or 
columns of a worksheet, the 
user can drag to change the 
column width.



Converting Architectural Scale
1" = 1'
Fraction of inch equaling 
1 foot

12 x 1/1 = 12
Inches/ foot multiplied by 
inverted fraction

1 : 12 
Number to be typed into 
Paper Scale

1/2" = 1' 12 x 2/1 = 24 1 : 24
1/4" = 1' 12 x 4/1 = 48 1 : 48
3/4"= 1' 12 x 4/3 = 16 1 : 16
1/8" = 1' 1/8" = 1' 1 : 96
3/8" = 1' 12 x 8/3 = 32 1 : 32
5/8" = 1' 12 x 8/5 = 19.2 1 : 19.2
7/8" = 1' 12 x 8/7 =13.714 1 : 13.7142857
1/16" = 1' 12 x 16/1 = 192 1 : 192
3/16" = 1' 12 x 16/3 = 64 1 : 64
5/16" = 1' 12 x 16/5 = 38.4 1 : 38.4
7/16" = 1' 12 x 16/7 = 27.428 1 : 27.4285714
9/16" = 1' 12 x 16/9 = 21.333 1 : 21.3333333
11/16" = 1' 12 x 16/11 = 17.454 1 : 17.4545454
13/16" = 1' 12 x 16/13 = 14.769 1 : 14.7692307
15/16" = 1' 12 x 16/15 = 12.8 1 : 12.8
1/32" = 1' 12 x 32/1 = 384 1 : 384
3/32" = 1' 12 x 32/3 = 128 1 : 128
5/32" = 1' 12 x 32/5 = 76.8 1 : 76.8
7/32" = 1' 12 x 32/7 = 54.857 1 :54.8571428
1/64" = 1' 12 x 64/1 = 768 1 : 768
3/64" = 1' 12 x 64/3 = 256 1 : 256

Converting Surveying Degrees

MiniCAD Circle/Arc Conventions--0º equals due East. Positive degrees run counter-clockwise and 
negative degrees run clockwise.

Survey Bearings--The acute angle between the Meridian and a line measured from North to South, 
toward East and West to give a reading of less than 90º.



A Coordinates Eº ' " N. Add to 0º to get a positive angle.
B Coordinates Nº ' " E. Subtract from 90º to get a positive angle.
C Coordinates Nº ' " W. Add to 90º to get a positive angle.
D Coordinates Wº ' " N. Subtract from 180º to get a positive angle.
E Coordinates Wº ' " S. Subtract from -180º to get a negative angle.
F Coordinates Sº ' " W. Add to -90º to get a negative angle.
G Coordinates Sº ' " E. Subtract from -90º to get a negative angle.
H Coordinates Sº' " E. Subtract from -90º to get a negative angle.
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